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Record Management
CSM provides an Out-Of-The-Box (OOTB) solution to support multiple features and processes.

Note: For detailed information on these features and processes, refer to the CSM Starter
Database Schema Guide. The schema guide can be found on the Customer Support Portal. Go to
the Release Notes tab and select Cherwell Service Management. Select the version of CSM you
are running to find the schema document you need. Also, note that CSM is highly configurable so
your processes and content will vary, especially if your system utilizes integrations and Cherwell
mergeable applications (mApps).
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About Records
A CSM record is a collection of Business Object data represented as a Form and Grid. Records are used
to track and relay information. Examples include:

• Incident/Service Request

• Problem

• Change Request

• Service

• Knowledge Article

The following figure shows an example Incident Business Object (represented by a Form):
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Tour a Record
Although the data in each record is unique, the layout of most major records is similar. Generally, CSM
records are made up of four main areas:

1. Quick Info Tile: Displays important at-a-glance information, such as ID, Status bar (current and next
status), record ownership, and common operations (I Want To).

2. Workflow bar: Displays the record's progress as it moves through its workflow phases.

3. Main Pane: Displays the main form fields. The Main panes greatly vary.

4. Arrangement: Dynamically displays linked child records, such as Journals, Tasks, Approvals, etc.
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Incident/Service Request Management
Incident/Service Request management is the process that ensures that Services are restored as quickly
as possible, whether that means:

• Incident: Restoring something that is broken/disrupted. Examples include fixing a printer, phone, or
software.

• Service Request: Fulfilling a request for information/advice or access a Service. Examples include
resetting a password, granting access to a printer, or providing standard setup Services for a new
employee.

Note: In CSM, Incidents and Service Requests (often called Requests) are stored together
in the Incident Business Object.

12
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About Incidents and Service Requests
An Incident is an unplanned interruption to a Service or a reduction in the quality of a Service (example:
Something is not working). A Service Request is a request for information, advice, a Standard Change, or
access to a Service (example: Installation of new software).

In CSM, Incidents and Service Requests are stored together in the Incident Business Object. The
categorization (Service/category/subcategory) identifies the record as either an Incident or Request. A
categorization often requires a unique Form to capture the correct information. For example, an Incident
for a non-working network printer would require different information than a Request for printer toner
cartridge. To facilitate gathering this specific information, CSM embeds and uses several OOTB Specifics
Forms, which are automatically displayed when you categorize the record.
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Incident and Service Request Features and
Capabilities

CSM Incident/Request Management has numerous features and capabilities:

• Searching: Quickly locate all Incidents by running a Quick Search, or search for a particular
Incident or set of Incidents by refining the search criteria to a word/phrase, timeframe, Customer,
etc. Use Search Group to save/run commonly-run Searches.

• Search Groups: Use Search Groups to quickly locate/filter Incidents, or to automate searching in
Reports or on Dashboards.

• Security: Secure Incidents by controlling who can view, create, edit, and delete records.

• Business Object: Use the dedicated Incident Business Object to track Incidents and Requests;
configure the Business Object to capture/track only what you want.

• Form: Use the powerful Incident and Request forms to create, edit, and track Incidents. The forms
provide a Quick Info Tile (left) to display important at-a-glance information (Incident ID, Status bar
(current and next status), Priority bar (with threshold colors), requestor, record owner, SLA respond/
resolve target times, and common operations (I Want To), a color-coded workflow bar (top) to
visually track the Incident/Request workflow phases, and an Arrangement area to dynamically
display linked records (child records) that are in a relationship with the Incident/Request (parent
record).

• Specifics forms: Use the context-sensitive Specifics forms to capture relevant data for the different
Categorizations of Incidents and Requests.

• Workflow: Use the streamlined Incident workflow to move Incidents/Requests from New to Closed.

• Creation Flexibility: Create Incidents manually or through an automated process, or allow
Customers to create their own records in the Portal.

• Ownership: Assign each Incident to a record owner to ensure accountability.

• Linked Records: Link child records to a parent Incident Record to keep supporting information at
your fingertips and to ensure data relationships. Linked child records are visible in the Incident
Arrangement.

• Tasks: Use linked Tasks to distribute and track individual pieces of work assigned to Teams or
Users (ex: Escalations, Time Entries, and Work Items).

• Incident matching: Take advantage of Incident Matching to determine if an Incident/Request has a
known solution/workaround, is part of a larger Problem, is a duplicate, etc.

• History and Revision tracking: Use linked Journals to track important status and field changes.

• E-mail correspondence tracking: Use linked Journals to track e-mail correspondence (ex:
Receipt, Follow-up, Resolved, and Closed).

• Chat and Remote Session tracking: Use linked Journals to track Chat and remote support
conversations.

• Queue tracking: Use linked Journals to track when Queues are added to/removed from a Queue.
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• SLA Management tracking: Use linked Journals and linked SLM records to track SLA breaches,
warnings, and changes in the Pending status for Stop The Clock.

• First Call Resolution (FCR) tracking: If an Incident is closed (manually or through an automated
process) in three saves or fewer, an FCR icon appears on the form to congratulate you and track
FCR. You can also manually mark the Incident as FCR on the linked Resolution Details form.

• Stop The Clock: If allowed, you can Stop The Clock (pause the SLA Clock and put the record into a
Pending status) during the Investigate/Fulfill phase.

• Rich Text: Use Rich Text to complement your Descriptions by adding formatting and images/
screenshots.

• Actions/One-Steps: Use powerful Actions and One-Steps to move Incidents through their workflow,
initiate common operations (ex: Assign ownership), initiate scenario-specific Actions, run Reports,
etc. Actions/One-Steps are available on the Incident and Request forms (including from the CSM
Desktop Client Task Pane and CSM Desktop Client menu bar), and on the Incident and Request
Dashboards.

• Dashboards: Use the Incident Dashboard, Incident Details Dashboard, and the Request
Dashboard to view your critical Incident/Request metrics in a single, real-time, at-a-glance control
panel. The Dashboards display the number of Open/Reopened/Pending/Overdue Incidents and
Requests, the number of open Incidents/Requests affecting VIP Customers, the average number of
Incidents/Requests resolved in a month, the percentage of Incidents/Requests in each Status of the
workflow (New, Assigned, In Progress, Pending, Resolved, Closed, and Reopened), and the number
of Incidents/requests by Category.

• Reports: Run Reports to show up-to-date statistics on most common Incidents, User and Team
workloads, closure rates, Service trends, potential SLA breaches, and much more.

• Automation Processes: Use Automation Processes to automatically close Incident and to send e-
mails.
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Incident Good to Know
• Incident and Requests are stored together in the Incident Business Object. The Categorization

(Service/Category/Subcategory) identifies the Incident Type as Incident or Request. The workflow
for Incidents and Requests is almost identical and the forms are very similar. Specifics forms always
vary.

• First Call Resolution (FCR) is defined as three or fewer saves. If an Incident is closed (manually or
through an automated process) in three saves or fewer, an FCR icon appears on the form to
congratulate you. You can also manually mark the Incident as FCR on the Resolution Details Form.

• If allowed, you can Stop The Clock (pause the SLA Clock and put the record into a Pending status).

• CSM provides several OOTB Automation Processes to automate Incident management. For more
information, refer to the Automation Process documentation.

• If enabled (via an Automation Process), a Customer Survey e-mail is automatically created/sent to
the Customer to notify her that her Incident was closed and to solicit feedback ("Send Survey"
Automation Process). To avoid too many e-mails being sent, CSM sends only one survey to each
Customer every 90 days and does not send surveys for Password Requests.

• When on a record, you can send an e-mail directly to the current Customer (Requestor) by clicking
File>E-mail Current Customer, or by clicking the Customer's e-mail address in the Requestor
section of the Quick Info Tile. If sent using the File menu, the e-mail is blank. If sent using the Quick
Info Tile, an e-mail template is used to autopopulate the e-mail with information from the current
Incident (example: Incident ID, Customer's name, logging date/time details, etc.).
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Incident/Service Request Workflow
The following figure describes the high-level Incident/Request workflow in the OOTB system.
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Note: CSM uses several features to manage the Incident/Request workflow (ex: The Incident
Form helps create and track Incidents, One-Steps help move an Incident through its workflow,
Automation Processes notify stakeholders via e-mails, Dashboards notifies stakeholders and track
metrics, Service Catalog Templates (SCT) and Work Units (WU) allow automation of tasks, etc.).

Contributors

An Incident/Request typically involves the following contributors. Depending on your workflow and the size
of your company, many of these contributors might be combined into one person:

• Requestor: Person who initiates the Incident/Request. This is typically a Customer.

• Creator: User who first logs the Incident/Request. This is a technician; the level varies depending
on tiered support.

• Owner: User who manages (investigates/resolves/fulfills) the Incident/Request. This is typically a
technician; the level varies depending on tiered support.

• Task owner: User to whom Tasks are assigned in order to help resolve/fulfill an Incident/Request.

Phases

The Incident/Request workflow is broken down into the following phases:

1. Detect: Incident is detected (Portal, call, e-mail, automated). This phase is not tracked in CSM.

2. Record: Creator logs a new Incident. Then, creator records the initial Who (Requestor), What
(Description), and How (Call Source) details.

3. Classify: Creator classifies the Incident (Service/Category/Subcategory, Priority, Major Incident,
and CI).

4. Investigate (Incident) or Fulfill (Request): Ownership is assigned. Owner investigates/diagnoses
the Incident or fulfills the Request. (Owner creates/assigns Tasks to one or more Task owners, if
needed.) When a resolution is diagnosed/fulfilled, owner resolves the Incident/Request (records
resolution details and code).

5. Resolve: Owner submits resolution to the Knowledge Base (as Knowledge Article), if necessary.
Owner can also close the record (to finalize the process) or reopen the record (to make changes).

6. Closed: Closed Incident/Request can be searched and viewed, but not edited.

Statuses

An Incident/Request progressing through the workflow encounters the following statuses:

Note: Incident/Request phases do not align with Incident/Request statuses.

1. New: Incident/Request is being created, recorded (initial details), classified, and assigned to an
owner.
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2. Assigned: Incident/Request has been assigned to an owner.

3. In Progress: Incident/Request is being investigated/fulfilled and resolved by an owner.

4. Pending: Incident/Request is temporarily paused (Stop The Clock).

5. Resolved: Incident/Request has been resolved and is waiting to be closed.

6. Closed: Incident/Request is closed.

7. Reopened: Incident/Request is reopened because the issue was not fixed or reoccurred.
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Logging Incidents
The following instructions are available to walk you through the steps to log a new Incident using our
OOTB workflow:

• Log an Incident: Typical step-by-step instructions for logging an Incident.

• Log an Incident - Detailed: Detailed step-by-step instructions for logging an Incident, including tips,
optional steps, and behind-the-scenes information.

Note: CSM provides an OOTB Incident workflow with all the features you need to
successfully manage Incidents. You can use this workflow as-is, or tailor it to meet the needs
of your organization.
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Log an Incident
The following procedures walk you through the steps required to log an Incident. A Request follows a
similar workflow.

Log an Incident

Create a new Incident Record and provide initial details.

1. On the CSM Desktop Client toolbar, click New > New Incident.
A new Incident Record is created with a unique Incident ID and a status of In Progress. The Incident
automatically enters the Record phase.

2. Record Incident details:
a. Requestor: Provide the name of the Customer who initiated the contact in the Quick Info Tile,

and then press ENTER or TAB to search for the Customer Record.

b. Short Description: Provide a concise description of the Incident.

c. Description: Provide a detailed description for the Incident.

d. Call Source: Select a source for the initiation.

After all required Fields are completed, the Incident automatically enters the Classify phase. When the
incident is saved, an e-mail is sent to the Customer to confirm receipt and relay the Incident number. If the
Incident is resolved before the first save, a Resolve e-mail is sent instead. Journal records are
automatically created to track e-mail communication. View e-mails in the Incident Journals tab of the Form
Arrangement.

Classify an Incident

The second step on an Incident form is to classify the Incident. Categorize, prioritize, and escalate to a
Major Incident, if necessary. .

1. Service: Select the affected Service from the drop-down.

2. Category: Select the affected Service category from the drop-down.

3. Subcategory: Select the affected servicesubcategory from the drop-down.

Note: Incident Type, related Specifics Form, and SLA's are determined by the Category
selections.

4. Prioritize the Incident:
a. Click the Priority drop-down and select a priority number from the Priority Matrix. The

selected priority populates the Quick Info Tile.

b. (Optional): If a priority of 1 is selected, the Major Incident checkbox becomes available. To
escalate the Incident to a Major Incident, it must have a Priority 1 status as well as similar
linked Incidents. Attach similar Incidents in the Similar Incidents tab of the Form Arrangement.
This tab is only visible if the Major Incident checkbox has been selected.
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c. (Optional): Select the Link to Existing Major Incident link in the I Want To section of the
Quick Info Tile if the Incident is a contributing factor to an already open and existing Major
Incident.

d. After a priority is selected, respond by and resolve by target times are calculated based on the
defined priority target times in the invoked SLA, and are then displayed in the SLA section of
the Quick Info Tile.

e. Select an affected CI: Click the CI Selector button  to launch the CMDB window, and then
select a CI. The selected CI record appears in the Configuration Items tab of the Form
Arrangement.

Investigate the Incident

Assign an owner to move the Incident through the workflow.

1. Assign an Owner to the Incident by clicking an ownership link in the Quick Info Tile. Ownership is
automatically assigned to the creator when the Incident is saved or escalated, but can be changed if
necessary.

2. The Owner completes any associated Specifics Form. These vary and are determined during
Categorization.

Resolve the Incident

After an Incident has been logged, classified, and associated Specifics Forms are complete, the owner
can Resolve the Incident.

1. Develop a resolution:
◦ Search the Knowledge Base.

◦ View Similar Incidents.

◦ Escalate the issue to a higher tier of support.

◦ Track time, or schedule an immediate Action Item for another Team/User.

◦ Use Actions (Actions/One-Steps/Quick Templates).

2. After a resolution has been reached, click the Resolve link in the Status bar.
CSM automatically prompts you to log the resolution/fulfillment details and select a Cause Code.
Then, a Resolution Details Record is created and appears in the Resolution Details tab of the Form
Arrangement. A Resolve notification e-mail is also sent to the Customer.

3. If you discover that the Incident was not resolved, clone it (create a new Incident with Fields auto-
populated with information from the cloned Incident) by clicking the Mark as Recurring or Mark as
Never Fixed links in the Quick Info Tile.
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Log an Incident - Detailed
The following procedures walk you through the steps required to log an Incident, as well as how to classify
it as a Major Incident. A Request follows a similar workflow.

Log an Incident

Create a new Incident Record and provide initial details.

1. On the CSM Desktop Client toolbar, click New > New Incident.

Note: If configured, an Incident can also be logged by an automated process or by a
Customer in the Portal. After an Incident is logged, a CSM Creator or Technician moves the
Incident through the Incident workflow.

A new Incident Record is created with a unique Incident ID (example: 102270) and a status of In
Progress. The Incident automatically enters the Record phase.

2. Record Incident details:
a. Requestor (in the Quick Info Tile): Provide the name of the Customer who initiated the Incident

(example: Max), and then press ENTER or TAB to search for the Customer Record.

Tip: Wildcards (example: % or *) can be used when searching. If the Customer is a

VIP, a VIP icon  appears beside the name. To browse for a Customer or add a

new Customer Record, click the Customer Selector button  to launch the Contact
Manager. To add an alternate phone number or e-mail address, click the Alternate
Contact Info link. To view the selected Requestor's detailed Customer Record, click the

Quick View button .

If an exact match is found, the Requestor fields are auto-populated with the Customer’s
information. If multiple matches are found (example: multiple Customers named Max), the
Contact Manager opens so that you can select the appropriate Customer.

b. Short Description: Provide a concise description for the Incident (example: Network printer
issue).

c. Description: Provide a description for the Incident (example: Cannot print to network printer).
The description field is a Rich Text field. To format the text or embed an image, click the Zoom
button.

d. Call Source: Select a source or method of contact from the drop-down.

Classify an Incident

The second step on an Incident form is to classify the Incident. Categorize, prioritize, and escalate to a
Major Incident, if necessary.

1. Service: Select the affected Service from the drop-down (example: Printing).
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2. Category: Select the affected Service Category from the drop-down (example: Network).

3. Subcategory: Select the affected Service Subcategory from the drop-down (example: Submit
Incident).

Note: Incident Type is determined by the Service, Category, and Subcategory selections.
This three-tiered Categorization determines the Incident Type (Incident or Request), which
Specifics form to display and which SLA to invoke. If you do not know the three-tiered
classification, enter a word into the Quick Classify field (example: Printer) then press TAB or
ENTER to locate a possible match. Wildcards (% or *) can be used when searching. If
matches are found, the Category Selector opens.

After an Incident is identified as an Incident or Request, the relevant Specifics form is displayed.

If it is determined that the Incident is a duplicate, use the Close as Duplicate One-Step (Incident
Actions>Quick Templates) to quickly close the Incident Record, capturing the RecID of the Incident
that it duplicates.

4. Prioritize the Incident:
a. Click the Priority drop-down and select a priority number from the Priority Matrix. The

selected priority populates the Quick Info Tile.

The priority is displayed in the Priority bar of the Quick Info Tile. The color (red/orange/green)
indicates the level of priority.

After a priority is selected, Respond By and Resolve By Target Times are calculated based on
the defined Priority Target Times in the invoked SLA, and are then displayed in the SLA
section of the Quick Info Tile. The SLA icon indicates the SLA Type (example: Corporate,
Customer, Config Item, or Service). The Respond/Resolve By icons indicate when the Target
Times (deadlines) are met and breached. If enabled (via an Automation Process), e-mails are
automatically created and sent to the managers of User/Team owners to notify them of
potential SLA Respond/Resolve By breaches.

Note: If necessary (and allowed by the invoked SLA), place the record in a pending
state to stop the SLA clock anytime after the required fields are populated by clicking
the Set to Pending link in the I Want To section. After you select a pending reason
(example: Need data from customer), the status changes to Pending and the pending
reason (with a review date) displays in the Status bar. To remove the status from
Pending, click the Remove from Pending Status link in the Status bar.

5. Select a Primary CI:

a. Click the CI Selector button  to launch the CMDB window, where you can select a CI. You
can locate CIs by filtering (by Config Type, All Customers, a specific Customer) or by
searching. You can also create a new CI on-the-fly.
The selected CI record appears on the Configuration Items tab (Arrangement area).

Tips: To view the selected CI record, click the Quick View button  or click the record on the
Configuration Items tab (Arrangement area). To view impacted CIs, click the Visualization

button  to open a Configuration Map that shows other CIs affected by the Incident.

24

CSM Record Management

CSM Record Management



After the Incident is categorized and prioritized, the Incident automatically enters the
Investigate/Fulfill phase. (This example follows an Incident, so it enters the Investigate phase.
Request Fulfillment follows a similar workflow.)

6. (Optional): Escalate the Incident to the second-level Team.
a. Click the Escalate to Level 2 link in the I Want To section of the Quick Info Tile. You can also

click the Escalation to Level 2 and 3 Action in the Incident Actions section of the Task Pane.
A window opens prompting you to define a reason for escalating the Incident.

b. Provide the reason for escalating the Incident.

c. Click OK.
A Task form opens in the Form Arrangement.

Note: The Title, Type, Description, and Owned By Team fields are auto-populated
based on the Incident Subcategory form.

d. Complete the Task form.

7. (Optional): Escalate the Incident to the third-level Team.
a. Click the Escalate to Level 3 button in the Incident Actions section of the Quick Info Tile. You

can also click the Escalation to Level 2 and 3 Action in the Incident Actions section of the Task
Pane.
A window opens prompting you to define a reason for escalating the Incident.

b. Type the reason for escalating the Incident.

c. Click OK.
A Task form opens in the Form Arrangement.

d. Complete the Task form.

Escalate to a Major Incident

A Major Incident has a company impact and requires a high level of urgency. It may involve several
departments, or may be the result of multiple related Incidents. For example, if several Incidents have
been submitted regarding login issues to Microsoft Outlook, and the cause of these Incidents is that
Microsoft Outlook is down company-wide, a Major Incident should be created.

To escalate an Incident to a Major Incident if necessary, complete the following procedures:

1. (Optional): Select the Major Incident checkbox. If a priority of 1 is selected, the Major Incident
checkbox is automatically enabled. To escalate the Incident to a Major Incident, it must have a
Priority 1 status as well as similar, linked Incidents.

2. (Optional): Attach similar incidents in the Similar Incidents tab of the Form Arrangement. This tab
is only visible if the Major Incident checkbox has been selected. Any Incidents linked to a Major
Incident can be automatically resolved at the same time as the Major Incident.

Tip: Linked Incidents are automatically updated with the Major Incident ID. If the Major
Incident is closed, the linked Incidents are also automatically closed. If desired, create a
One-Step to notify all Incident Owners of the Major Incident Escalation.
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3. (Optional): Select the Link to Existing Major Incident link in the I Want To section of the Quick Info
Tile if the Incident is a contributing factor to an already open and existing Major Incident.

Assign Ownership to an Incident

Assign an owner to move the Incident through the workflow:

1. To assign an owner, choose one of the following methods:
◦ Take Ownership: Click this link to make yourself the User owner .

◦ Assign to: Click this link to select a User owner . The Team owner is populated by the User
owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User owner (User is
limited by Team).

◦ Select Team: Incidents are assigned to the 1st Level Support Team by default. Click this link to
select a new Team owner, if necessary.
CSM automatically sends an e-mail to the owners to notify them of ownership.

2. The Owner completes any associated Specifics Form. These vary and are determined during
Categorization.

Resolve the Incident

After an Incident has been logged, classified, and associated Specifics Forms are complete, the owner
can Resolve the Incident.

1. Develop a resolution:
◦ Search the Knowledge Base.

◦ View Similar Incidents.

◦ Track time, or schedule an immediate Action Item for another Team/User.

◦ Use Actions (Actions/One-Steps/Quick Templates/Tasks).

Tip: Several Actions/One-Steps are available on the Quick Info Tile (I Want To section),
the CSM Desktop Client Task Pane, and the CSM Desktop Client menu bar to help you
efficiently resolve Incidents (example: Create Problem, Reboot Computer, Reset
Password, etc.). CSM also provides several example Actions you might consider
implementing to improve your workflow (for example, Notify Owned By Via E-mail and
Reset Password with E-mail). For more information, see Incident One-Steps.

Tip: Document your progress by adding Journals.

2. After a resolution is developed, resolve the Incident and capture the resolution details:
a. In the Status bar, click Resolve.

CSM prompts you to log the resolution/fulfillment details.
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Note: If the Incident has open Tasks associated with it that need to be closed before the Incident is
resolved, a message displays to warn you.

After the Close Description is logged, a Resolution Details Record is created and appears on the
Resolution Details tab (Arrangement section) to track the resolution, the Incident status changes to
Resolved, and the Incident automatically enters the Resolve phase. An e-mail is created and sent to
the Customer to notify him that his Incident was resolved. If you discover that the Incident/Request
is not ready to be resolved, reopen the Incident/Request by clicking the Reopen Incident link in the
Status bar of the Quick Info Tile. If reopened, the Status changes to Reopened and the Incident can
be investigated/fulfilled again.

3. (Optional) Transfer the resolution to the Knowledge Base/Support Group:
a. Click the Submit to KB button on the Resolution Details form or the Submit to Knowledge

Base link in I Want To section of the Quick Info Tile to log a KA.

After three days, an Automation Process automatically closes the Incident, the Incident status
changes to Closed, and the Incident enters the Closed phase. An e-mail survey is automatically
created/sent to the Customer to notify him that his Incident was closed and to solicit feedback.

Note: To manually close the record sooner, click the Close this Incident link in the I Want
To section of the Quick Info Tile.

4. If you discover that the Incident was not resolved, clone it (create a new Incident with fields auto-
populated with information from the cloned Incident) by opening the Task Pane and selecting
Incident Actions>Quick Templates>Close Current Incident.
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Incident Design Ideas
CSM provides an OOTB Incident workflow with all the features you need to successfully log/resolve
Incidents and log/fulfill Requests. You can use this workflow as-is, or tailor it to meet the needs of your
organization. Design ideas include:

• Fields: Change which Fields are required and when, which Fields support Rich Text, etc.

• Statuses: Change Incident statuses and/or the One-Steps that are initiated when an Incident enters
each status.

• Form: Change the Form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Steps: Create Actions/One-Steps to automate your workflow, or implement any
of the unused example One-Steps that are shipped with CSM (ex: "Notify Owned By of Edits" One-
Step).

• E-mail: Change the templates that are used to create the e-mails sent by One-Steps or Automation
Processes (ex: Resolved Confirmation). The e-mail templates are defined as part of the One-Step.
Or, disable/change when and to whom notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that monitor Incidents (ex:
Monitors for SLA resolve/respond by deadline breaches, automatic notification e-mails, etc.)
Consider creating Automation Processes to notify stakeholders of a Major Incident or to coordinate a
Major Incident effort.

• Validated Field values: Use Table Management to add/edit Lookup Object values to use in drop-
down menus (ex: Cause Codes).

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.
Refer to the online help for this detailed information.

28

CSM Record Management

CSM Record Management



Incident Features
CSM provides the following tools to help manage Incidents and Requests:

• Forms (Incident/Request and Specifics Forms)

• Tasks

• Journals

• Dashboards

• One-Steps

• Search Groups

• Automation Processes

• Reports

29

CSM Record Management

CSM Record Management



Incident Form
Use the Incident and Request forms to create, edit, and track Incidents/Requests. The forms are similar
and are made up of four main areas:

1. Workflow Bar: Tracks the Incident as it progresses through the Incident/Request workflow. Dark gray
indicates the current phase.

2. Quick Info Tile: Displays important at-a-glance information, such as Incident ID, requestor contact
information, Status bar (current and next Status), record ownership, SLA information, and common
operations (I Want To).

3. Main Pane: Displays the main form fields, organized by Record, Classify, and Investigate/Fulfill
steps. Specifics forms appear when relevant.

4. Arrangement: Dynamically displays linked records (child records) that are in a relationship with the
Parent Incident Record.

The following table describes the fields on the form.
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Field Description Comments

Quick Info Tile

Important at-a-glance information, such as Incident ID,
requestor contact information, Status bar (current and next
status), record ownership, common operations (I Want To
area.), and SLA information).

 

Incident/Request Record Type.
CSM automatically assigns the Record Type based on
the type of record created (New>Incident) and its
classification.

ID Unique record identifier (ex: 10999).
CSM automatically assigns the ID when the Incident/
Request is created.

Requestor Person who initiated the Incident/Request.  

*Requestor Name

Name of the Customer who initiated the Incident/Request.

Provide a name in the Requestor field (ex: Max), and then
press <Enter> or <Tab> to locate the Customer record.

Note: Wildcards like % or * can be used with partial
information. If an exact match is found, the information
autopopulates the Requestor, Phone, and E-mail fields. If
multiple matches are found (ex: Multiple Customers named
Max), the Contact Manager opens so that the technician can
select the appropriate one.

Manually launch the Contact Manager by clicking the Contact

Manager button .

View the Customer's Contact record by clicking the Go To

button .

*Required

After you select a Customer, the Photo, Phone, and E-
mail fields are autopopulated with information from the
Customer record.

If the Customer is a VIP, a VIP icon appears in the
Requestor area to notify you of his importance.

Alt. Contact Info
Alternate phone number or e-mail address of the Customer
who initiated the Incident/Request.

 

Avatar
Avatar (photo or image) of the Customer who initiated the
Incident/Request.

The Avatar, Phone, and E-mail fields are autopopulated
with information from the Requestor's Customer Record.

One-Step (Dial Customer Phone): Dials the Customer's
phone number.

One-Step (Follow-up E-mail): Creates a follow-up e-mail
to send the Customer regarding a question or update
about the Incident. Allows the User to edit the e-mail
before clicking Send. Attaches the e-mail to the Incident
History record.
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Field Description Comments

E-mail

E-mail address of the Customer who initiated the Incident/
Request.

Click the link to create an e-mail addressed to the Customer
(if e-mail is configured).

Phone

Phone number of the Customer who initiated the Incident/
Request.

Click the link to dial the Customer (if telephony is configured).

Status Bar
Current and next status of the Incident as it progresses
through the Incident workflow.

Incident statuses do not align with Incident phases.

Status

Statuses include:

• New: Incident/Request was created and initial details
are being entered.

• Assigned: Incident/Request has been assigned to a
record owner.

• In Progress: Incident/Request is being investigated/
fulfilled by a record owner and/or Task owners.

• Pending: Incident/Request is temporarily paused (Stop
The Clock).

• Resolved: Incident/Request has been investigated/
fulfilled and is waiting to be closed.

• Closed: Incident/Request is closed.

• Reopened: Incident/Request is reopened because the
issue was not fixed or reoccurred.

 

Next: Status
Click the links to move the Incident/Request through the
Incident/Request workflow. Actions include:

One-Steps (Alt 1 Step from Relationship, Alt 2 Step from
Relationship, or Next Step from Relationship):

Conditionally changes the record status to next logical
status (defined by the status values in Table
Management).

 
• Begin Work: Captures a date-time stamp to track when

work began on the Incident/Request.

One-Step (Start Work In Progress): Tracks the date/time
responded and changes the Incident Status to In
Progress. If ownership has not yet been assigned,
assigns the Incident to the current User and the Team
that User belongs to.
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Field Description Comments

 
• Set Pending: Temporarily pauses the Incident/Request

(Stops the SLA Clock).

One-Step (Set Pending): Changes Incident Status from
In Progress or Reopened to Pending in order to pause
the SLA Clock (Stop The Clock). For Incidents in Pending
Status, sets them to their previous Status using the
Remove Pending Status link.

 
• Resolve: Prompts the User to log the Resolution details

(Close Description) and Cause Code.

One-Step (Resolve Incident): Changes Incident Status
from In Progress to Resolved, and then prompts the User
for a Close Description and Cause Code if those fields
are empty. Pops up a message if the Incident Record has
open Tasks associated with it that need to be closed
before the Incident is Resolved.

 
• Close: Manually closes the Incident/Request. Note: A

CSM Automation Process/One-Step automatically
closes Incidents after three (3) days.

One-Step (Close Incident): Changes the Incident Status
from Resolved to Closed. Prompts the User to fill in
Resolution Notes and Cause Code if those fields are
empty.

 
• Reopen: Reopens a Resolved Incident/Request

because it was technically not resolved. Restarts the
SLA Clock.

One-Step (Reopen Incident): Changes the Incident
Status from Resolved to Reopened, and clears the
resolution fields. Sets the Resolved Time in minutes and
the Total STC Time in minutes to restart the SLA Clock.

Owned By Record owner.  

User Owner

-select owner-

Name of the User owner. Click the link to first select a Team
and then a User owner (User is limited by Team).

Typically, the owner is the Reviewer and a member of the
Support Team.

One-Step (Assign to Individual):

Launches the Choose Team window, where a User can
choose an Owned By Team for the record; then,
launches the Choose User window, where a User can
choose a Primary User from the already-selected Team.

Team Owner

-select team-

Name of the Team owner. Click the link to select a Team
owner.

One-Step (Assign to Team):

Launches the Choose Team window, where a User can
choose an Owned By Team for the record.

Assign to
Click the link to select a User owner for the Incident. The
Team owner is populated by the selected User owner's OOTB
Team.

One-Step (Assign to ANY Individual): Prompts the User
to assign the record to any CSM User (not limited by
Team). Uses Owned By ID and Owned By Team fields.

Avatar
Photo/graphic associated with the User owner (from User
Profile).

 

Owner E-mail Address Owner's e-mail address (from User Profile).  

Owner Phone Number Owner's phone number (from User Profile).  

I Want To Common operations (initiate Actions/One-Steps).  
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Field Description Comments

Take Ownership
Click the link to make yourself (Current User) the User owner
for the Incident.

One-Step (Take Ownership):

Makes the Current User the Primary User of the record.

View detailed date/time information

Click the link to open the Information window, where you can
view current status, created date and time, creator name, and
last edited date and time. Time Date/time format is MM/DD/
YYYY HH:MM.

One-Step (Date Time Stamps Popup): Displays details
for all the date/timestamps to give a historical view.

Link to existing Major Incident/Unlink
from Major Incident

Click the link to create a relationship between the incident/
Request and a Major Incident. When a Major Incident is
Resolved, you can also resolve all the Incidents linked to it
(see the Major Incident - Resolve Linked One-Step).

One-Step (Link or Unlink to Major Incident): Links the
current Incident to an existing Major Incident specified in
the User prompt. If the current Incident is already linked
to a Major Incident, removes the link.

Submit to Knowledge Base

Click the link to create a new Knowledge Article (KA) that
uses the Description, Categorization, and solution/
workaround from the Incident/Request. A KA is a separate
record with its own workflow.

One-Step (Nominate for KB): Creates a new Knowledge
Article (KA) populated with the Description,
Categorization, and Solution/Workaround from the
Incident.

Track time
Click the link to create a Time Log Task to record details and
time spent on a Task completed for the Incident.

One-Step (Track Time Against Incident): Creates a Task
time tracking entry and prompts the User for time spent
and task completion details. Sets the Task Close Code to
Completed.

 

Linked to Major Incident
Click the link to open the Major Incident, when one is linked to
the Incident in focus.

One-Step (Go to Major Incident): Navigates the User to
the Major Incident, when one is linked to the Incident in
focus.

I Want To Common operations (initiate Actions/One-Steps).  

Take Ownership
Click the link to make yourself (Current User) the User owner
for the Incident.

One-Step (Take Ownership):

Makes the Current User the Primary User of the record.

View detailed date/time information

Click the link to open the Information window, where you can
view current status, created date and time, creator name, and
last edited date and time. Time Date/time format is MM/DD/
YYYY HH:MM.

One-Step (Date Time Stamps Popup): Displays details
for all the date/timestamps to give a historical view.

Link to existing Major Incident/Unlink
from Major Incident

Click the link to create a relationship between the incident/
Request and a Major Incident. When a Major Incident is
Resolved, you can also resolve all the Incidents linked to it
(see the Major Incident - Resolve Linked One-Step).

One-Step (Link or Unlink to Major Incident): Links the
current Incident to an existing Major Incident specified in
the User prompt. If the current Incident is already linked
to a Major Incident, removes the link.

Submit to Knowledge Base

Click the link to create a new Knowledge Article (KA) that
uses the Description, Categorization, and solution/
workaround from the Incident/Request. A KA is a separate
record with its own workflow.

One-Step (Nominate for KB): Creates a new Knowledge
Article (KA) populated with the Description,
Categorization, and Solution/Workaround from the
Incident.
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Field Description Comments

Track time
Click the link to create a Time Log Task to record details and
time spent on a Task completed for the Incident.

One-Step (Track Time Against Incident): Creates a Task
time tracking entry and prompts the User for time spent
and task completion details. Sets the Task Close Code to
Completed.

 

Linked to Major Incident
Click the link to open the Major Incident, when one is linked to
the Incident in focus.

One-Step (Go to Major Incident): Navigates the User to
the Major Incident, when one is linked to the Incident in
focus.

Workflow Bar
Displays the Incident/Request workflow phases. Dark gray
indicates the current phase.

Incident phases do not align with Incident statuses.

 

Workflow phases include:

• Detect: Incident is detected (Portal, call, e-mail,
automated). This phase is not tracked in CSM.

• Record: Technician creates the Incident and records the
initial Who (Requestor), What (Description), and How
(Call Source) details.

• Classify: Technician classifies the record
(Categorization, Priority, Major Incident, and CI).

• Investigate (Incident) or Fulfill (Request): Technician
investigates/diagnoses the Incident or fulfills the
Request.

• Resolve: Technician resolves the Incident/Request and
initiates recovery procedures, if needed.

• Closed: Incident/Request is closed.

 

Main Pane   

Step 1: Record the Details Record the basic details.  

Last Edited by...
Date, time, and user name information is recorded the first
time the form is saved, and each time the form is modified.

 

*Requestor Select a Requestor/Initiator (see above). *Required

*Short Description A concise description of the Incident/Request.. *Required

*Description Description of the Incident/Request. *Required. Full-Text field (searchable).
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Field Description Comments

Call Source

Detection source for the Incident/Request:

• Walk In

• Social Media

• E-mail

• Event

• Phone

• Portal

 

Step 2: Classification Classify the issue.

Classifies the record (Categorization (Incident or
Request), Priority, Major Incident, and CI). Determines
the Specifics Screen for capturing the appropriate details
(Specifics forms).

Service

Service affected by Incident/Request:

• Account Management

• Conferencing/Presentation

• Desktop Management

• E-mail/Calendaring

• Employee Support

• Enterprise Apps

• IT Service Desk

• Network Services

• Printing

• Telephony/Fax

• Web Services

You can classify an Incident from top down by first
selecting a Service, then a Category, and then a
Subcategory, or you can select the three-tier combination
at once by clicking the click the Incident Subcategory

Selector button . Click Clear Classification to Clear the
Categorization fields.

Note: The Knowledge Button  is visible next to the
Service field when you select a Service in the drop-down.
Click the button to search the Service title (ex: Printing) in
the Knowledge Base and view Search Results in the
Knowledge Pane.

For more information, see Service Categorization.

Category Service Category that the record relates to (ex: Mobile Client).

Subcategory
Service Subcategory that the KA relates to (ex: Submit
Incident).

Priority
Indicates the established timescales and effort to respond to
and resolve an issue (Incident or Request). Priority is derived
from an impact and urgency Priority Matrix.

For more information, see Priority.

Major Incident
When selected, indicates that the Incident/Request is
considered a Major Incident (ex: a Priority 1 Incident/Request
that requires a coordinated effort).

 

Primary CI CI affected by the Incident/Request, if any.  

Step 3: Investigate   
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Field Description Comments

Specifics forms Specifics forms vary. For more information, see Specifics forms.

Arrangement
Dynamically displays child records that are in a relationship
with the Incident.

 

Resolution Details
Displays related Resolution Detail records that are created to
track the Resolution Details and possibly the Cause Code (if it
is an Incident).

 

Journals

Displays related Journal records that are created to track User
notes/comments, Customer requests/comments, field and
Status changes, SLM history, Queue history, and e-mail
correspondence.

For more information, see Incident Journals.

Tasks
Displays related Tasks (Escalations, Time Entries, and Work
Items).

For more information, see Incident Tasks.

Similar Incidents

Displays similar Incidents (if applicable) that are found through
Incident Matching to determine if the Incident/Request has a
known solution/workaround, is part of a larger Problem, is a
duplicate, etc.

 

Configuration Items
Displays CIs that are related to/support this Incident (ex:
Primary CI).

For more information, see About CMDB.

SLM History
Displays related SLA/SLM records (SLA breaches, warnings,
and changes in the Pending status for Stop The Clock ).

 

Change Request Displays Change Requests that involve this Incident. For more information, see About Change Requests.

Problem Displays Problems that involve this Incident. For more information, see About Problems.

Linked Incidents Displays related Incidents that involve this Incident.  
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Specifics Forms
Specifics forms are context-sensitive forms that are embedded into Incident and Service Request records
to capture relevant data for the different Categorizations of Incidents and Service Requests. For example,
different details are needed for a Printing Incident than for a Mobile Phone Request. Using Specifics forms
allows the Service Desk to capture the exact data to determine a resolution more quickly by either asking
scripted questions to lead to the appropriate answer or capture the correct data for subsequent support
teams involved in the functional escalation process.

CSM provides OOTB Specifics forms for each Service:
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Standard Details Specifics Form
The Standard Details Specifics form is invoked when a Service is categorized as:

Service Category Subcategory

Account Management <Any> <Any>

IT Service Desk <Any> <Any>

Enterprise Apps <Any> <Any>

Many other Subcategories use the Standard Details Specifics form; they are noted in later tables.
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Conferencing/Presentation Specifics Forms
The Conferencing/Presentation Specifics form is invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

Conferencing/Presentation <Any> <Any> Presentation
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Desktop Management Specifics Forms
The Desktop Management Specifics form is invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

Desktop Management Computer Request New Computer New Device

All other Categories/Subcategories invoke the Standard Details Specifics form.
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E-mail/Calendaring Specifics Forms
The E-mail/Calendaring Specifics forms are invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

E-mail/Calendaring Browser Client Request Access/Installation Website Address

E-mail/Calendaring Browser Client Submit Incident Connectivity

E-mail/Calendaring Desktop Client Request Access/Installation Standard Details

E-mail/Calendaring Desktop Client Submit Incident Connectivity

E-mail/Calendaring Mailbox Request Disk Quota Increase Request Disk Quota Increase

E-mail/Calendaring Mailbox Request Mailbox or Alias Request Mailbox or Alias

E-mail/Calendaring Mailbox Spam Filter Request Spam Filter Request

E-mail/Calendaring Mobile Client Request Access/Installation Standard Details

E-mail/Calendaring Mobile Client Submit Incident Connectivity
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Employee Support Specifics Forms
The Employee Support Specifics forms are invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

Employee Support Add/Change Employee Separation Employee Departure

Employee Support Add/Change New Employee Setup New Employee

Employee Support Add/Change Update Employee Update Employee
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Network Services Specifics Forms
The Network Services Specifics forms are invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

Network Services Backup/Restore Request Full Restore of backup Backup/Restore

Network Services Backup/Restore Request new backup job Backup/Restore

Network Services Backup/Restore Request restore of files Backup/restore

Network Services Fileserver Request File Share Request File Share

Network Services Fileserver Request increase in disk quota Request Increase in Disk Quota

Network Services Physical Wires Request New Wiring Request New Wiring

Network Services Physical Wires Request Relocation of Wiring Request Relocation of Wiring

Network Services Physical Wires Submit Incident Standard Details

Network Services Wireless Request Access Request Access

Network Services Wireless Submit Incident Standard Details

44

CSM Record Management

CSM Record Management



Printing Specifics Forms
The Printing Specifics forms are invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

Printing Desktop Request desktop printer Printer Order

Printing Desktop Request Toner/Ink Toner Order

Printing Desktop Submit Incident Print Incident

Printing Network Request access to network printer Request Access to Network Printer

Printing Network Request new Network Printer Printer Order

Printing Network Request Toner/Ink Toner Order

Printing Network Submit Incident Print Incident
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Telephony/Fax Specifics Forms
The Telephony/Fax Specifics forms are invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

Telephony/Fax Call Center Telephony Move/Add/Change User or Queue Standard Details

Telephony/Fax Call Center Telephony Request ACD/IVR Change Standard Details

Telephony/Fax Call Center Telephony Submit Incident Phone/Fax Incident

Telephony/Fax Desktop Telephone Request Telephone Standard Details

Telephony/Fax Desktop Telephone Submit Incident Phone/Fax Incident

Telephony/Fax Fax Request Fax Hardware Standard Details

Telephony/Fax Fax Request Fax Software Standard Details

Telephony/Fax Fax Request Toner/Ink Standard Details

Telephony/Fax Fax Submit Incident Phone/Fax Incident

Telephony/Fax Mobile Telephone Request Telephone Standard Details

Telephony/Fax Mobile Telephone Submit Incident Phone/Fax Incident
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Web Services Specifics Forms
The Web Services Specifics forms are invoked when a Service is categorized as:

Service Category Subcategory Specifics Form

Web Service Internet Request new page or Site Request New Page or Site

Web Service Internet Request update to page or Site Request New Page or Site

Web Service Internet Submit Incident Standard Details

Web Service Intranet Request new page or Site Request New Page or Site

Web Service Intranet Request update to page or Site Request New Page or Site

Web Service Intranet Submit Incident Standard Details
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Dynamic Specifics Forms
Dynamic Specifics Forms allow you to select Computer and Mobile Device accessories on the New
Employee and New Device Specifics Form. Users configure the functionality by adding accessory titles
and costs to each Computer and Mobile Device item in the Product Catalog Lookup Table. Accessory
values dynamically display based on the selected Computer or Mobile Device item.
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Configure Dynamic Specifics Forms
Complete the following procedure to configure Dynamic Specifics Forms. Configuration procedures are
completed in the CSM Desktop Client.
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Define Accessories and Permissions for a
Computer CI

Use Table Management in the CSM Desktop Client to define accessories for a Computer CI.

To define accessories for a Computer CI:

1. In the CSM Desktop Client menu bar, click Tools>Table Management.

The Table Management interface opens.

2. In the Type drop-down, select Product Catalog.

Product Catalog items open in the Grid.

3. Select a Computer item (example: Latitude E5530 Laptop), and then click the Show Current
Record button.

The record (example: Product - Latitude E5530 Laptop) opens.

4. Define accessories for the item:
a. In an accessory field, type the name of the accessory (example: Carrying Case).

b. In the Cost field, type the cost of the accessory (example: 59.99).

Note: You must define accessories for each Computer item in your Product Catalog.

5. Define permissions for who can access the item in the drop-down on the Specifics Form:
a. Click the Include Specific Departments link.

b. Do one of the following to grant permissions to access the item in the drop-down on the
Specifics Form:

◦ Click the add from list link to grant permissions to a all members of a specific
department.

◦ Click the add all departments link to grant permissions all members of all company
departments.

Tip: To remove all departments from the list, click the Clear All link.

6. Click Save.
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Define Accessories and Permissions for a Mobile
Device CI

Use Table Management in the CSM Desktop Client to define accessories for a Mobile Device CI.

To define accessories for a Mobile Device CI:

1. In the CSM Desktop Client menu bar, click Tools>Table Management.

The Table Management interface opens.

2. In the Type drop-down, select Product Catalog.

Product Catalog items open in the Grid.

3. Select a Mobile Device item (example: Apple iPhone 5 32GB), and then click the Show Current
Record button.

The record (example: Product - iPhone 5 32GB) opens.

4. Define accessories for the item:
a. In an Accessory field, type the name of the accessory (example: Phone Case).

b. In the Cost field, type the cost of the accessory (example: $35.00).

Note: You must define accessories for each Mobile Device item in your Product
Catalog.

5. Define permissions for who can access the item in the drop-down on the Specifics Form:
a. Click the Include Specific Departments link.

b. Do one of the following to grant permissions to access the item in the drop-down on the
Specifics Form:

◦ Click the add from list link to grant permissions to a all members of a specific
department.

◦ Click the add all departments link to grant permissions all members of all company
departments.

Tip: To remove all departments from the list, click the Clear All link.

6. Click Save.
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Using Dynamic Specifics Forms
When working with Dynamic Specifics Forms, Users can:
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Add Accessories to a Computer CI and Mobile
Device CI

Use the Incident Form in the CSM Desktop Client to add accessories to a Computer CI and Mobile Device
CI.

To add accessories to a Computer CI and Mobile Device CI:

1. In the CSM Desktop Client, log a new Incident (New > Incident).

A new Incident record is created.

2. Classify the Incident as a New Employee Setup:
a. Service: Select Employee Support.

b. Category: Select Add/Change.

c. Subcategory: Select New Employee Setup.

The New Employee Specifics Form opens.

Note: The configured Computer and Mobile Device accessory and cost values are also
available on the New Device Specifics Form. Access the form by classifying the Incident as a
Request New Computer (Service: Desktop Management, Category: Computer, Subcategory:
Request New Computer).

3. In the Computer section, select an item from the Computer drop-down (example: Latitude E5530
Laptop).

Note: Your department must have defined permissions to access the item.

The defined Computer accessories display.

a. Select an accessory check box (example: Carrying Case $59.99).

The price of the accessory is added to the Computer Details calculation, and an Ordered
[Item] check box displays on the form.

4. In the Mobile Device section, select an item from the Mobile Device drop-down (example: iPhone 5
32GB).

The defined Mobile Device accessories display.

a. Select an accessory check box (example: Car Charger $19.95).

The price of the accessory is added to the Computer Details calculation, and an Ordered
[Item] check box displays on the form.

5. Complete the Incident logging process.
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Incident Tasks
A Task is a piece of work that is created and assigned to another CSM User or Team to help resolve/fulfill
an Incident/Service Request, Problem, or Change Request (example: An Incident might require a server
reboot). Tasks can also be used to successfully complete a Project or Release (example: A Project might
require a new switch). Use Tasks to distribute and track individual pieces of work assigned to Teams or
Users within the context of an Incident.

The following OOTB Task types are available for Incidents:

• Escalation: A Task assigned to a higher tier of support.

• Time Entry: A Task for tracking time against a parent object.

• Work Item: A Task for either immediate action or future completion.

The Task form captures and manages your Tasks. The Task form is a child record that is linked to and
available from its parent Incident Form (access the form by clicking the Tasks tab in the Incident
Arrangement). The Task form that is accessed from an Incident is an abbreviated form view.

To view the detailed Task form, click the Go to Record button , or search for the Task using a Quick
Search or Search Group.

Note: For detailed information about the Task form, refer to the Task form documentation.

55

CSM Record Management

CSM Record Management



Incident Journals
CSM provides the following OOTB Incident Journal types:

• Journal - Note: Tracks User notes/comments. For example, a User might chronicle troubleshooting
progress.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt, follow-
up, resolution, and questions.

• Journal - SLM History: Tracks SLA breaches, warnings, and changes in the Pending status for
Stop the Clock.

• Journal - Queue History: Tracks when records are added to/removed from a Queue.

• Journal - Remote Support History: Tracks chat/remote support sessions.

Note: History Journals are automatically created by CSM. Notes are manually created in
CSM by clicking New Journal. Customer Requests are manually created in the Portal.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).
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Incident Dashboards
CSM provides the following OOTB Incident Dashboards:
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Incident Dashboard
CSM provides an OOTB Incident Dashboard that intuitively organizes your critical Incident metrics into a
single, real-time, at-a-glance Incident control panel.

Note: Incidents metrics are also found on other OOTB Dashboards (ex: Global IT and Executive).

The following table describes the items on the Dashboard.

Item Description
Widget
Type

Widget Name Widget Uses:

Create New
Incident

Creates a new Incident Record. Button NA
Create Business
Object Action

Total Open
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed).
Drills down into the Incident
Details Dashboard.

Text
Gauge

Total Open
Incidents

Open Incidents
Search Group

Incident Details
Dashboard

Reopened
Incidents

Number of Reopened Incidents
(Status = Reopened).

Text
Gauge

Total Reopened
Incidents

Re-Opened
Incidents Search
Group
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Item Description
Widget
Type

Widget Name Widget Uses:

Pending
Incidents

Number of Reopened Incidents
(Status = Pending).

Text
Gauge

Current Pending
Incidents

Pending Incidents
Search Group

Open
Overdue
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed)
that have not been resolved by the
SLA deadline.

Text
Gauge

Current Overdue
Incidents

Open Overdue
Search Group

Open VIP
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed)
initiated by a VIP Customer.

Text
Gauge

Total Open VIP
Incidents

Total Open VIP
Incidents Search
Group

Unowned
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed)
that have an empty Ownership
field.

Text
Gauge

CDCurrent
Unknown
Incidents

Current Unknown
Incidents Search
Group

Open
Incidents by
Category

Percentage of Open Incidents
(Status does NOT = Resolved or
Closed) by Service Category. Pie
slices represent Service
Categories.

Pie Chart
Incidents by
Category

Open Incident
Search Group

Open Incident
Lifecycle

Percentage of Open Incidents
(Status does NOT = Resolved or
Closed) by Status. Pipeline Slices
represent Incident Statuses.

Pipeline
Chart

Incident
Lifecycle
Distribution

Open Incident
Search Group

Filter
Filters the data on the Dashboard
by time (ex: Today, yesterday,
within last week, etc.).

Filter
CD - Date Filter
- 30 day default
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Incident Details Dashboard
CSM provides an OOTB Incident Details Dashboard that provides more detailed Incident information,
including MTTR and lifecycle stats.
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Service Request Dashboard
CSM provides an OOTB Service Request Dashboard that intuitively organizes your critical Request
metrics into a single, real-time, at-a-glance Request control panel.

Note: Request metrics are also found on other OOTB Dashboards (ex: Global IT and Executive).

The following table describes the items on the Dashboard.

Item Description
Widget
Type

Widget Name Widget Uses:

Total Open
Requests

Number of Open Requests (Status
does NOT = Closed or
Reopened).

Text Gauge
Total Open
Requests

Open Requests
Search Group

Pending
Requests

Number of Reopened Requests
(Status = Pending).

Text Gauge
Current Pending
Requests

Pending
Requests
Search Group

Open Overdue
Requests

Number of Open Requests (Status
does NOT = Closed or Reopened)
that have not been resolved by the
SLA deadline.

Text Gauge
Current
Overdue
Requests

Open Overdue
Search Group
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Item Description
Widget
Type

Widget Name Widget Uses:

Open VIP
Requests

Number of Open Requests (Status
does not = Closed or Reopened)
initiated by a VIP Customer.

Text Gauge
Total Open VIP
Requests

Total Open VIP
Requests
Search Group

Unowned
Requests

Number of Open Requests (Status
does NOT = Resolved or Closed)
that have an empty Ownership
field.

Text Gauge
Unowned
Requests

Unowned
Requests
Search Group

Reopened
Requests

Number of Reopened Requests
(Status = Reopened).

Text Gauge
Total Reopened
Requests

Re-Opened
Requests
Search Group

Open
Requests by
Category

Percentage of Open Requests
(Status does NOT = Closed or
Reopened) by Service Category.

Pie Chart
Requests by
Category

Open Requests
Search Group

Open
Requests in
Lifecycle

Percentage of Open Requests
(Status does NOT = Closed or
Reopened) by Status.

Pipeline
Chart

Request
Lifecycle
Distribution

Open Requests
Search Group
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Incident One-Steps
CSM provides the following default Incident One-Steps:

One-Steps Description/Actions Associations Executed From

Status    

Alt 1 Step from
Relationship

Conditionally change the Incident Status to
next logical Status (defined by the Incident
Status values in Table Management) and/or
initiate the next appropriate One-Step:

Incident

 

Incident Form: Next:
<Status>

 

Alt 2 Step from
Relationship

Next Step from
Relationship

Form    

Ownership    

Assign to ANY
Individual

Prompts the User to assign the record to
any CSM User (not limited by Team). Uses
Owned By ID and Owned By Team fields.

Changes the Incident Status from New to
Assigned.

Incident
Incident Form: Assign
To link

Assign to
Individual

Launches the Choose Team window, where
a User can choose an Owned By Team for
the record; then, launches the Choose User
window, where a User can choose a
Primary User from the already-selected
Team.

Changes the Incident Status from New to
Assigned.

Incident
Incident Form: Owned
By link

Assign to Team
Launches the Choose Team window, where
a User can choose an Owned By Team for
the record.

Incident
Incident Form: Owned
By Team: link

Take Ownership

Makes the Current User the Primary User
of the record.

Changes the Incident Status from New to
Assigned.

Incident
Incident Form: Take
Ownership link (I Want
To section)

Other    
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Date Time
Stamps Popup

Displays details for all the date/timestamps
to give a historical view of the Incident.

Incident

Incident Form: View
Detailed Date/Time
Information link (I Want
To section)

Link or Unlink to
Major Incident

Links the current Incident to an existing
Major Incident specified in the User prompt.
If the current Incident is already linked to a
Major Incident, removes the link.

Use to create a relationship between
Incident(s) and a Major Incident. When a
Major Incident is Resolved, you can also
resolve all of the Incidents linked to it (see
the Major Incident - Resolve Linked One-
Step).

Incident

Incident Form: Link to
Existing Major Incident
or Unlink from Major
Incident link (I Want To
section)

Nominate for
KB

Creates a new Knowledge Article (KA)
populated with the Description,
Categorization, and Solution/Workaround
from the Incident.

Use to submit information from an Incident
Record as a KA to the Knowledge Base. A
KA is a separate record with its own
workflow.

Incident

Incident Form: Submit
to Knowledge Base link
(I Want To section)

Incident form: Submit
to Knowledge Base
button in Resolution
Details (new tab that
appears in Form
Arrangement when
Incident is resolved)

Incident form:
Nominate for
Knowledge Base link in
Task Pane under
Incident Actions

Track Time
Against Incident

Creates a Task time tracking entry and
prompts the User for time spent and task
completion details. Sets the Task Close
Code to Completed.

Use to create a Time Log Task to record
details and time spent on a Task completed
for the Incident.

Incident
Incident Form: Track
Time link (I Want To
section)

Go to Major
Incident

Navigates the User to the Major Incident,
when one is linked to the Incident in focus.

Incident
Incident Form: Linked
to Major Incident link (I
Want To section)
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A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.
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Incident Search Groups
CSM provides numerous OOTB Incident Search Groups. Notable Incident Search Groups include:

Search Group Returns Association Executed From

All Incidents All Incidents and Requests. Incident
Search Manager,
Widgets

Closed on 1st Call
(Incidents and Requests)

Incidents and Requests closed on the
first call.

Incident
Search Manager,
Widgets

Incidents by Priority Incidents with a User-selected Priority. Incident Search Manager

Incidents Linked to
Problem

Open Incidents that are linked to a
Problem.

Incident
Search Manager,
Widgets

My Open Incidents
Open Incidents owned by me (Current
User).

Incident
Search Manager,
Reports

My Open Incidents and
Requests

Open Incidents and Requests owned
by me (Current User).

Incident
Search Manager,
Widgets

My Teams Open
Incidents

Open Incidents owned by one of my
(Current User) Teams.

Incident Search Manager

Open Incidents and
Requests

Open Incidents and Requests. Incident
Search Manager,
Widgets

VIP Open Tickets
Open Incidents and Requests that are
initiated by a VIP Customer.

Incident
Search Manager,
Metrics, Widgets

VIP Tickets All VIP Incidents and Requests. Incident Search Manager
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Incident Automation Processes
CSM provides the following OOTB Incident Automation Processes:

Name Description

Incident -
Confirmation Email
on Create

When an Incident is created, the process initiates the Incident Confirmation
One-Step, which sends the Customer an e-mail to confirm their record and
provide the Record ID number.

Incident - Not
Touched in 3 Days

Waits for the Last Modified Date Time Field to update. If the Field is not updated
for three days, the process initiates the SLA Escalate if Not Touched in 3 Days
One-Step that sends an e-mail to the Incident owner with a reminder to follow
up with the Customer.

Notify Incident Owner
of a new Journal -
Note

When a Journal is added to an Incident, the process initiates the Notify Owned
By of a New Journal-Note One-Step, which sends a notification e-mail to the
Incident owner.

Notify Incident Owner
of Assignment

When the Owned By Field of an Incident changes, the process initiates the
Notify Owned By Via E-mail One-Step, which sends a notification e-mail to the
assigned Incident owner.

Notify Incident Team
of Assignment

When the Owned By Team Field of an Incident changes, the process initiates
the Notify Owned By Team Via E-mail One-Step, which sends a notification e-
mail to the assigned Team.

Resolve By
Breached - Incident
Changed from
Pending

Waits for the Resolve by SLA Deadline value to pass after the status of an
Incident is changed from Pending. If it passes, this process sends an e-mail to
the manager of the User who owns the Incident and creates a Journal entry to
record the breach.

Resolve By
Breached - Incident
Created

Waits for the Resolve By SLA Deadline value to pass after an Incident is
created. If it passes, this process labels the Incident as Breached and sends an
e-mail to the manager of the User who owns the Incident.

Resolve By
Breached - Incident
Reopened

Waits for the Resolve By SLA Deadline value to pass after an Incident is
reopened. If it passes, this process labels the Incident as Breached and sends
an e-mail to the manager of the User who owns the Incident.

Resolve By Warning
- Incident Changed
from Pending

Waits for the SLA Resolution Warning Deadline value to pass after an Incident
status is changed from Pending. If it passes, this process sends an e-mail to the
manager of the User who owns the Incident and creates a Journal entry
warning that the SLA resolution time is about to breach.

Resolve By Warning
- Incident Created

Waits for the SLA Resolution Warning Deadline value to pass after an Incident
is created. If it passes, this process sends an e-mail to the manager of the User
who owns the Incident and creates a Journal entry warning that the SLA
resolution time is about to breach.

Resolve By Warning
- Incident Reopened

Waits for the SLA Resolution Warning Deadline value to pass after an Incident
is reopened. If it passes, this process sends an e-mail to the manager of the
User who owns the Incident and creates a Journal entry warning that the SLA
resolution time is about to breach.
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Name Description

Resolved - Calc SLA
Good Fields

When the Status Field of an Incident changes to Resolved, the process uses an
Expression (SLA Calculations) to determine whether the date and time of the
resolution is less than or equal to the SLA resolve deadline.

Tip: Use this Automation Process for Report or Dashboard metrics.

Resolve to Closed
Process

Waits for three days after the status of an Incident is changed to Resolved. If the
status does not change from Resolved, it marks the status as Closed.

Respond by
Breached - Incident
Created

Waits for the Respond By SLA Deadline value to pass after an Incident is
created. If it passes, this process labels the Incident as Breached and sends an
e-mail to the manager of the User who owns the Incident to notify them of the
breach.

Respond by Warning
- Incident Created

Waits for the SLA Response Time value to pass after an Incident is created. If it
passes, this process sends an e-mail to the manager of the User who owns the
Incident and creates a Journal entry warning that the SLA resolution time is
about to breach.

Responded - Calc
SLA Good Field

When the Status Field of an Incident changes from New to Work In Progress,
the process uses an Expression (SLA Calculations) to determine whether the
date and time of the response is less than or equal to the SLA response
deadline.

Tip: Use this Automation Process for Report or Dashboard metrics.

Too Many Open
Incidents

Waits for there to be more than 10 open Incidents related to the E-mail/
Calendaring Service. If that threshold is reached, the Automation Process
initiates a One-Step that sends the owner a notification e-mail.
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Incident Reports
CSM provides numerous OOTB Incident Reports, including several Reports with drill-down functionality.
Notable Incident Reports include:

Report Description Association
Search
Group

Incidents by
Owner

Bar chart shows the number of Incidents by CSM
User within a User-specified date range. Also lists
Incident details.

Incident
Date Range
for Report

Incidents by
Team

Bar chart shows the number of Incidents by Team
within a User-specified date range. Also lists Incident
details.

Incident
Date Range
for Report

Incidents by
Category

Bar chart shows the number of Incidents by
Category within a User-specified date range. Also
lists Incident details.

Incident
Date Range
for Report

Incidents by
Priority

Pie chart shows the percentage of Incidents by
Priority within a User-specified date range. Also lists
Incident details.

Incident
Date Range
for Report

Incidents that
Occur Most
Often

Bar chart shows the top five Incident categories by
the number of Incidents within a User-specified date
range. Also lists Incident details.

Incident
Date Range
for Report

Overdue
Incidents

Bar chart shows the number of overdue Incidents by
Owner. Also lists Incident details.

Incident
Open
Overdue

Top 10 High
Volume
Customers

Bar chart shows the number of Incidents by
Customer within a User-specified date range. Also
lists Incident details.

Incident
Date Range
for Report

Incident Duration
Metrics

Bar charts (each priority (priority 1, priority 2, priority
3) show the number of closed Incidents by duration
(days) within a User-specified date range. Also lists
Incident details.

Incident
Closed in
Date Range

My Open
Incidents

Lists open Incidents owned by me (Current User). Incident
My Open
Incidents

My Open
Incidents by
Category

Lists open Incidents owned by me (Current User) by
category.

Incident
My Open
Incidents

Condensed High
Volume
Customers

Drill-down Report. Bar graph shows the top ten
Customers based on the number of submitted
Incidents within a User-specified date range. Also
lists Incident details.

Drill down to view the Incidents by clicking a link in
the Incident ID column.

Incident
Date Range
for Report
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Report Description Association
Search
Group

Condensed
Incident Duration
Metrics

Drill-down Report. Three bar graphs (based on
Priority) show the number of days required to close
Incidents within a User-specified date range. Also
lists Incident details.

Drill down to view the Incidents by clicking a link in
the Incident ID column.

Incident
Closed in
Date Range

Condensed
Incidents with
Longest Duration

Drill-down Report. Bar graph shows the number of
days required to close Incidents (by Incident
category) within a User-specified date range.

Drill down to view the Incidents by clicking a link in
the Incident ID column.

Incident
Date Range
for Report

Incident List with
Audit Trail

Drill-down Report. Lists Incidents and their
associated Journal Records within a User-specified
date range.

Drill down to view the Journals by clicking a link in
the Incident ID column. If an Incident does not have
any associated Journals, the Incident ID is not be
underlined (indicates a link).

Incident
Date Range
for Report

Incident List with
Task Audit Trail

Drill-down Report. Lists Incidents and their
associated Task records within a User-specified date
range.

Drill down to view the Journals by clicking a link in
Incident ID column. If an Incident does not have any
associated Tasks, the Incident ID is not be
underlined (indicates a link).

Incident
Date Range
for Report

Incidents by
Source Call

Drill-down Report. Pie chart shows the percentage of
Incidents based on the source of the initiation (ex: E-
mail, Portal, etc.) within a User-specified date range.

Drill down to view the Incidents by clicking a link in
the Incident Source column.

Incident
Date Range
for Report
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Service Portfolio/Service Catalog Management
Service Portfolio management is the process that allows organizations to create and manage a
comprehensive set of Service offerings for Customers. In CSM, the heart of the Service Portfolio is the
Service Catalog. The Service Catalog is imperative to a service desk because it defines and
communicates a list of Services that an organization provides to its employees or customers.

Each Service in a catalog is defined by:

• Basic information: Name, description, status, stakeholders/owners, costs, etc.

• Service Categorization: The Service categorization has a three-tiered organization (Service,
category, and subcategory) that determines the type of support required (Incident or Request),
which Specifics form to display to capture the appropriate details, and which Priority Matrix to use.

• SLAs: A Service Level Agreement (SLA) is an agreement between an entity (Customer, Service, or
Configuration Item) and a Service Provider that defines Response/Resolve target times for a
Service.

• Priority: The priority is used to establish timescales and effort to respond to and resolve an issue
(Incident or Request). Priority is derived from an impact and urgency Priority Matrix.
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About Services and Service Catalogs
The Service Catalog is imperative to a service desk because it defines and communicates a list of
Services that an organization provides to its employees or customers. Each Service in a catalog is
defined by:

• Basic information: Name, description, status, stakeholders/owners, costs, etc.

• Service Categorization: The Service categorization has a three-tiered organization (Service,
category, and subcategory) that determines the type of support required (Incident or Request),
which Specifics form to display to capture the appropriate details, and which Priority Matrix to use.

• SLAs: A Service Level Agreement (SLA) is an agreement between an entity (Customer, Service, or
Configuration Item) and a Service Provider that defines Response/Resolve target times for a
Service.

• Priority: The priority is used to establish timescales and effort to respond to and resolve an issue
(Incident or Request). Priority is derived from an impact and urgency Priority Matrix.

To get your service desk started, CSM provides a thorough OOTB Service Catalog (found in the CSM
Portal), shown in the following figure.

In CSM, a Service is a Major Business Object. The Service Form defines each Service. For more
information about the Service Form, refer to the Service Form documentation.

72

CSM Record Management

CSM Record Management



Service Categorization
The Service categorization has a three-tiered organization (Service, category, and subcategory) that
determines the type of support required (Incident or Request), which Specifics form to display to capture
the appropriate details, and which Priority Matrix to use.

The following figure shows how the Service, category, and subcategory work together to identify an issue
as an Incident or Request, and then display the appropriate Specifics Form.

The category and subcategory forms define your Service Categories/Subcategories. These forms are
child forms, and are linked to and available from their parent Service Form (Category and subcategory
tabs in the Service Form's Arrangement section). There are several different Specifics Forms, the
Subcategory Form determines the Specifics Form that displays.
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Service Good to Know
• Search for one or more Services that meet a specific criteria by running a Quick Search or Search

Group.

• The Service categorization has a three-tiered organization (Service, category, and subcategory) that
determines the type of support required (Incident or Request), which Specifics form to display to
capture the appropriate details, and which Priority Matrix to use.

• CSM provides several OOTB categories and subcategories to use as part of the Service
categorization. Use these categories and subcategories as-s, edit them, or create your own using
their respective forms in the Arrangement area of the Service Form.

• CSM implements several OOTB Actions/One-Steps to make Service management more efficient.
For more information about Actions and One-Steps, refer to the Actions/One-Steps documentation.
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OOTB Service Categories and Subcategories
CSM provides the following OOTB Categories and Subcategories.

Service Category Subcategory
Incident
Type

Specific Form

Account
Management

Network Access Change Password Request Standard Details

Account
Management

Network Access New Account Request Standard Details

Account
Management

Network Access Password Reset Request Standard Details

Account
Management

Network Access New Account Request Standard Details

Account
Management

Network Access
Remove Access/
Permissions

Request Standard Details

Account
Management

Self Service Change Password Request Standard Details

Account
Management

Self Service New Account Request Standard Details

Conferencing/
Presentation

Equipment
Request

Request Conference
Phone

Request Presentation

Conferencing/
Presentation

Equipment
Request

Request Projector Request Presentation

Conferencing/
Presentation

Equipment
Request

Request Webcam Request Presentation

Conferencing/
Presentation

Video/Audio
Conferencing

One-Time
Convergence Setup

Request Presentation

Conferencing/
Presentation

Video/Audio
Conferencing

Request Account Request Presentation

Desktop
Management

Anti-Virus
Request Installation/
Config

Request Standard Details

Desktop
Management

Anti-Virus Submit Incident Incident Standard Details

Desktop
Management

Computer
Request Computer
Upgrade

Request Standard Details

Desktop
Management

Computer
Request New
Computer

Request Order Computer

Desktop
Management

Computer
Request Removal of
Computer

Request Standard Details
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Service Category Subcategory
Incident
Type

Specific Form

Desktop
Management

Computer Submit Incident Incident Standard Details

Desktop
Management

Misc. Software
Request Installation/
Config

Request Standard Details

Desktop
Management

Misc. Software Submit Incident Incident Standard Details

Desktop
Management

OS Request Upgrade Request Standard Details

Desktop
Management

OS Submit Incident Incident Standard Details

E-mail/Calendaring Browser Client
Request Access/
installation

Request Website Address

E-mail/Calendaring Browser Client Submit Incident Incident Connectivity

E-mail/Calendaring Desktop Client
Request Access/
installation

Request Standard Details

E-mail/Calendaring Desktop Client Submit Incident Incident Connectivity

E-mail/Calendaring Mailbox
Request Disk Quote
Increase

Request
Request Disk Quota
Increase

E-mail/Calendaring Mailbox
Request Mailbox or
Alias

Request
Request Mailbox or
Alias

E-mail/Calendaring Mailbox Spam Filter request Request Spam Filter Request

E-mail/Calendaring Mobile Client
Request Access/
installation

Request Standard Details

E-mail/Calendaring Mobile Client Submit Incident Incident Connectivity

Employee Support Add/Change Employee Separation Request
Employee
Departure

Employee Support Add/Change New Employee Setup Request New Employee

Employee Support Add/Change Update Employee Request Update Employee

Enterprise Apps
Accounting
System

NA Incident Standard Details

Enterprise Apps
CRM/Sales
Software

NA Incident Standard Details

Enterprise Apps JD Edwards Convert to Option form Request Standard Details

Enterprise Apps JD Edwards Submit Incident Incident Standard Details

Enterprise Apps MS Office NA Request Standard Details

Enterprise Apps MS Office Submit Incident Incident Standard Details
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Service Category Subcategory
Incident
Type

Specific Form

Enterprise Apps Office Suite NA Request Standard Details

Enterprise Apps Oracle Convert to Option form Request Standard Details

Enterprise Apps Oracle Submit Incident Incident Standard Details

Enterprise Apps PeopleSoft NA Request Standard Details

Enterprise Apps PeopleSoft Submit Incident Incident Standard Details

Enterprise Apps SAP NA Request Standard Details

Enterprise Apps SAP Submit Incident Incident Standard Details

IT Service Desk
Report Outage or
Error

NA Incident Standard Details

IT Service Desk
Report Outage or
Error

Submit Incident Incident Standard Details

IT Service Desk Request Help NA Request Standard Details

IT Service Desk Request Help
Submit Service
Request

Request Standard Details

Network Services Backup/Restore
Request Full Restore
of backup

Request Backup/Restore

Network Services Backup/Restore
Request new backup
job

Request Backup/Restore

Network Services Backup/Restore
Request restore of
files

Request Backup/restore

Network Services Fileserver Request File Share Request Request File Share

Network Services Fileserver
Request increase in
disk quota

Request
Request Increase in
Disk Quota

Network Services Physical Wires Request new wiring Request Request New Wiring

Network Services Physical Wires
Request relocation or
wiring

Request
Request Relocation
of Wiring

Network Services Physical Wires Submit Incident Incident Standard Details

Network Services Wireless Request Access Request Request Access

Network Services Wireless Submit Incident Incident Standard Details

Printing Desktop
Request desktop
printer

Request Printer Order Form

Printing Desktop Request toner/ink Request Toner Order Form

Printing Desktop Submit Incident Incident Print Incident

Printing Network
Request access to
network printer

Request
Request Access to
Network Printer
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Service Category Subcategory
Incident
Type

Specific Form

Printing Network
Request new network
printer

Request Printer Order Form

Printing Network Request toner/ink Request Toner Order Form

Printing Network Submit Incident Incident Print Incident

Telephony/Fax
Call Center
Telephony

Move/add/change
user or queue

Request Standard Details

Telephony/Fax
Call Center
Telephony

Request ACV/IVR
change

Request Standard Details

Telephony/Fax
Call Center
Telephony

Submit Incident Incident Phone/Fax Incident

Telephony/Fax
Desktop
Telephone

Request telephone Request Standard Details

Telephony/Fax
Desktop
Telephone

Submit Incident Incident Phone/Fax Incident

Telephony/Fax Fax
Request FAX
hardware

Request Standard Details

Telephony/Fax Fax Request FAX software Request Standard Details

Telephony/Fax Fax Request FAX toner/ink Request Standard Details

Telephony/Fax Fax Submit Incident Incident Phone/Fax Incident

Telephony/Fax Mobile Telephone Request telephone Request Standard Details

Telephony/Fax Mobile Telephone Submit Incident Incident Phone/Fax Incident

Web Services Internet
Request new page or
site

Request
Request New Page
or Site Specifics
Screen

Web Services Internet
Request update to
page or site

Request
Request New Page
or Site Specifics
Screen

Web Services Internet Submit Incident Incident Standard Details
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Service Level Agreements (SLAs)
A Service Level Agreement (SLA) is an agreement between an entity (Customer, Service, or
Configuration Item) and a Service Provider that defines Response and Resolve target times for a Service.
SLAs can be a formal agreement between an organization and its Customers, or a guide for technicians.
CSM provides two types of SLA models, including time-based (default) and hierarchy-based. Use one of
these models to define how the system operates when multiple SLAs apply to a particular Incident/
Service Request. Since response and resolution deadlines can only be calculated based on one SLA, the
system must select which SLA these deadlines use during calculation.

Note: Changing the SLA model only affects Incidents and Service Requests created after the
model is selected, so we recommend choosing a model during initial implementation.

CSM provides the ability to set different SLA Respond/Resolve target times using the target times wizard.
SLA target times define the behavior of an SLA and are based on:

• Priority: A P1 should have faster target times than a P5.

• Record Type: A disruption (Incident) should have faster target times than a Request.

• SLA Type: SLAs can be bound to a Customer, a Service, and a CI. A critical CI (server) should have
faster target times than a non-critical system.

Use this comprehensive processing to ensure that Incidents and Requests involving Customers, Services,
and CIs are appropriately serviced according to the needs of your organization. For example, set a
Resolve Target Time of 90 hours for a P3 Corporate Request, such as a software upgrade. Consider a
faster resolve time (ex: 8 hours) for executives. Reserve your most aggressive Respond target times (ex: 5
minutes) for a critical P1 Config Item Incident, such as your Primary Server going down.

CSM also provides the ability to Stop The Clock (pauses the SLA Clock), define Business Hours (apply/
calculate SLA target times using working days/times), link Operational Level Agreements (OLAs) and
Underpinning Contracts, and set timeframes for potential breach warnings.

Note: For a detailed spreadsheet of OOTB SLA Respond/Resolve target times, organized by SLA
type, record type, priority, and Work Hours, see the SLA/Priority Spreadsheet. You can also use
this spreadsheet to design your own SLA structure/Priority Matrix.

In CSM, an SLA is a Major Business Object. The SLA Form defines and manages the SLA.
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SLA Good to Know
• CSM provides the ability to set different SLA Respond/Resolve target times based on:

• Priority: A P1 should have faster target times than a P5.

• Record Type: A disruption (Incident) should have faster target times than a Request.

• SLA Type: SLAs can be bound to a Customer, a Service, and a CI. A critical CI (server) should
have faster target times than a non-critical system.

• CSM provides multiple OOTB SLAs for use throughout CSM. Use these SLAs as-is or create your
own using the SLA form.

• The Respond By Warning and Resolve By Warning One-Steps use the Working Hours Calendar in
their calculations to ensure that Users receive SLA notifications during normal business hours.

• CSM implements several OOTB Actions/One-Steps to make Service Level Management more
efficient. For more information about Actions and One-Steps, refer to the Actions/One-Steps
documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• The Quick Info Tile (left) displays important at-a-glance information:
• The Status alert bar displays the current status of the SLA as it moves through its workflow.

The next status is displayed as a link directly beneath the current status. Click the status link to
move the SLA to the next status.

• The Breached Incidents alert bar displays the number of open Incidents that have breached
the SLA Resolve or Resolution deadline.

• The Open Incidents alert bar displays the number of open Incidents associated with the SLA.

• The Owner section displays the current owner (oneself, a User, or a Team). SLAs can be
assigned by clicking one of the Ownership links in the Quick Info Tile.

• The workflow bar (top of Main Pane) indicates the current phase of the SLA as it moves through its
workflow. Dark gray indicates the current phase.

• The Main Pane displays the main form fields.

• Fields:
• Some validated fields can recognize what you are typing and will suggest a value for you (ex:

Type "P" into the field; CSM will suggest the first item it finds that starts with the letter P). Use
your Down Arrow button to scroll through other possible values.

• Press F3 to open a Selector window, where you can select a legal value or create a new value.

• Press TAB to move to the "next" field on the form.

• Saving:

• Date, time, and user name information is recorded the first time the form is saved, and each
time the form is modified.

80

CSM Record Management

CSM Record Management



OOTB SLAs
OOTB SLAs are organized into the following SLA types:

• Config Item: SLAs for Configuration Items (CIs), typically based on criticality (ex: Primary Server).
A Config Item SLA overrides every other SLA (Service, Customer, and Corporate).

• Service: SLAs for a Service, typically based on criticality (ex: E-mail Service is really important). A
Service SLA overrides a Customer and Corporate SLA. Not many Services require a special SLA. In
the OOTB system, only Desktop Management and E-mail Calendaring have their own SLAs.

• Customer: SLAs for Customer levels, typically based on employee status (Platinum, Gold, Silver,
Bronze). A Customer SLA overrides a Corporate SLA.

• Corporate (default): Default SLA. Many organizations use only this SLA type.
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Define SLA Target Times for an Existing SLA
To define SLA target times for an existing SLA:

1. Open the SLA that you want to edit:
a. Click Searching on the CSM menu bar and select Search Manager.

The Search Manager opens.

b. Select SLA from the Association drop-down.

c. Click the All SLAs Search Group, and then click the Run button.

A list of SLAs opens in the Grid.

d. Double-click the SLA that you want to edit (ex: Corporate).

The SLA record opens.

2. (Optional) Edit SLA Fields.

Note: For detailed Field information, refer to the SLA Form in the online help.

3. Click the SLA Target Time tab (SLA Arrangement section).

4. Click an SLA Target Time (ex: Priority 1 Incident).

The SLA Target Time Form opens to the right of the Grid.

5. Click the Review link.
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Tip: You can also use the target times wizard to edit target times by clicking the Step links
on the Form.

a. Edit the Response Time Fields:
i. Response Time: Select the target number of days, hours, or minutes to respond to the

Incident (ex: 1 hour).

Note: The response time must be shorter than the maximum time limits of the
Operational Level Agreements (OLAs) and Underpinning Contracts (UCs) linked
to the SLA. If the response time is too short, a warning icon  appears.

ii. Applies: Select the Business Hours that constrain the Response Time (ex: 24/7).

iii. Work Hours: Click the icon to the right of the text field to open the Business Hours
Manager. The manager sets the Time Zone (based on time zones or the time zone of the
server that is using the business hours), Default Hours, and Exceptions.

iv. Warning: Select the number of days, hours, or minutes before a Response Breach to
initiate a warning (ex: 15 minutes). This is used to alert you of an impending breach.

Note: The warning time must be shorter than the response time. If it is not, a
warning icon  appears.

b. Edit the Resolution Time Fields:
i. Resolution Time: Select the target number of days, hours, or minutes to resolve the

Incident (ex: 5 Hours).

Note: The resolution time must be shorter than the maximum time limits of the
Operational Level Agreements (OLAs) and Underpinning Contracts (UCs) linked
to the SLA. If the resolution time is too short, a warning icon  appears.

ii. Applies: Select the Business Hours that constrain the Resolution Time (ex: M-F 8-5). The
SLA uses Business Hours to help calculate the Resolution and Response times.

iii. Warning: Select the number of days, hours, or minutes before a Resolution Breach to
initiate a warning (ex: 15 minutes). This is used to alert you of an impending breach.

Note: The warning time must be shorter than the resolution time. If it is not, a
warning icon  appears.

6. (Optional) Edit additional target times.

7. Click Save . The new target time appears in the SLA Target Times Tab.
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Priority
The priority is used to establish timescales and effort to respond to and resolve an issue (Incident or
Request). Priority is derived from an impact and urgency Priority Matrix.

• Impact: Measures the effect of an Incident/Request (ex: Number of Customers affected/influenced
by the Incident).

• Urgency: Measures how long it will be until the Incident has a significant impact on the business (ex:
If the e-mail server goes down, all Customers are immediately affected).

CSM uses Priority Matrixes to automatically calculate priority and to provide a visual perspective of how
priorities align. Because Incidents and Requests typically require different priorities, each uses its own
Matrix. Priority Matrixes are organized by Priority Groups so that they can be applied to Services. Default
Priority Groups include:

• Standard: Standard Priority Matrixes for Incident and Request.

• E-mail/Calendaring: Priority Matrixes dedicated to the E-mail/Calendaring Service. Priority Groups
and Priority Matrixes are configurable, so any Service/entity can have its own Priority Group/Matrix.

A Priority Matrix Element Form defines each priority that populates your Priority Matrix. This form is a
child form, and is linked to and available from its parent SLA Form (Priority Matrix Elements tab in the SLA
Form Arrangement).

The following figure shows how the Priority Matrix Element Form populates the Priority Matrix.

Note: For more information about the Priority Matrix Element Form, refer to the Priority Matrix
Element Form documentation.
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OOTB Priority Matrixes
OOTB Priority Groups include:

• Standard: Standard Priority Matrixes for Incident and Request.

• E-mail/Calendaring: Priority Matrixes dedicated to the E-mail/Calendaring Service. Priority Groups
and Priority Matrixes are customizable, so any Service/entity can have its own Priority Group/Matrix.

Standard Incident Priority Matrix

Standard Incident Priority Matrix
Impact

Company Department Individual

Urgency

 

High 1 2 3

Medium 2 3 4

Low 3 4 5

Standard Request Priority Matrix

Standard Request Priority Matrix
Impact

Must Have Should Have Whenever Possible

Urgency
Expedite 1 2 3

Standard 2 3 3

E-mail/Calendaring Incident Priority Matrix

E-mail/Calendaring Incident Priority Matrix
Impact

Company Department Team Individual

Urgency
Critical 1 1 2 2

Normal 3 3 4 4

E-mail/Calendaring Request Priority Matrix

E-mail/Calendaring Request Priority Matrix
Impact

Critical Routine

Urgency
Expedite 1 2

Standard 2 3
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SLA/Priority Spreadsheet
The following table describes the OOTB SLAs. SLAs are listed hierarchically by SLA type, and show
Response/Resolve Target Times by Work Hours and Priority.

Note: For 24 x 7 support, resolution Target Times can be expressed in days, hours, or minutes.

SLA Description SLA Type

Target Times

Work
Hours

Priority Response Resolve

Config Item

Primary
Server

SLA for the Server the
runs many of the
mission-critical
applications.

Standard

Incidents

24x7

1 5 mins 1 hrs

2 5 mins 2 hrs

3 10 mins 3 hrs

4 15 mins 4 hrs

Service Requests

8-5
Monday -
Friday

1 10 mins 2 hrs

2 15 mins 3 hrs

3 20 mins 4 hrs

Service

Email
Service

SLA for Email Service
provided for the entire
organization.

E-mail/
Calendaring

Incidents

24x7

1 15 mins 2 hrs

2 15 mins 4 hrs

3 30 mins 6 hrs

4 30 mins 8 hrs

Service Requests

8-5
Monday -
Friday

1 1 hr 6 hrs

2 2 hrs 1 day

3 4 hrs 3 days

Customer       
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SLA Description SLA Type

Target Times

Work
Hours

Priority Response Resolve

Platinum
SLA for VIP Customers
(must be Director or
above).

Standard

Incidents

24x7

1 15 mins 2 hrs

2 15 mins 4 hrs

3 30 mins 6 hrs

4 30 mins 8 hrs

Service Requests

8-5
Monday -
Friday

1 25 mins 4 hrs

2 1 hr 8 hrs

3 4 hrs 2 days

Gold
SLA for IP Customers
(ex: Sales and IT
Department).

Standard

Incidents

24x7

1 30 mins 3 hrs

2 30 mins 8 hrs

3 1 hr 12 hrs

4 3 hrs 16 hrs

Service Requests

8-5
Monday-
Friday

1 1 hr 4 hrs

2 2 hrs 12 hrs

3 4 hrs 16 hrs

Silver
SLA for managers and
Supervisors.

Standard

Incidents

24x7

1 45 mins 5 hrs

2 45 mins 1 day

3 2 hrs 2 days

4 5 hrs 3 days

Service Requests

8-5
Monday-
Friday

1 75 mins 4 hrs

2 2 hrs 2 days

3 3 hrs 5 days
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SLA Description SLA Type

Target Times

Work
Hours

Priority Response Resolve

Bronze
SLA for the Accounting
Department.

Standard

Incidents

24x7

1 1 hr 6 hrs

2 1 hr 2 days

3 2 hrs 3 days

4 2 hrs 5 days

Service Requests

8-5
Monday-
Friday

1 2 hrs 2 days

2 2 hrs 5 days

3 1 day 10 days

Corporate       

Corporate

 

Default SLA for all
Customers who are not
entitled to a Customer
Service Level.

Standard

 

Incident

24x7

1 1 hr 5 hrs

2 1 hr 2 days

3 2 hrs 3 days

4 2 hrs 5 days

5 2 hrs 9 days

Service Requests

8-5
Monday-
Friday

1 2 hrs 2 days

2 2 hrs 5 days

3 1 day 10 days

The SLA form captures the above information. For more information about the SLA form, see SLA Form in
the online documentation.
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Service Workflow
The following figure describes the high-level Service workflow in the OOTB system.

89

CSM Record Management

CSM Record Management



Note: CSM uses several features to enhance the Service workflow (ex: The Service Form helps
create and manage Services, One-Steps help move a Service through its workflow, etc.).

Contributors

A Service typically involves the following contributors. Depending on your workflow and the size of your
company, many of these contributors might be combined into one person (ex: Creator and owner might be
the same person):

• Creator: User who creates the Service. This is typically a member of the Services Team.

• Owner: User who manages the Service. This is typically a member of the Services Team.

• Approver: User who ensures that the Service is ready to be released and made operational in a live
environment. This is typically the Service/IT Manager.

• Consumer: Person who uses the Service. This is typically a Customer or User (technician) logging
a record.

Phases

The Service workflow is broken down into the following phases:

1. Planning: Creator creates a new Service. Ownership is assigned. Then, the owner designs the
Service and submits it to an approver for approval to develop.

2. Approval: Approver approves the Service for development. The approver can also reject the
Service and send it back for rework.

3. Development: Owner defines categories and subcategories for the Service. When ready, the owner
releases/activates the Service.

4. Active: Service is operational in a live environment. Service is periodically assessed by the owner.
Service can be sent back for review/rework or be retired if necessary.

5. Retired: Expired/out-of-date Service is retired. Service can be reactivated, if necessary.

Statuses

A Service progressing through the workflow encounters the following statuses:

1. Planning: Service is being created, assigned an owner, designed, and submitted for Approval.

2. Approval: Service is being approved by the approver.

3. Development: Service is being developed (refined).

4. Active: Service is operational in a live environment.

5. Retired: Service is retired from use.
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Note: Service phases align with Service statuses, but this is not the case in every process
(ex: Incident phases are different than Incident statuses).
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SLA Workflow
The following figure describes the high-level SLA workflow in the OOTB system.
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Note: CSM uses several features to enhance the SLA workflow (ex: The SLA Form helps create
and manage SLAs, One-Steps help move an SLA through its workflow, etc.).

Contributors

An SLA typically involves the following contributors. Depending on the workflow and the size of your
company, the creator and owner might be the same person.

• Creator: User who creates the SLA. This is typically a member of the Services Team.

• Owner: User who manages the SLA. This is typically a member of the Services Team.

• Consumer: Person who uses the SLA. This is typically a Customer or User (technician) logging a
record.

Phases

The SLA workflow is broken down into the following phases:

1. New: Creator creates a new SLA and assigns ownership. Then, the owner defines the initial details
and submits the SLA for planning/development.

2. Planning (Development): Owner develops the SLA, including Target Times and Priority Matrix
Elements. When ready, the owner activates the SLA.

3. Active: SLA is operational in a live environment. Owner periodically assesses the SLA (SLA can be
sent back for review/rework or retired if necessary).

4. Inactive: SLA is temporarily out of use. Owner periodically assesses the SLA (SLA can be sent
back for review/rework or retired if necessary).

5. Retired: Expired/out-of-date SLA is retired. Owner can send the SLA back for review/rework, if
necessary.

Statuses

An SLA progressing through the workflow encounters the following statuses:

1. New: SLA is being created, assigned an owner, designed, and submitted for planning.

2. Planning: SLA is being developed (refined and tested), and then activated.

3. Active: SLA is operational in a live environment.

4. Inactive: SLA is temporarily out of use.

5. Retired: SLA is retired from use.
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Create a Service/SLA/Priority Structure
To create a Service, SLA, Priority structure:

1. Design a three-tier Categorization for each Service.

2. Complete your own SLA/Priority Spreadsheet.

3. Create one or more SLAs:

Tip: CSM provides a default SLA, named Corporate. Consider using this SLA for all Incidents/
Requests. If needed, change the Target Times to meet your needs.

a. Create a new SLA by clicking File>New>New SLA from the CSM Desktop Client menu bar or
by clicking New>New SLA on the CSM Desktop Client toolbar.

A new SLA Record is created with a Status of New.

b. Complete the SLA fields. The Title and SLA Type are required to save the record.

Note: For detailed field information, refer to the SLA Form documentation.

c. Plan your SLA:
i. In the Status alert bar, click Set to Planning.

The SLA status changes to Planning.

d. Define your SLA Target Times:
i. Click the SLA Target Times tab (Form Arrangement area).

ii. Click New SLA Target Time.

The New SLA Target Times form opens.

Note: For detailed field information, refer to the Target Times Form documentation.

Notes: By default, the Target Times form uses a wizard interface that provides helpful
information for creating Target Times. To bypass the Target Times wizard and complete
the information using one form, select the Disable Target Time Wizard radio button under
Advanced Options in the Main Pane.
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iii. Select/define your Priority and parent type.

iv. Click the Next button  and define your Work Hours.

v. Click the Next button  and define your Response Time.

vi. Click the Next button  and define your Resolution Time.

e. Add values to your Priority Matrix:
i. Click the Priority Matrix Element tab (Form Arrangement area).

ii. Click New Priority Matrix Element.

The Priority Matrix Element form opens.
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iii. Define the priorities.

Note: For detailed field information, refer to the Priority Matrix Element form
documentation.

4. Activate your SLA:
a. In the Status alert bar, click Active.

5. Create one or more Services:
a. Create a new Service by clicking File>New>New Service from the CSM Desktop Client menu

bar or by clicking New>New Service on the CSM Desktop Client toolbar.

A new Service Record is created with a Status of Planning.
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b. Define the Service fields.

Note: For detailed field information, refer to the Service Form documentation.

c. Define the Service Categories:
i. Click the Categories tab (Service Form Arrangements area).

ii. Click New Category.

The Category form opens.

iii. Complete the fields.

Note: For detailed information, refer to the Service Form documentation.

d. Define the Service Subcategories:
i. Click the Subcategories tab (Arrangements area).

ii. Click New Subcategory.

The Subcategory form opens.

iii. Define the fields.

Note: For more information, refer to the Service Form documentation.

6. Activate your Service:
a. In the Status alert bar, click Set as Active.
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7. After the SLA is activated, you have the following options:
a. If you discover that work needs to be done on the SLA, click the Deactivate this SLA link in

the I Want To section to temporarily disable it (Status changes to Inactive). The SLA can be
reactivated by clicking the Set to Planning link in the Status alert bar.

b. If the SLA is no longer applicable, click the Retire this SLA link in the I Want to section (Status
changes to Retired). The SLA can be reactivated by clicking the Set to Planning link in the
Status alert bar.
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Service/Service Catalog Features
CSM provides the following tools to help manage Services.
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Service Form
Use the Service Form to define and manage your Services. The Service Form is made up of three main
areas:

1. Workflow Bar: Tracks the Service as it progresses through the Service workflow. Dark gray indicates
the current phase.

2. Quick Info Tile: Displays important at-a-glance information, such as Status bar (current and next
Status), Breached Incidents, Open Incidents, ownership information, and common operations (I
Want To).

3. Main Pane: Displays the main form fields.

4. Form Arrangement: Dynamically displays linked records (child records) that are in a relationship with
the Service (parent record).

Good to know:
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• Search for one or more Services that meet a specific criteria by running a Quick Search or Search
Group.

• Create a new Service by clicking New>New Service on the CSM Desktop Client toolbar or
File>New>New Service from the CSM Desktop Client menu bar.

• The Service categorization has a three-tiered organization (Service, category, and subcategory) that
determines the type of support required (Incident or Request), which Specifics form to display to
capture the appropriate details, and which Priority Matrix to use.

• CSM provides multiple OOTB Services for use throughout CSM. Use these Services as-is or create
your own using the Service Form.

• CSM provides several OOTB categories and subcategories to use as part of the Service
categorization. Use these categories and subcategories as-s, edit them, or create your own using
their respective forms in the Arrangement area of the Service Form.

• CSM implements several OOTB Actions/One-Steps to make Service management more efficient.
For more information about Actions and One-Steps, refer to the Actions/One-Steps documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• The Quick Info Tile (left) displays important at-a-glance information:
• The Status alert bar displays the current status of the Service as it moves through its workflow.

The next status is displayed as a link directly beneath the current status. Click the status link to
move the Service to the next status.

• The Breached Incidents alert bar displays the number of open Incidents that have breached
the SLA Resolve or Resolution deadline.

• The Open Incidents alert bar displays the number of open Incidents associated with the
Service.

• The Owner section displays the current owner (oneself, a User, or a Team). Services can be
assigned by clicking one of the Ownership links in the Quick Info Tile.

• The workflow bar (top of Main Pane) indicates the current phase of the Service as it moves through
its workflow. Dark gray indicates the current phase.

• The Main Pane displays the main form fields.

• Fields:
• Some validated fields can recognize what you are typing and will suggest a value for you (ex:

Type "P" into the field; CSM will suggest the first item it finds that starts with the letter P). Use
your Down Arrow button to scroll through other possible values.

• Press F3 to open a Selector window, where you can select a legal value or create a new value.

• Press TAB to move to the "next" field on the form.

• Saving:

• Date, time, and user name information is recorded the first time the form is saved, and each
time the form is modified.
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The following table describes the fields on the form.

Field Description Comments

Quick Info Tile

Important at-a-glance information, such as record
type, Status bar (current and next Status),
breached Incidents, open Incidents, record
ownership, and common operations (I Want To).

<Service Name> Name that uniquely identifies the Service.

Status Service workflow status.

Status

Current Status of the Service as it moves through
the Service workflow. Statuses include:

• Planning: Service is being created and
designed.

• Approval: Requirements are being finalized
and authorized. Requirements are
communicated, budgets and resources are
allocated.

• Development: Service is being developed
(refined and tested).

• Active: Service is operational in a live
environment.

• Retired: Service is retired from use.

Next: Status

Click the links to move the Service through the
Service workflow. Actions include:

• Submit for Approval: Changes the Service
Status to Approval.

• Begin Development: Changes the Service
Status to Development.

• Reject: Changes the Service Status back to
Approval.

• Set as Active: Changes the Service Status
to Active.

• Retire: Changes the Service Status to
Retired.

• Submit for Review: Changes the Service
Status back to Approval.

One-Steps (Alt 1 Step from
Relationship, Alt 2 Step from
Relationship, or Next Step from
Relationship): Conditionally changes
the record Status to next logical
Status (defined by the Status values
in Table Management).

Breached Incidents alert bar
Number of Open Incidents that have breached
the SLA's Resolve deadline.

 

Open Incidents alert bar Number of Open Incidents bound  
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Field Description Comments

Owned By Record owner.  

User Owner

-select owner-

Name of the User owner. Click the link to first
select a Team and then a User owner (User is
limited by Team).

Typically, the owner is the IT/Business Manager.

One-Step (Assign to Individual):

Launches the Choose Team window,
where a User can choose an Owned
By Team for the record; then,
launches the Choose User window,
where a User can choose a Primary
User from the already-selected
Team.

Team Owner

-select team-

Name of the Team owner. Click the link to select
a Team owner.

One-Step (Assign to Team):

Launches the Choose Team window,
where a User can choose an Owned
By Team for the record.

Avatar
Photo/graphic associated with the User owner
(from User Profile).

 

Owner E-mail Address Owner's e-mail address (from User Profile).  

Owner Phone Number Owner's phone number (from User Profile).  

Owned By Record owner.  

User Owner

-select owner-

Name of the User owner. Click the link to first
select a Team and then a User owner (User is
limited by Team).

Typically, the owner is the IT/Business Manager.

One-Step (Assign to Individual):

Launches the Choose Team window,
where a User can choose an Owned
By Team for the record; then,
launches the Choose User window,
where a User can choose a Primary
User from the already-selected
Team.

Team Owner

-select team-

Name of the Team owner. Click the link to select
a Team owner.

One-Step (Assign to Team):

Launches the Choose Team window,
where a User can choose an Owned
By Team for the record.

Avatar
Photo/graphic associated with the User owner
(from User Profile).

 

Owner E-mail Address Owner's e-mail address (from User Profile).  

Owner Phone Number Owner's phone number (from User Profile).  

Main Pane   

Details   
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Field Description Comments

Service Name
Name that uniquely identifies the Service. Be
succinct because the Service Catalog displays
this name.

 

Service Type

Type of Service:

• Technical

• Business

 

Service Manager
Service/Record owner. Person responsible for
owning the Service.

 

Service Classification

Service Classification:

• Core IT

• On Demand

• Subscription

 

Service Description Description of the Service.  

Services Included List of mini services included in the Service.  

Services Excluded List of mini services not included in the Service.  

Optional Services List of optional services included in the Service.  

Service SLA

Service SLA bound to this Service, if applicable.

Note: Not many Services require a
special SLA. In the OOTB system, only
Desktop Management and E-mail
Calendaring have their own SLAs.

 

SLAs entitled to this Service

Lists the SLAs that can access the Service in the
Portal (Corporate means every Customer can
access the Service in the Service Catalog;
Platinum, Gold, Silver, and Bronze limit the
Service by Customer status/level). SLAs must be
separated by a comma.

 

Importance

Service Importance:

• Mission-Critical

• Support

• Optional
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Field Description Comments

Review Date
Scheduled review MM/DD/YYYY for the selected

Service. Click the Calendar button  to launch a
Calendar where you can schedule a date.

Used to allow the Service to be
periodically reviewed to ensure that it
is correct/updated.

Alignment and Cost
Click the Alignment and Cost link to view the
form.

 

Business Alignment Business reasoning/support for the Service.  

Business Owner
CSM User who is responsible for being the
business stakeholder.

 

Maintenance Cal
Defined Business Hours for the Service, as
defined in the Business Hours Manager.

 

Outsourced To Vendor to whom the Service is outsourced, if any.  

Default OLA Team
Default OLA team responsible for the operational
components of the Service.

 

Linked Image

Image that represent the Service in the UI. Click
the Set Image button to open the Image
Manager, where you can select or import an
image.

 

Cost Cost per hour associated with the Service.  

Arrangement
Dynamically displays child records that are in a
relationship with the Service.

 

Linked Services
Displays related Services that have a
dependency on this Service.

 

Categories
Displays the defined Service Categories that
categorize your Service.

For more information, see Service
Categorization.

Subcategories
Displays the defined Service Categories that
categorize your Service.

Incidents
Displays Incidents that are logged to report a
disruption in this Service.

For more information, see About
Incidents and Requests.

Problems Displays Problems that involve this Service.  

Change Requests
Displays Change Requests that involve this
Service.

 

Configuration items
Displays CIs that are related to/support this
Service.

 

Service Schedules
Displays Service Schedules that affect this
Service (ex: Down for maintenance).

 

SLAs Displays SLAs that are bound to this Service.
For more information, see Service
Level Agreements (SLAs).
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Field Description Comments

OLAs

Displays related Operational Level Agreements
(OLAs) that affect this Service. Operational Level
Agreements define how Departments will work
together to meet SLAs.

 

Underpinning Contracts

Displays related Underpinning Contract records
(agreements created between the IT Service
Provider and an external supplier of services) that
affect this Service.

An Underpinning Contract is an
agreement created between the IT
Service Provider and an external
supplier of services.

Note: For more information about the Service One-Steps, see Service One-Steps.
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Target Times Form
Use the Target Times form to define and manage your SLA Target Times. The Target Time form is a Child
form, and is linked to and available from its parent SLA form (SLA Target Times tab in the SLA form's
Arrangement area). The Target Times form has a wizard interface, which allows you to easily move
through the process of creating Target Times. However, you also have the option to disable the wizard and
simply use the Review page (which includes identical information) to create the Target Times.

Note: For more information about creating Target Times, see Create a Service Catalog (Service,
SLA, Priority Structure).

The following image shows the Review page:

The following table describes the fields on the form.

Field Description Comments

Priority Priority name/value.  

Parent Type Record type, either Incident or Request.
Determined by your toggle
choice (SLA form).

Work Hours Business Hours when the SLA should be used.  

Use as Default

The SLA will be used as the default if the working hours
cannot be determined or there is not a defined Target
Time for the time period that an Incident or Service
Request is created.

 

Response Time
Target number of Days, Hour, or Minutes to Respond to
the Incident (ex: 1 Hour).
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Field Description Comments

Resolution
Time

Target number of Days, Hour, or Minutes to Resolve the
Incident (ex: 4 Hours).

 

Work Hours
(Response
Time)

Specifies the defined Business Hours that constrain the
Target Time. If blank, it is assumed that it is a 24 hour
clock.

Click the Business Hours Manager button to launch
the Business Hours Manager where you can select
existing Business Hours or create new Business Hours.
Also select the time zone for the Business Hours based
on time zones or the time zone of the Cherwell
Application Server.

Note: When you create
new Business Hours, you
must update the Created
During What Business
Hours Expression to
reflect the new hours. If
Business Hours overlap,
move the preferred hours
above the other hours in
the list.

Work Hours
(Resolution
Time)

Response
Warning Time

Number of Days, Hours, or Minutes before a Response
Breach to initiate a warning. Used to alert you to an
impending breach.

 

Resolution
Warning Time

Number of Days, Hours, or Minutes before a Resolution
Breach to initiate a warning. Used to alert you to an
impending breach.

 

Note: For more information about the SLA Target Time One-Steps, see SLA One-Steps.
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Priority Matrix Element Form
Use the Priority Matrix Element form to define and manage the values that go in your Priority Matrix. The
Priority Matrix Element form is a Child form, and is linked to and available from its Parent SLA form
(Priority Matrix Elements tab in the SLA form's Arrangement area).

The following table describes the fields on the form.

Field Description Comments

Priority Group

Specifies which Priority Group (Priority Matrix) the value is
in:

• Standard: Standard Priority Matrixes for Incident and
Request.

• E-mail/Calendaring: Priority Matrixes dedicated to the
E-mail/Calendaring Service.

• Custom.

 

Incident/Service
Request

Specifies whether the value is in the Incident or Request
Priority Matrix.

 

Urgency Specifies which Priority Matrix row the Priority is in. The value is put into
the row and column
that intersect.Impact Specifies in which Priority Matrix column the Priority is in.

Priority Specifies the value of the priority.  

Matrix Order
Specifies the vertical and horizontal sort order for the grid
(low to high). We recommend that you build left to right, then
down.

 

Description Description of the priority.  
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Service One-Steps
CSM provides the following OOTB Service One-Steps.

One-Step Description/Actions Association Executed From

Status Actions    

Alt 1 Step from
Relationship

Conditionally changes the record status to
next logical status (defined by the status
values in Table Management).

Service

 

Service Form: Status:
<Next Status>

 

Alt 2 Step from
Relationship

Next Step from
Relationship

Status Info Displays a description of the Service. Service  

Update Service
Status

Prompts you to manually select any status. Service
Service Form: Status:
<Current Status>

Form Actions    

Ownership Assign ownership.   

Assign to ANY
Individual

Prompts the User to assign the record to
any CSM User (not limited by Team). Uses
Owned By ID and Owned By Team fields.

Service
Service Form: Assign
To link

Assign to
Individual

Launches the Choose Team window,
where a User can choose an Owned By
Team for the record; then, launches the
Choose User window, where a User can
choose a Primary User from the already-
selected Team.

Service
Service Form: Owned
By link

Assign to Team
Launches the Choose Team window,
where a User can choose an Owned By
Team for the record.

Service
Service Form: Owned
By Team link

Take Ownership
Makes the Current User the Primary User
of the record.

Service
Service Form: Take
Ownership link (I Want
To section)

Other    

Date/Time
Information

Displays details for all the date/timestamps
to give a historical view.

Service

Service Form: View
Detailed Date/Time
Information link (I
Want To section)
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A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.
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Service Search Groups
CSM provides the following OOTB Service Search Groups.

Search Group Returns Association Executed From

Active Services Services in the Active Phase. Service Search Manager, Reports

All Services All Services, regardless of status. Service Search Manager
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Problem Management
Problem management is the process that ensures that the root cause of multiple Incidents is resolved as
quickly as possible.
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About Problems
A Problem is the cause of one or more related Incidents. Problems involve a more complicated issue than
Incidents, and require a deeper investigative process so that the Incidents do not reoccur. A Known Error
is the root cause of a Problem and has a workaround to keep employees operating while the Problem is
being resolved.

For example, technicians at a company log five separate Incidents related to e-mail issues. A technician
notices this trend and logs a Problem that links all of the Incidents together as one record. The Problem is
investigated and the Known Error (the root cause of a Problem) is determined to be a failed e-mail server
connection.
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Problem Features and Capabilities
CSM Problem Management has numerous features and capabilities:

• Searching: Quickly locate all Problems by running a Quick Search, or search for a particular
Problem or set of Problems by refining the search criteria to a word/phrase, timeframe, Customer,
etc. Use Search Groups to save/run commonly run Searches.

• Security: Secure Problems by controlling who can view, create, and edit records.

• Business Object: Use the dedicated Problem Business Object to track Problems and configure the
Business Object to capture/track only what you want.

• Form: Use the powerful Problem Form to create, edit, and track Problems. The form provides a
Quick Info Tile to display important at-a-glance information (Problem ID, current and next status,
record ownership, common operations (I Want To), and SLA information), a workflow bar to visually
track the Problem workflow phases, and a Form Arrangement area to dynamically display linked
records (child records) that are in a relationship with the Problem (parent record).

• Workflow: Use the streamlined Problem workflow to move Problems from New to Closed.

• Ownership: Assign each Problem to a record owner to ensure accountability.

• Tasks: Use linked Tasks to distribute and track individual pieces of work assigned to Teams or
Users (for example, Escalations, Time Entries, and Work Items).

• Linked Records: Link child records to a parent Problem record to keep supporting information at
your fingertips and to ensure data relationships. Linked child records are visible in the Problem's
Arrangement area.

• History and Revision Tracking: Use linked Journals to track important status and Field changes.

• Queue Tracking: Use linked Journals to track when Queues are added to or removed from a
Queue.

• Actions/One-Steps: Use powerful Actions and One-Steps to move Problems through their
workflow, initiate common operations (for example, Assign ownership), initiate scenario-specific
Actions, run Reports, etc. Actions/One-Steps are available on the Problem Form (including from the
CSM Desktop Client Task Pane and CSM Desktop Client menu bar) and on the Problem
Dashboard.

• Problem Dashboard: Use the Problem Dashboard to view your critical Problem metrics in a single,
real-time, at-a-glance control panel. The Dashboard displays the number of open Problems, open
Top Issues (in the Portal), total linked Incidents, Problems with no workaround, Problems with
workarounds, and open known errors. It also shows a list of Top Issues, the number of Problems
owned by each Team, the percentage of Problems in each status of the workflow, and the
percentage of Problems by category.

• Reports: Run Reports to show up-to-date statistics on the most common Problems, User and Team
workloads, closure rates, Service trends, potential SLA breaches, and much more.
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Problem Good to Know
• Search for one or more Problems that meet a specific criteria by running a Quick Search or Search

Group.

• Create a new Problem by clicking New>New Problem on the CSM Desktop Client toolbar, by
clicking File>New>New Problem from the CSM Desktop Client menu bar, or by pressing CTRL
+SHIFT+P.

• You can create a Problem from multiple Incidents, then attach additional Incidents when appropriate.

• By default, Problem uses the Corporate Priority Matrix.

• By default, Problem uses the Incident Service and Category structure. Access Category options by
clicking Tools>Table Management>Type>Incident Category.

• The OOTB system implements several Actions/One-Steps to make logging Problems more efficient.
For more information about Actions and One-Steps, refer to the Actions/One-Steps documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• CSM provides several OOTB Automation Processes to automate Problem Management. For more
information, refer to the Automation Process documentation.

• If enabled (via Automation Process), e-mail notifications are:
• Automatically created and sent to User owners to notify them of ownership.

• Automatically created and sent to Team owners to notify them of ownership.

• When on a record, you can send an e-mail directly to the current Customer (Requestor) by clicking
File>E-mail Current Customer, or by clicking the Customer's e-mail address in the Requestor
section of the Quick Info Tile. If sent using the File menu, the e-mail is blank. If sent using the Quick
Info Tile, an e-mail template is used to auto-populate the e-mail with information from the current
Incident (ex: Change ID, Customer's name, logging date/time details, etc.).

• Journals track what occurs during the record's lifecycle (ex: Notes to track progress or comments,
and History to track important field changes, e-mail correspondence, etc.). View or add Journals by
clicking the Journal tab in the record's Arrangement.

• Attachments supplement records by providing additional details in the form of linked/imported files
(.pdf, .doc, etc.), images, web pages, and Document Repositories. View and manage Attachments

using the Attachment button  and Attachments bar.

• The Quick Info Tile (left) displays important at-a-glance information:
• The Status bar displays the current status of the Problem as it moves through its workflow. The

next status is displayed as a link directly beneath the current status. Click the status link to
move the Problem to the next status. Some Problem status links change the status and move
the Problem to the next phase.

Note: Typically, workflows statuses should be enforced; however, some records do
allow Users (with security rights) to bypass statuses (ex: Problems can be manually
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closed without being formally resolved, if needed). To bypass a status, click one of the
alternate statuses in the I Want To section of the Quick Info Tile.

• The Priority bar displays the Problem priority. Red indicates a priority 1, orange indicates a
priority 2, and green indicates a priority 3-5.

• The Linked Incidents bar displays a threshold color based on the number of linked Incidents
(zero to two is green, three to four is yellow, and above five is red).

• The Owner section displays the current record owner (oneself, a User, or a Team). Problems
should be assigned to an owner and can be assigned by clicking one of the ownership links in
the Quick Info Tile.

• The workflow bar (top of Main Pane) indicates the current phase of the Problem as it moves through
its workflow. Dark gray indicates the current phase.

• Press TAB to move to the next field on the form.

• Fields:
• The Description field is a Rich Text field. To format the text or embed an image, click the Zoom

button .

• Use social media to communicate a Problem by clicking the Tweet button  in the Classify
and/or Known Error phase.

Note: To use the Tweet button on the Problem Form, you must integrate your Twitter account
and activate the Tweet buttons. For more information, see the Create a Twitter Account and
Activate Twitter Buttons documentation.

• Submit a Workaround to your Knowledge Base or submit a Known Error to the Portal using
their respective buttons in the Workaround and Known Error phase.

Note: A full list of Fields is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view
a full list of fields associated with a particular type of Business Object (ex: Major).

• Saving:

• Date, time, and user name information is recorded the first time the form is saved, and each
time the form is modified.

• Clicking Save  triggers an audit of certain Problem information, such as Status, Urgency
(Priority Matrix), Impact (Priority Matrix), Owned By, Diagnosis, and Workaround. If a change
is detected in one of those Fields, a Journal-History record is created to track the change.
View the changes in the Problem Journals tab (Arrangement section).
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Problem Workflow
The following figure shows the high-level Problem process workflow in the OOTB system.
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Note: CSM uses several features to manage the Problem workflow (ex: The Problem Form helps
create and manage Problems, One-Steps help move the Problem through its workflow,
Automation Processes notify stakeholders via e-mails, a Problem Dashboard notifies stakeholders
and tracks metrics, etc.).

Contributors

A Problem typically involves the following contributors:

• Creator: User who first logs the Problem. This is typically a member of the Problem Management
Team.

• Owner: User who manages the Problem. This is typically an IT manager who is a member of the
Problem Management Team.

Phases:

The Problem workflow is divided into the following phases:

1. Classify: Creator logs a new Problem. Then, the creator identifies and classifies the Problem
(Description, Service, Category, and Priority). The creator updates Customers via Twitter and links
related Incidents to the record.

2. Investigate: Ownership is assigned. The owner begins work, investigates and analyzes the
Problem, and then records a diagnosis. The owner updates Customers by publishing the Problem to
the Portal, and then links Configuration Items (CIs).

3. Known Error: Owner develops and records the workaround. Then, the owner can update Users (by
submitting a Knowledge Article to Knowledge Base) and Customers (by publishing a known error to
Customer Portal, post to Twitter, or send e-mail).

4. Resolve: Owner records resolution details and cause code. Then, the owner can escalate the
Problem and/or log a Change Request required to solve the Problem (if necessary). The owner then
resolves attached Incidents before resolving the Problem.

5. Closed: Owner closes the Problem.

Statuses

A Problem progressing through the workflow encounters the following statuses:

1. New: Problem is being logged, identified, and classified.

2. Assigned: Problem has been assigned to an owner.

3. Work in Progress: Problem is being diagnosed, investigated, and analyzed.

4. Pending Change: Problem process is on hold until a Change Request is implemented.

5. Resolved: Problem is resolved.

6. Closed: Problem is closed.
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Note: Problem statuses do not align with Problem phases.
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Logging Problems
The following instructions are available to walk you through the steps to log a new Problem using our
OOTB workflow:

• Log a Problem: Typical step-by-step instructions for logging a Problem.

• Log a Problem - Detailed: Detailed step-by-step instructions for logging a Problem, including tips,
optional steps, and behind-the-scenes information.

Note: CSM provides an OOTB Problem workflow with all the features you need to
successfully manage Problems. You can use this workflow as-is, or tailor it to meet the
needs of your organization.
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Log a Problem
The following procedure walks you through the typical steps to log a Problem.

To log a Problem:

1. On the CSM Desktop Client toolbar, click New>New Problem.

A new Problem Record is created with a unique Problem ID and a status of New. The Problem
automatically enters the Classify phase.

2. Step 1: Identify and classify the Problem:
a. Short Description: Provide a brief explanation of the Problem.

b. Detailed Description: Provide a detailed explanation of the Problem.

c. Service: Select the affected Service.

d. Category: Select the affected Service category.

e. Priority: Select an Incident priority:
i. Click the Priority drop-down to reveal the Priority Matrix (determined by invoked SLA),

and then click a number (priority).

The priority is displayed in the Priority alert bar of the Quick Info Tile.

f. Link related Incidents to the Problem:
i. Click the Link button in the Incidents tab (Arrangement section) to launch the Incident

Quick Selector window.

The Incident Selector window opens.

ii. Select related Incidents from the Grid.
The number of linked Incidents is visible in the Quick Info Tile and the records are visible
in the Incident tab (Arrangement section).

Note: When a workaround is in place (the Workaround field must be populated),
the Resolve Attached Incidents link (I Want To section) is enabled. The link
allows you to simultaneously resolve all of the Incidents linked to the Problem.

After the Problem is classified, the Problem automatically enters the Investigate phase.

3. Step 2: Investigate and analyze the Problem:
a. Assign an owner to the Problem by clicking one of the ownership links in the Quick Info Tile

(Owned By and I Want To sections).

The Problem status changes to Assigned and the ownership information appears in the Quick
Info Tile.

b. The owner begins work:
i. In the Status alert bar, click Begin Work.
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The Problem status changes to Work in Progress.

c. Diagnosis: Provide a description of the diagnosis process. This information might include:
◦ Investigative process (ex: Search Knowledge Base, view similar Problems, recreate
issue, etc.).

◦ Analysis of the results.

d. Select an affected CI, if any:

i. Click the CI Selector button  to launch the CMDB window, where you can select a CI.
You can locate CIs by filtering (by Config Type, All Customers, or a specific Customer) or
by searching. You can also create a new CI on the fly.

e. View Impacted CIs: Click this button to view a Configuration Map of CIs that are affected by
the Problem.

f. (Optional) Update Customers: Click the Publish to Top Issues List in Portal link in the Quick
Info Tile to publish the Problem in the Portal. Customers can then subscribe to the Problem.

The Problem automatically enters the Known Error phase.

4. Step 3: Develop/log a workaround and known error, and then update Customers.
a. Workaround: Provide an explanation of the workaround.

b. Update Users and Customers about the known error:

◦ Submit Workaround to Knowledge Base: Click the Knowledge Article button  to
create a Knowledge Article using the described known error.

◦ Publish Known Error in Portal: Click the Publish to Portal button  to post the known
error in the Portal.

◦ Tweet the Known Error: Click the Tweet button  to post a Tweet of the known error to
Customers.

◦ Send E-mail Update to Customers: Click this link in the Quick Info Tile to define a
message to send via e-mail to the Customers associated with Incidents linked to the
Problem.

The Problem automatically enters the Resolve phase.

5. Step 4: Record the root cause and resolution.
a. (Optional) Escalate the Problem if you are unable to find a resolution:

◦ Create Tasks (Arrangement section) to either escalate the Problem to a higher tier of
support, track time, or schedule an immediate Action Item for another Team/User.

◦ Add the record to a Queue to escalate the Problem to a higher tier of support.

b. Resolution: Provide a description of the root cause and resolution.

c. Cause Code: In the drop-down, select a cause type.

d. Resolve the Problem and record resolution details:
i. Click Resolved Attached Incidents in the Quick Info Tile.

ii. Click the Set as Resolved link.
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The Problem status changes to Resolved.

Note: If you find that the Problem was not resolved, reopen the record by clicking the
View More Status Options link in the Quick Info Tile and select a status (ex: Work in
Progress) from the drop-down.

6. Click the Close link to close the Problem.

Note: After a Problem is closed, it cannot be reopened.

The Problem status changes to Closed and the Problem enters the Closed phase.

126

CSM Record Management

CSM Record Management



Log a Problem - Detailed
The following procedure walks you through detailed step-by-step instructions for logging a Problem,
including tips and behind-the-scenes information. The different contributors are noted in the procedure.

To log a Problem:

1. On the CSM Desktop Client toolbar, click New>New Problem.

Tip: You can also click File>New>New Problem from the CSM Desktop Client menu bar, or press
CTRL+SHIFT+P.

Note: A Problem can be logged from an Incident (Task Pane>Incident Actions>Create
Problem link). When submitted from an Incident, the Priority, Short Description, Detailed
Description, and Service categorization are auto-populated and the Incident is linked to the
Problem in the Arrangement area. A Problem can also be logged from anywhere in the
system (Task Pane>Common Tasks>Create Problem), though fields do not auto-populate
and a record is not automatically linked using this option.

A new Problem Record is created with a unique Problem ID (example: 10230) and a status of New.
The Problem automatically enters the Classify phase.

2. Step 1: Identify and classify the Problem.

Notes: All fields in the Identify and Classify section are required to move to the Investigate
phase.

a. Short Description: Provide a brief explanation of the Problem (example: E-mail is not
sending.)

b. (Optional) Update Customers: Click the Tweet button  next to the Short Description field to
Tweet the Short Description.

Note: To use the Tweet button on the Problem Form, you must integrate your Twitter account
and activate the Tweet buttons. For more information, see the Create a Twitter Account and
Activate Twitter Buttons documentation.

c. Detailed Description: Provide a detailed explanation of the Problem (example: Marketing
department e-mail is not sending).

Tip: Description is a Rich Text field. To format the text or embed an image, click the Zoom
button .

d. Service: Select the affected Service (example: E-mail/Calendaring).

e. Category: Select the affected Service Category (example: Mailbox).

f. Priority: Select a Problem priority:
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i. Click the Priority drop-down to reveal the Priority Matrix (determined by invoked SLA),
and then click a number (priority).

The priority is displayed in the Priority bar of the Quick Info Tile. The color (red/orange/green)
indicates the level of priority.

g. Link related Incidents to the Problem.

i. Click the Link button  in the Incidents tab (Arrangement area) to launch the Incident
Quick Selector window.

ii. Select related Incidents from the Grid.

Tip: Hold down the CTRL button to select multiple items from the grid.

The number of linked Incidents is visible in the Quick Info Tile and the records are visible
in the Incident tab (Arrangement area).

Note: The Linked Incidents bar in the Quick Info Tile displays a threshold color based on
the number of linked Incidents (Green indicates zero to two linked Incidents, yellow
indicates three to four linked Incidents, and red indicates that there are more than five
linked Incidents.)

After all required fields are completed, the Problem automatically enters the Investigate phase.

3. Step 2: Investigate and analyze the Problem.
a. Assign an owner to the Problem by clicking one of the Ownership links in the Quick Info Tile

(Owned By and I Want To sections). Ownership is required:
◦ Take Ownership: Click this link to make yourself the User owner.

◦ Assign to: Click this link to select a User owner. The Team owner is populated by the
User owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User owner (User is
limited by Team).

◦ Select Team: Click this link to first select a Team owner.

The Problem status changes to Assigned and the Ownership information appears in the Quick
Info Tile. CSM automatically sends an e-mail to the owner to notify them of Ownership.

b. The owner begins work.
i. In the Status bar, click Begin Work.

The Problem status changes to Work in Progress.

c. Diagnosis: Provide a description of the diagnostic process. This information might include:
◦ Investigative process (example: Search Knowledge Base, view similar Problems,
recreate issue, etc.).

◦ Analysis of the results.
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d. (Optional) Update Customers: Click the Publish to Top Issues List in Portal link in the Quick
Info Tile to publish the Problem in the Portal. Customers can then subscribe to the Problem
using Affects Me Too functionality.

e. Affected CI: Select an affected CI, if any:

i. Click the CI Selector button  to launch the CMDB window, where you can select a CI.
You can locate CIs by filtering (by Config Type, All Customers, a specific Customer) or by
searching. You can also create a new CI on-the-fly.

f. View Impacted CIs: Click this button to view a Configuration Map of CIs that are affected by
the Problem.

After all required fields are completed, the Problem automatically enters the Known Error phase.

4. Step 3: Develop/log a workaround and known error, and then update Customers.
a. Workaround: Provide an explanation of the workaround.

Tip: Write a detailed procedure so that Users and Customers understand exactly what they
are supposed to do.

b. Update Users and Customers about the known error:

◦ Submit Workaround to Knowledge Base: Click the Knowledge Article button  to
create a Knowledge Article using the described known error.

Notes: The Workaround field is required to create a Knowledge Article. The new
Knowledge Article pulls information from the following fields: Short Description, Detailed
Description, Service, Category, Workaround, Diagnosis, and resolution.

◦ Publish Known Error in Portal: Click the Publish to Portal button  to post the known
error to the Portal.

Note: The Diagnosis and Workaround fields are required to publish workaround
information in the Portal.

The known error becomes visible in the Top Issues category in the Portal.

Note: To remove the known error from the Portal, click the Remove from Top Issues List
link in the I Want To section of the Quick Info Tile.

◦ Tweet the Known Error: Click the Tweet button  to send a Tweet of the known error to
Customers.

Notes: The Workaround field is required to Tweet known error information. To use the
Tweet button on the Problem Form, you must integrate your Twitter account and activate
the Tweet buttons. For more information, see the Create a Twitter Account and Activate
Twitter Buttons documentation.
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◦ Send E-mail Update to Customers: Click this link in the Quick Info Tile to define a
message to send via e-mail to the Customers associated with Incidents linked to the
Problem.

After all required fields are completed, the Problem automatically enters the Resolve phase.

5. Step 4: Record the root cause and resolution.
a. Escalate the Problem if you are unable to find a resolution:

◦ Create Tasks (Arrangement area) to either escalate the Problem to a higher tier of
support, track time, or schedule an immediate Action Item for another Team/User.

◦ Add the record to a Queue to escalate the Problem to a higher tier or support.

b. Resolution: Provide a description of the root cause and resolution.

Note: This field is required to click the Set to Resolved status.

c. Cause Code: Select a cause type in the drop-down.

Options include:

◦ Hardware Failure

◦ Human Failure

◦ Procedure Failure

◦ Software Failure

◦ Update Failure

d. (Optional) Create a Change Request from the Problem:
i. Click the Create Change button in the Task Pane and then select responses for each

prompt (Change Type, Requestor, Title, and Priority).

A new Change opens in the Main Pane and the Problem status changes to Pending
Change.

ii. Log the Change using the appropriate Change workflow (example: Normal, Standard,
Emergency).

Notes: Return to the linked Problem at any time by clicking the Go to Problem button

 in the Problem tab of the Change Request Form Arrangement. When the linked
Change is complete, a notification e-mail is automatically sent to the Problem owner.

e. Resolve the Problem and record resolution details:
i. Click Resolve Attached Incidents in the Quick Info Pane to set the status of all linked

Incidents to Resolved.

Tip: You can also click the Resolve Linked Incidents button in the Problem Actions
section of the Task Pane to resolve the Incidents.

ii. Click the Set as Resolved link.
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The Problem status changes to Resolved.

Note: If you find that the Problem was not resolved, you can reopen the record by
clicking the View More Status Options link in the Quick Info Tile and selecting the status
(example: Work in Progress) you want in the drop-down.

6. Click the Close link to close the Problem.

Note: After a Problem is closed, the record cannot be reopened.

The Problem status changes to Closed and the Problem enters the Closed phase.

131

CSM Record Management

CSM Record Management



Problem Design Ideas
CSM provides an OOTB Problem workflow with all the items you need to successfully log and resolve
Problems. You can use this workflow, or tailor it to meet the needs of your organization. Design ideas
include:

• Fields: Change which Fields are required and when, which Fields support Rich Text, etc.

• Statuses: Change Problem statuses and/or the One-Steps that are initiated when a Problem enters
each status.

• Form: Change the Form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Steps: Create Actions/One-Steps to automate your workflow (ex: Tweet the
Resolution description when a Problem is closed).

• E-mail: Change the templates that are used to create the e-mails sent by One-Steps or Automation
Processes (ex: "Notify Owned By via E-mail" One-Step). The e-mail templates are defined as part of
the One-Step. Or, disable/change when and to whom notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that monitor Incidents (ex:
Monitors for record inactivity, sends automatic notification e-mails, etc.).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down Fields (ex: Cause Codes).

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.
Refer to the online help for this detailed information.
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Problem Features
CSM provides the following tools to help manage Problems:
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Problem Form
Use the Problem Form to log, edit, and track Problems. The form is made up of four main areas:

1. Workflow Bar: Displays the Problem phases (Classify, Investigate, Known Error, Resolve). Light gray
indicates upcoming/complete phases and dark gray indicates that the record is in-phase.

2. Quick Info Tile: Displays important at-a-glance information (Problem ID, Status bar, (current and next
status), Priority bar, Linked Incidents bar, record ownership, and common operations (I Want To
section).

3. Main Pane: Displays the main form fields, organized by Identify and Classify; Investigation and
Analysis; Workaround and Error; and Root Cause and Resolution steps.

4. Arrangement: Dynamically displays linked records (Child Records) that are in a relationship with the
parent Problem Record.

The following table describes the fields on the form.
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Field Description Comments

Quick Info Tile

Important at-a-glance information, such as
Problem ID, Requestor contact information,
Status bar (current and next status), record
ownership, and common operations (I Want
To...area.).

 

Problem Record type.  

ID Unique record identifier (ex: 10220).
CSM automatically assigns the ID
when the Problem is created.

Priority Alert Bar
The color (red/orange/green) indicates the
level of priority.

 

Linked Incidents
Alert Bar

The color (red/orange/green) indicates the
number of affected Incidents.

 

Status Alert Bar
Current and next status of the Problem as it
progresses through the Problem workflow.

Problem statuses do not align with
Problem phases.

Status

Statuses include:

• New: Problem is being logged,
identified, and classified.

• Assigned: Problem has been assigned
to an owner.

• Work in Progress: Problem is being
diagnosed, investigated, and analyzed.

• Pending Change: Problem process is
on hold until a Change Request is
implemented.

• Resolved: Problem is resolved.

• Closed: Problem is closed.

 

Next: Status
Click the links to move the Problem through
the Problem workflow. Actions include:

One-Steps (Alt 1 Step from
Relationship, Alt 2 Step from
Relationship, or Next Step from
Relationship):

Conditionally changes the record
status to next logical status (defined
by the status values in Table
Management).
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Field Description Comments

 
Begin Work: Captures a date-time stamp to
track when work began on the Problem.

One-Step (Start Work In Progress):
Changes the Problem status to
Work in Progress. If an owner is not
assigned, assigns the Problem to
the current User and the Team the
User belongs to.

 
Set as Pending Change: Temporarily
suspends the Problem until a Change
Request is implemented.

One-Step (Set to Pending Change):
Changes Problem status from Work
in Progress to Pending Change.

 Set as Resolved: Resolves the Problem.
One-Step (Set as Resolved):
Changes the Problem status to
Resolved.

 Close: Closes the Problem.
One-Step (Set as Closed):
Changes the Problem status from
Resolved to Closed.

Owned By Record owner.  

User Owner

-select owner-

Name of the User owner. Click the link to first
select a Team and then a User owner (User
is limited by Team).

Typically, the owner is the Reviewer and a
member of the Support Team.

One-Step (Assign to Individual):

Launches the Choose Team
window, where a User can choose
an Owned By Team for the record;
then, launches the Choose User
window, where a User can choose
a Primary User from the already-
selected Team.

Team Owner

-select team-

Name of the owner Team. Click the link to
select a Team owner.

One-Step (Assign to Team):

Launches the Choose Team
window, where a User can choose
an Owned By Team for the record.

Assign to
Click the link to select a User owner for the
Problem. The Team owner is populated by
the selected User owner's default Team.

One-Step (Assign to ANY
Individual): Prompts the User to
assign the record to any CSM User
(not limited by Team). Uses Owned
By ID and Owned By Team fields.

Avatar
Photo/graphic associated with the User
owner (from User Profile).

 

Owner E-mail
Address

Owner's e-mail address (from User Profile).  

Owner Phone
Number

Owner's phone number (from User Profile).  

I Want To
Common operations (initiate Actions/One-
Steps).
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Field Description Comments

Take Ownership
Click the link to make yourself (Current User)
the User owner for the Problem.

One-Step (Take Ownership):

Makes the Current User the
Primary User of the record.

Publish to Top
Issues List in
Portal

Click the link to publish the text from the
Diagnosis and Workaround fields to the
Portal. Customers can access the update by
clicking the Top Issues link in the Portal.

One-Step (Publish/Remove known
error to/from Portal): If the known
error is not yet visible in the Top
Issues section of the Portal, uses
the Publish Known Error in Portal
One-Step Action to display the
known error. If the known error is
visible in the Top Issues section of
the Portal, uses the Remove Known
Error from Portal One-Step Action
to remove the known error.

Send an E-mail
Update to
Customers

Click the link to define a message to send via
e-mail to the Customers associated with
Incidents linked to the Problem.

One-Step (E-mail Customer):
Sends an e-mail to Customers of
Incidents linked to the Problem.

Resolve Attached
Incidents

Click the link to change the status of linked
Incidents to Resolved.

One-Step (Resolve Incidents):
Makes the current User the owner,
and then changes the Problem
status to Resolved. When the
status changes to Resolved, e-
mails Customers of attached
Incidents to notify them of the
resolution.

Set as Resolved

Click the link to automatically change the
Problem status to Resolve. When the
Problem is resolved, you can also resolve all
of the linked Incidents (see the Resolve
Attached Incidents link).

One-Step (Set as Resolved):
Changes the Problem status to
Resolved.

View More Status
Options

Click the link to open a Prompt popup with a
drop-down that contains a list of all available
status options (Assigned, Closed, New,
Pending Change, Resolved, Work in
Progress).

One-Step (Update Problem Status):
Prompts the User to select a status,
and then changes the Problem
status.

Workflow Bar
Displays the Problem workflow phases. Dark
gray indicates the current phase.

Problem phases do not align with
Problem statuses.
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Field Description Comments

 

Workflow phases include:

• New: Creator logs a new Problem.
Then, the creator identifies and
classifies the Problem (Description,
Service, Category, and Priority).

• Investigate: Ownership is assigned.
The owner investigates and analyzes
the Problem, and then logs a diagnosis.
The owner creates a Change Request,
if necessary.

• Known Error: Owner develops and
logs the workaround. Then, the owner
can update Users (submit a Knowledge
Article to Knowledge Base) and
Customer (publish known error to
Customer Portal).

• Resolve: Owner resolves the Problem
(logs resolution details and code).

• Closed: Owner closes the Problem.

 

Main Pane   

Step 1: Identify
and Classify

Record the basic details.  

*Short Description A concise description of the Problem.

*Required.

Note: The Tweet button  (must
be activated) is displayed next to
the Short Description field. Click the
button to Tweet the text in the Short
Description field.

*Detailed
Description

A detailed description of the Problem.
*Required. Full-Text field
(searchable).
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Field Description Comments

*Service

Service affected by the Problem:

• Account Management

• Conferencing/Presentation

• Desktop Management

• E-mail/Calendaring

• Employee Support

• Enterprise Apps

• IT Service Desk

• Network Services

• Printing

• Telephony/Fax

• Web Services

*Required.

Classify a Problem from top down
by first selecting a Service, then a
Category, and then a Subcategory.

For more information, see Service
Categorization.

*Category
Service Category that the record relates to
(ex: Mailbox).

*Priority
Indicates the established timescales and
effort to resolve a Problem. Priority is derived
from an impact and urgency Priority Matrix.

*Required. For more information,
see Priority.

Step 2:
Investigation
and Analysis

Record a diagnosis and view affected CIs.

Step 3:
Workaround and
Known Error

Record the workaround and update
Customers.

 

Workaround
Exists

Select the check box to indicate that a
workaround is available to Customers.

 

Workaround
Provide an explanation of a workaround for
the Problem.

 

Submit
Workaround to
Knowledge Base

Click the Knowledge Article button  to
create a Knowledge Article using the text
from the Workaround field.

One-Step (Send Known Error to
Knowledge): Creates a Knowledge
Article in a new window, attaches
the Problem, and autofills the
Knowledge Article Title, Solution or
Workaround, Service, Category,
Article Type.
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Field Description Comments

Publish Known
Error in Portal

Click the Portal button  to submit the text
from the Workaround field to the Portal.

One-Step (Publish/Remove Known
Error to/from Portal): If the known
error is not yet visible in the Top
Issues section of the Portal, uses
the Publish Known Error in Portal
One-Step Action to display the
known error. If the known error is
visible in the Top Issues section of
the Portal, uses the Remove Known
Error from Portal One-Step Action
to remove the known error.

Tweet Known
Error

Click the Twitter button  to Tweet the
known error information.

One-Step (Send Known Error
Tweet): Tweets the Short
Description field.

Note: To use the Tweet button on
the Problem Form, you must
integrate your Twitter account and
activate the Tweet buttons. For
more information, see Create a
Twitter Account and Activate Twitter
Buttons.

Step 4: Root
Cause and
Resolution

Record the resolution and cause code
associated with the Problem.

 

Resolution
Provide a description of the root cause and
resolution.

 

Cause Code

Select a cause code in the drop-down.
Options include:

• Hardware Failure

• Human Failure

• Procedure Failure

• Software Failure

• Update Failure

 

Form
Arrangement

  

Journals

Displays related Journal records that are
created to track User notes/comments,
Customer requests/comments, field and
status changes, Queue history, and e-mail
correspondence.
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Field Description Comments

Tasks
Displays related Tasks (Escalations, Time
Entries, and Work Items).

 

Configuration
Items

Displays CIs that are related to/support this
Problem (ex: Primary CI).

For more information, refer to About
CMDB.

Incidents
Displays related Incidents that linked to/
affected by the Problem.

 

Change Request
Displays Change Requests that involve this
Problem.

For more information, refer to About
Change Requests.
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Problem Tasks
A Task is a piece of work that is created and assigned to another CSM User or Team to help resolve/fulfill
an Incident/Service Request, Problem, or Change Request (example: An Incident might require a server
reboot). Tasks can also be used to successfully complete a Project or Release (example: A Project might
require a new switch). Use Tasks to distribute and track individual pieces of work assigned to Teams or
Users within the context of a Problem.

The following OOTB Task types are available for Problems:

• Escalation: A Task assigned to a higher tier of support.

• Time Entry: A Task for tracking time against a parent object.

• Work Item: A Task for either immediate action or future completion.

The Task form captures and manages your Tasks. The Task form is a child record that is linked to and
available from its parent Problem form (access the form by clicking the Tasks tab in the Problem
Arrangement). The Task form that is accessed from a Problem is an abbreviated form view.

To view the detailed Task form, click the Go to Record button, or search for the Task using a Quick Search
or Search Group.

Note: For detailed information about the Task form, refer to the Task form documentation.
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Problem Journals
CSM provides the following OOTB Problem Journal types:

• Journal - Note: Tracks User notes/comments. For example, a User might chronicle troubleshooting
progress.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt, follow-
up, resolution, and questions.

• Journal - Queue History: Tracks when records are added to/removed from a Queue.

Note: History Journals are automatically created by CSM. Notes are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).
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Problem Dashboard
CSM provides a OOTB Problem Dashboard that intuitively organizes your critical Problem metrics into a
single control panel. The Dashboard displays the number of open Problems, number of open Top Issues
(in the Portal), number of linked Incidents, number of Problems with and without workarounds, number of
open known errors, number of Problems owned by Teams, percentage of Problems in each phase (New,
Investigate, etc.), percentage of Problems in each category (based on Service), list of all Top Issues, and
a list of all Problems.

Note: Problem metrics are also available on other Dashboards, including Executive, Global IT, and
Change.

OOTB Problem Dashboard Widgets

Item Description
Widget
Type

Widget Name Widget Uses:

Open
Problems

Number of open Problems
(Status does NOT = Resolved or
Closed).

Text
Gauge

Total Open
Problems

Open Problems
Search Group
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Item Description
Widget
Type

Widget Name Widget Uses:

Open Top
Issues

Number of open Problems
(Status does NOT = Resolved or
Closed) visible in the Portal.

Text
Gauge

Top Issues
Count

Problems Set as
Top Issues Search
Group

Total Linked
Incidents

Number of open Incidents
(Status does NOT = Resolved or
Closed) linked to the Problem.

Text
Gauge

Incidents
Affected
Counter

Incidents Linked to
Problem Search
Group

No Work
Around

Number of open Problems
(Status does NOT = Resolved or
Closed) with a cleared
Workaround Exists check box.

Text
Gauge

Problems with
No Work
Around

No Workaround
Search Group

With a Work
Around

Number of open Problems
(Status does NOT = Resolved or
Closed) with a marked
Workaround Exists check box.

Text
Gauge

Problems with a
Workaround

Workaround Exists
Search Group

Known Errors

Number of open Problems
(Status does NOT = Resolved or
Closed) with completed
Workaround and Resolution
fields.

Text
Gauge

Known Error
Open: Known Error
Search Group

Problems
Owned by
Team

Percentage of open Problems
(Status does NOT = Resolved or
Closed) based on Team
ownership.

Bar Chart
Problems by
Teams

Open Problems
Search Group with
values based on
Owned By Team
field.

Problem
Lifecycle

Percentage of open Problems
(Status does NOT = Resolved or
Closed) based on the Status
field.

Pipeline
Chart

Problem
Lifecycle

Pipeline slices
represent Problem
statuses.

Open Problem
Categories

Percentage of open Problems
(Status does NOT = Resolved or
Closed) based on the Category
field.

Pie Chart Open Problems
Chart slices
represent Problem
categories.

Top Issues
List of all Problems that are
visible in the Portal.

Search
Results
List

Global Issues
All Top Issues
Search Group.

All Problems
List of all open Problems (Status
does NOT = Resolved or
Closed).

Search
Results
List

All Problems
Open Problems
Search Group.
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Problem One-Steps
CSM provides numerous OOTB Problem One-Steps. Notable Problem One-Steps include:

One-Step Description/Actions Associations Executed From

Status    

Alt 1 Step from
Relationship Conditionally change the Problem status to

next logical status (defined by the Problem
status values in Table Management) and/or
initiate the next appropriate One-Step:

• Begin Work: Start Work in Progress
One-Step.

• Set as Resolved: Set as Resolved One-
Step.

• Pending Change: Set to Pending
Change One-Step.

• Close: Set as Closed One-Step.

Problem
Problem Form,
Next: <Status>

Alt 2 Step from
Relationship

Next Step from
Relationship

View More
Status Options

Allows the User to set any status. Problem
Problem Form,
Next: <Status>

Conditional
Status

   

Start Work in
Progress

Changes the Problem status to Work in
Progress. If an owner is not assigned, assigns
the Problem to the current User and the Team
the User belongs to.

Problem
Problem Form,
Status: Begin Work
link

Set as Resolved Changes the Problem status to Resolved. Problem
Problem Form,
Status: Set as
Resolved link

Set to Pending
Change

Changes the Problem status to Pending
Change.

Problem

Problem Form,
Quick Info Tile: Set
as Pending Change
link

Set as Closed Changes the Problem status to Closed. Problem
Problem Form,
Status: Close link

Form    

Ownership    
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Assign to ANY
Individual

Prompts the User to assign the record to any
CSM User (not limited by Team). Uses Owned
By ID and Owned By Team fields.

Changes Problem status from New to
Assigned.

Problem
Problem Form,
Assign To link

Assign to
Individual

Launches the Choose Team window, where a
User can choose an Owned By Team for the
record; then, launches the Choose User
window, where a User can choose a Primary
User from the already-selected Team.

Changes Problem status from New to
Assigned.

Problem
Problem Form,
Owned By: Select
Owner link

Assign to Team

Launches the Choose Team window, where a
User can choose an Owned By Team for the
record.

Changes Problem status from New to
Assigned.

Problem
Problem Form,
Owned By: Select
Team link

Take Ownership

Makes the Current User the Primary User of
the record.

Changes status from New to Assigned.

Problem
Problem Form, I
Want To: Take
Ownership link

I Want To    

Publish/Remove
Known Error to/
from Portal

If the known error is not yet visible in the Top
Issues section of the Portal, uses the Publish
Known Error in Portal One-Step Action to
display the known error. If the known error is
visible in the Top Issues section of the Portal,
uses the Remove Known Error from Portal
One-Step Action to remove the known error.

Problem

Problem Form, I
Want To: Publish to
Top Issues List in
Portal, Step 3:
Workaround and
Known Error:
Publish Known
Error in Portal
button

Resolve
Incidents

Makes the current User the owner, and then
changes the Problem status to Resolved.
When the status changes to Resolved, e-mails
Customers of attached Incidents to notify
them of the resolution.

Problem
Problem Form, I
Want To: Resolve
Attached Incidents

Set as Resolved Changes the Problem status to Resolved. Problem
Problem Form, I
Want To: Set as
Resolved
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Update Problem
Status

Prompts the User to select a status, and then
changes the Problem status.

Problem
Problem Form, I
Want To: View More
Status Options

A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.
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Problem Search Groups
CSM provides numerous OOTB Problem Search Groups. Notable Problem Search Groups include:

Search Group Returns Association Executed From

All Problems All Problems, regardless of status. Problem
Search Manager,
Metrics, Reports,
Widgets

All Top Issues
All Problems that are visible in the
Portal.

Problem
Search Manager,
Widgets

Known Error
Problems that are known errors
(completed Diagnosis and Workaround
fields).

Problem
Search Manager,
Metrics

My Open Problems
Open Problems that are owned by me
(Current User).

Problem
Search Manager,
Metrics, Widgets

My Team Open
Problems

Open Problems that are owned by a
Team to which I (Current User) belong.

Problem Metrics, Widgets

Open Problems Open Problems. Problem
Search Manager,
Metrics, Widgets

Open: Known Error
Open Problems that are known errors
(completed Diagnosis and Workaround
fields).

Problem
Search Manager,
Metrics, Widgets

Open: Known Error in
Portal

Open Problems that are known errors
visible in the Portal.

Problem
Search Manager,
Metrics, Widgets

Problems Set as
Global Issues

Open Problems that are Global Issues
(completed Diagnosis and Workaround
fields).

Problem
Search Manager,
Metrics

Workaround Exists
Problems that have a defined
workaround.

Problem Search Manager
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Problem Automation Processes
CSM provides the following OOTB Problem Automation Processes:

Name Description

Notify Problem
Owner of
Assignment

When the Owned By Field of a Problem changes, the process initiates the Notify
Owned By via E-mail One-Step, which sends a notification e-mail to the new
owner.

Notify Problem
Team of
Assignment

When the Owned By Team Field of a Problem changes, the process initiates the
Notify Owned By Team via E-mail One-Step, which sends a notification e-mail to
members of the Team that owns the changed Problem.

Inactivity Escalation
Waits two days after the Last Modified Date Time Field changes, then initiates the
Escalate if Inactive One-Step, which sends a notification e-mail to the manager of
the Problem owner.

Problem - Resolve
Incident

Waits for the status of a Problem to be set to Closed, then initiates the Resolve
Incidents One-Step, which sets the status of the Incidents to Resolved and sends
a notification e-mail to the Incident Customer(s).
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Problem Reports
CSM provides numerous OOTB Problem Reports. Notable Problem Reports include:

Report Description Association Search Group

Problem Impact
Metrics

Lists all Problems (including details) and highlights
the number of Incidents linked to each Problem.

Problem All Problems

Problem Metrics
Bar charts show the number of Problems (including
details) by status, Service, impact, and category.

Problem All Problems

Problem
Summary

Bar chart shows the number of open and resolved
Problems logged each quarter.

Problem All Problems

Problem Trends
Line charts show the number of Problems each
month by Service and impact.

Problem All Problems

Problems by
Category

Bar chart shows the number of Problems by
category. Below the chart is a list of Problem details.

Problem All Problems

Problems by
Impact

Bar chart shows the number of Problems by impact.
Below the chart is a list of Problem details.

Problem All Problems.

Problems by
Service

Bar chart shows the number of Problems by
Service. Below the chart is a list of Problem details.

Problem All Problems

Problems Linked
with Incidents

Lists Problems (including details) that have linked
Incidents.

Problem All Problems

Top 10 Problems
Bar chart displays the top ten Problems based on
how many Incidents are associated with each
Problem ID.

Problem All Problems

Top 10 Problems
by Category

Bar charts display the top ten Problems (by
category) based on how many Incidents are
associated with each Problem ID.

Problem All Problems
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Service Asset and Configuration Management
(CMDB)

CSM provides a Configuration Management Database (CMDB) process to ensure that all Configuration
Items are effectively managed and stored in the Configuration Management Database (CMDB).
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About the Configuration Management Database
(CMDB)

The Configuration Management Database (CMDB) is a repository of Configuration Items (CIs). The
CMDB is an interface that assists with the management of Configuration Item (CI) Records. Use the
CMDB to view, create, edit, and delete CI records. CI Records are stored alphabetically, and can be
viewed in a Grid View or Record View. Configuration Item is a Group Object comprised of different CI
types. Use the CMDB to:

• Create CIs.

• View CI details.

• Edit CIs.

For more information, refer to CMDB Features and Capabilities in the online help.
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About Configuration Items
Configuration Items (CIs) are assets that make up the CMDB that are managed to avoid disruptions to
Services. Use Configuration Items to track and monitor:

• New items.

• Current items.

• Retired items.

There are several OOTB CI categories:

• Computer: Individual laptops, individual workstations, etc.

• Mobile Device: Company cell phones, tablets, etc.

• Network Device: Access points, firewalls, routers, switches, etc.

• Printer: Local printers, network printers.

• Server: Application server, file server, mail server, etc.

• Software License: Open source, proprietary, shareware, etc.

• System: Database system, network system (ex: A CI System for the e-mail system would have a
relationship with each of the mail servers).

• Telephony Equipment: Phone, ACD, etc.

• Other: CIs that do not correspond with other CI categories.

The OOTB CI Forms (ex: Printer) help to create, manage, and track CIs:
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1. The Main Pane displays detailed CI information based on the type of CI, such as location and
network information.

2. The Quick Info Tile displays important at-a-glance information based on the type of CI, such as the
Status alert bar (current and next status), Open Incidents alert bar, Primary User, asset ownership,
and common operations (I Want To section).

3. The Form Arrangement dynamically displays linked child records based on the type of CI, such as
Journals, Incidents, and Problems.
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CMDB Features and Capabilities
CSM CMDB has several features and capabilities:

• Searching: Quickly locate all CIs by running a Quick Search, or search for a particular CI or set of
CIs by refining the search criteria to a word/phrase, timeframe, Customer, etc. Use Search Group to
save/run commonly-run Searches.

• Search Groups: Use CI Search Groups to quickly locate/filter CIs, or to automate searching in
Reports or on Dashboards.

• Security: Secure CIs by controlling who can view, create, edit, and delete records.

• Business Object: Use the dedicated Config Item Business Object to track CIs, and then configure
the Business Object to capture/track only what you want.

• Forms: Use the powerful Config Item Forms to create, edit, and track CIs. The form provides a
Quick Info Tile to display important at-a-glance information (CI type, status alert bar (current and
next status), Open Incidents alert bar (with threshold colors), Primary User, asset owner, common
operations (I Want To section), and an Arrangement area to dynamically display linked records (child
records) that are in a relationship with the CI (parent record).

• Workflow: Use the streamlined CMDB workflow to move CIs from an initial status to a final status.

• Creation Flexibility: Create CIs manually or through an automated process.

• Ownership: Assign each CI to a Primary User to ensure accountability and track assets. The
Primary User is also thought of as an external Customer, technician, or internal User of an asset. In
CMDB, the Customer is referred to as the Primary User.

• Linked Records: Link child records to a parent CI Record to keep supporting information at your
fingertips and to ensure data relationships. Linked child records are visible in the CI Arrangement.

• History and Revision tracking: Use linked Journals to track important status and field changes.

• E-mail correspondence tracking: Use linked Journals to track e-mail correspondence.

• Rich Text: Use Rich Text to complement your Descriptions by adding formatting and images/
screenshots.

• Actions/One-Steps: Use powerful Actions and One-Steps to move CIs through their workflow,
initiate common operations (ex: Assign ownership), e-mail asset owners, etc. Actions/One-Steps are
available on the CI Form (ex: CSM Desktop Client Task Pane).

• CMDB Dashboard: Use the CMDB Dashboard to view your critical CI metrics in a single, real-time,
at-a-glance control panel. The Dashboard displays the number of CIs being repaired, the number of
CIs that are down, the number of new CIs, total CMDB assets based on type, the number of CI
events based on type, and the number of CIs based on vendor.

• Reports: Run Reports to show up-to-date statistics on the number of assets based on type (ex:
Hardware, Software, etc.).

• Automation Processes: Use Automation Processes to automatically send notification e-mails and
run tiered alerts.

• Status: Use to retire and move a CI out of an active CMDB by changing the status to inactive,
retired, or disposed.  Status allows the system administrator to view the lifecycle of a CI and
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maintain a logical history of incidents, revisions, and upgrades. The system administrator can
update the status of a CI from active to inactive and apply a no orphan to particular associated
records while removing the CI from the current selection processes..
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Configuration Item Workflow
CI assets use two distinct workflows based on their classification of either hardware or software.

The following figure shows the high-level Hardware CI (Computers, Mobile Devices, Printers, Network
Devices, Servers, Systems, Telephony Equipment, and Other CIs) process workflow in the OOTB system.
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Note: Access additional statuses (Stolen/MIA, In Repair, In Testing, etc.) at any time via the View
More Status options link (I Want To section of the Quick Info Tile).

A CI progressing through the Hardware CI workflow encounters the following statuses:

1. New: CI is being logged, and the initial details are being recorded.

2. Ordered: CI is being ordered.

3. In Stock: CI has been received.

4. Planned: CI use and location are being determined.

5. In Testing: CI is being tested.

6. Active: CI is operational.

7. In Repair: CI is being repaired.

8. Down: CI is being taken out of service temporarily.

9. Stolen/MIA: CI has been stolen or lost.

10. Retired: CI is being taken out of service.

The following figure shows the high-level Software CI (Software License) process workflow in the OOTB
system.
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A CI progressing through the Software CI workflow encounters the following statuses:

1. Requested: Software License has been requested.

2. Planned: Software License use and location are being determined.

3. Ordered: Software License is being ordered.

4. Active: Software License is operational.

5. Expire: Software License is expired.
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CMDB Interface
The CMDB interface is a tool that allows you to quickly manage Configuration Item (CI) records. Use the
CMDB interface to:

• View CI records: View a Grid list of CI records or a specific record in detail.

• Find a specific CI record using filtering and searching options.

• Create, edit, or delete a CI record.

The CMDB interface can be opened several ways from the CSM Desktop Client or Browser Client.

To open the CMDB interface:

• From the CSM Desktop Client menu bar or CSM Browser Client menu bar, click Tools>CMDB.

• From the Common Tasks section of the CSM Desktop Client Task Pane, click CMDB.

• From a Business Object record, click the CI Selector button .

• From the Configuration Items tab in a Form Arrangement, click the Link button .

1. Filters: View all CI records, or filter by CI Type (ex: Computer, Printer, etc.), Customer (ex: All or
named Customer), and/or timeframe (ex: Anytime, Today, Previous Month, etc.).
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2. Search: Search for a specific CI record (ex: Search any searchable field, such as Asset Tag, Host
name, etc.).

3. Record View: Displays Grid list of CI records or a specific CI record.

Good to know:

• From the Grid, you can print, export, run an Action, sort, filter, group, size, move/reorder, and add/
remove columns. Double-click a record to display it.

• See CMDB Interface Behaviors for tips on working with CI records in the CMDB interface.
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Open the CMDB Interface
1. Open the CSM Desktop Client or CSM Browser Client.

2. Select Tools > CMDB, or use one of the following options:
◦ From the Common Tasks section of the CSM Desktop Client Task Pane, click CMDB.

◦ From a Business Object record, click the CI Selector button .

◦ From the Configuration Items tab in a Form Arrangement, click the Link button .

The CMDB interface opens.

165

CSM Record Management

CSM Record Management



CMDB Interface Behaviors
Menu Bars and Toolbars

Use the CSM Desktop Client menu bar/toolbar and Browser Client menu bar/toolbar to access Table
Management operations, such as:

• Navigating records.

• Switching between Grid view and Current Record view.

• Adding, editing, and deleting CI records.

Context Menu (Desktop Client Only)

Use the CMDB interface context (right-click) menu to to quickly access common CMDB operations.

Menu Item Description

Go to Record Displays the selected CI record.

New Creates a new CI record.

Delete Deletes the selected CI record.

Print Grid Prints the active Grid.

Export Grid Exports the active Grid to a file.

Tip: If Context Menu Actions are defined, an Actions menu item is also displayed to run Actions.

Record Views

There are two views available for the CMDB interface:

• Grid list: Select the Show Results button   on the toolbar to display a Grid list of CI records.

• Current record: Select the Show Current Record button   on the toolbar to display the
selected CI record.

Grid Capabilities
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When CI records are displayed in Grid view, use the CSM Grid capabilities (ex: Print, export, run an
Action, sort, filter, group, size, move/reorder, and add/remove columns) to display only the data you want
and in a way that is meaningful to you.

Find Records

Use the filter and search options to find CI records. Display all CI records, or filter by CI Type (ex:
Computer, Printer, etc.), Customer (ex: All or named Customer), and/or timeframe (ex: Anytime, Today,
Previous Month, etc.). To search, type a value to search in the Search box (ex: Asset tab, host name,
etc.), and then click Go.
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Creating Configuration Item (CI) Records
The instructions walk through the steps to create a Printer CI Record using our OOTB workflow:

• Create a Configuration Item (CI) Record: Typical step-by-step instructions for creating a Printer CI
Record.

Note: CSM provides OOTB CMDB workflows with all the features needed to successfully
manage CIs. Use these workflows as-is, or tailor them to meet organizational needs.
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Create a Configuration Item (Printer)
Hardware and Software Forms vary based on the specific Configuration Item. The following procedure
provides steps for creating a Printer CI. For more information, see CMDB Good to know

To create a CI:

1. On the CSM Desktop Client toolbar, click New>New Configuration Item, and then select a CI (ex:
New Config - Printer).

Tip: Another way to create a CI is to click File>New>New Configuration Item>New Config -
Printer from the CSM Desktop Client menu bar.

A CI Record is created with a unique Asset Tag ID (ex: 4476) and a status of New. This can be an
auto-generated Asset tag or a value provided by the system administrator.
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Note: An Asset Tag can be auto-generated or provided by an administrator to customize it
for business needs.

2. Select a Primary User in the Quick Info Tile:
a. Primary User: Provide the name (ex: Gina) of the person who initiated the Change (not the

creator of the record), and then press Enter or Tab to search for the Customer Record.

If an exact match is found, the Primary User Fields are auto-populated with the Customer’s
name, avatar, e-mail, and phone number. If multiple matches are found (ex: Multiple
Customers named Gina), the Contact Manager opens to select the appropriate Customer.

Note: The Primary User is also thought of as an external Customer, technician, or internal
User of an asset. In CMDB, the Customer is referred to as the Primary User.

Tips: Wildcards (ex: % or *) can be used when searching. If the Customer is a VIP, a VIP icon

 appears beside the name. To browse for a Customer or add a new Customer Record, click

the Customer Selector button  to launch the Contact Manager. To add an alternate phone
number or e-mail address, click the Alternate Contact Info link. To view the selected

Requestor's detailed Customer Record, click the Quick View button .

3. Assign an Owned By (ex. IT) to the CI by clicking one of the ownership links in the Quick Info Tile
(Owned By or I Want To sections):

◦ Take Ownership: Click this link to make yourself the Owned By User.

◦ Assign to: Click this link to select an Owned By User. The Team owner is populated by the
User's default Team.

◦ Select Owned By (User): Click the link to first select a Team, and then an Owned By User
(User is limited by Team).

◦ Select Owned By Team: Click this link to first select an Owned By Team.
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4. The CI owner records the initial CI details (ex: Details and Network sections of the Config - Printer
Form).

Tip: Fields with drop-down arrows are populated based on Lookup Table values in Table
Management. Add, edit, or delete Field values by selecting the Field, and then pressing F3.
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Note: Consider providing a Friendly Name for each CI. This Field is used by other Business
Objects (ex: Incident and Change) when linking to the record. In some cases, the CI cannot
be linked without the Friendly Name.

5. The asset owner orders the CI:
a. In the Status alert bar, click Order.

The CI status changes to Ordered.

6. When the CI is received, the asset owner identifies the CI as in stock:
a. In the Status alert bar, click Mark as In Stock.

The CI status changes to In Stock.

Note: If the CI needs to be tested before becoming operational, click View more status options
under I Want To. The CI Status Selector opens. Click In Testing, and then click OK. The status
changes to In Testing.

Note: If the CI is stolen or lost, click the View More Status Options link in the I Want To section
of the Quick Info Tile to access the CI Status Selector, and then select the Stolen/MIA status.

7. Owner plans the use and location of the CI:
a. In the Status alert bar, click Planned.

The CI status changes to Planned.

Note: If the CI needs to be tested before becoming operational, click View more status options
under I Want To. The CI Status Selector opens. Click In Testing, and then click OK. The status
changes to In Testing.

8. When ready, owner activates the CI:
a. In the Status alert bar, click Activate.
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The CI status changes to Active.

Note: If the CI needs to be repaired while active, click the Mark as "In Repair" link in the I
Want To section of the Quick Info Tile. The status changes to In Repair.

9. (Optional) Owner deactivates the CI:

Note: A CI is typically deactivated when it must be taken out of service temporarily (ex:
Primary User leaves the organization).

a. In the Status alert bar, click Bring Down.

The status changes to Down, and the Status alert bar turns red.

Tip: CSM provides multiple OOTB Automation Processes that use Tiered Alerts to help
manage CIs when they are out of service (status is Down). Use these Automation Processes,
edit them, or create them to fit the organizational needs.

10. (Optional) Asset Owner retires the CI:

Note: A CI is typically retired when it must be taken out of service permanently (ex: Printer is
replaced).

a. In the I Want To section of the Quick Info Tile, click the View More Status Options link.

The CI Status Selector opens.

b. Click the Retired status.

c. Click OK.

The CI status changes to Retired.
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CMDB Design Ideas
CSM provides OOTB CI workflows with all the items you need to successfully create CIs. Use these
workflows, or tailor them to meet organizational needs. Design ideas include:

• Fields: Change which Fields are required and when, which Fields support Rich Text, etc.

• Statuses: Change CI statuses and/or the One-Steps that are initiated when a CI enters each status.

• Form: Change the Form theme (background and text color), tab order, and size. Change the
threshold and/or colors for Open Incidents logged against a CI.

• Actions and One-Steps: Create Actions/One-Steps to automate the workflow.

• E-mail: Change the e-mail templates that are used to create the e-mails sent by One-Steps or
Automation Processes. Or, disable/change when and to whom notifications are sent (ex: Send a
notification to a computer owner whenever their CI Record changes).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
downs (ex: Computer Manufacturer).

• Visualizations: Add, remove, or edit Upstream or Downstream Relationship options.

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.
Refer to the online help for this detailed information.
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CMDB Features
CSM provides the following tools to help manage the CMDB:
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CMDB Forms
Use the CI Forms (ex: Printer) to create, edit, and track CIs. The forms are made up of four main areas:

1. The Main pane displays detailed CI information based on the type of CI, such as location and
network information.

2. The Quick Info Tile displays important at-a-glance information based on the type of CI, such as the
CI type, Status alert bar (current and next status), Open Incidents alert bar, primary User, record
ownership, and common operations (I Want To section).

3. The Arrangement dynamically displays linked child records based on the type of CI, such as
Journals, Incidents, and Problems.

The following table describes common fields on the CI Form:

Field Description Comments

Quick Info
Tile

Important at-a-glance information
based on the type of CI, such as the CI
type, Status alert bar (current and next
status), Open Incidents alert bar,
primary User, record ownership, and
common operations (I Want To section).
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Field Description Comments

[CI] Record Type.

CSM automatically assigns the Record Type
based on the type of record created
(New>New Configuration Item>New Config -
"CI").

Status alert
bar

Current and next status of the CI as it
progresses through the CI workflow.

Unlike other records, the CI only uses
statuses (not phases).

Open
Incidents
alert bar

Displays the number of Open Incidents
linked to the CI.

 

Primary User User assigned to the CI.

The asset is owned by a group or manager
within an organization (ex. IT). The Owned
By Team assigns the asset to a Primary User
to use. The Primary User does not own the
asset.

Primary User
Name

Name of the Primary User who uses
the CI. The User assigned the asset by
the organizational owner (see Owned
by).

Provide a name in the Primary User
field (ex: Gina), and then press Enter or
Tab to locate the Customer Record.

Note: Wildcards like % or * can be
used with partial information. If an exact
match is found, the information
autopopulates the Requestor, Phone,
and E-mail fields. If multiple matches
are found (ex: Multiple Customers
named Gina), the Contact Manager
opens so that the technician can select
the appropriate one.

After you select a Primary User, the Photo,
Phone, and E-mail fields are auto-populated
with information from the Customer Record.

Avatar
Avatar (photo or image) of the
Customer (Primary User). The Avatar, Phone, and E-mail fields are

auto-populated with information from the
Primary User's Customer Record.

One-Step (Dial Customer Phone): Dials the
Customer's phone number.

One-Step (Follow-up E-mail): Creates a
follow-up e-mail to send the Customer
regarding a question or update about the CI.
Allows the User to edit the e-mail before
clicking Send. Attaches the e-mail to the CI
History record.

E-mail
E-mail address of the Customer
(Primary User) who uses the CI.

Phone

Phone number of the Customer
(Primary User) who uses the CI.

Click the link to dial the Customer
(Primary User) if telephony is
configured.
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Field Description Comments

Owned By

Record owner. Owned by refers to the
team or group responsible to the
organization for the asset. This defaults
to the person creating the record and
can be the manager of the group
assigned responsibility for the asset.
The person assigned to the asset itself
would be the Primary User.

The owner is automatically assigned to the
creator. This should be viewed as the person
within an organization who is responsible for
the asset. The Owned By person assigns the
asset to the Primary User.

Assign to

Click the link to select a Primary User
for the CI. The Team owner is
populated by the selected User owner's
default Team.

One-Step (Assign to ANY Individual):
Prompts the User to assign the record to any
CSM User (not limited by Team). Uses
Owned By ID and Owned By Team fields.

User Owner

-select owner-

Name of the Owned By User. Click the
link to first select a Team and then a
Owned By User owner (User is limited
by Team).

One-Step (Assign to Individual):

Launches the Choose Team window, where a
User can choose an Owned By Team for the
record; then, launches the Choose User
window, where a User can choose a Primary
User from the already-selected Team.

Team Owner

-select team-

Name of the Owned By Team. Click the
link to select a Team owner.

One-Step (Assign to Team):

Launches the Choose Team window, where a
User can choose an Owned By Team for the
record.

Avatar
Photo/graphic associated with the User
owner (from User profile).

 

I Want To
Common operations (initiate Actions/
One-Steps).

 

Take
Ownership

Click the link to make yourself (Current
User) the Owned By User of the asset.

One-Step (Take Ownership):

Makes the Current User the Primary User of
the record.

View Detailed
Date/Time
Information

Click the link to open the Information
window, where you can view created
date and time, creator name, and last
edited date and time. Time Date/time
format is MM/DD/YYYY HH:MM.

One-Step (Date Time Info Popup): Displays
details for all the date/timestamps to give a
historical view.

Main Pane
Displays detailed CI information about
the CI, such as location and network
information.

Fields in the Main pane vary based on the
type of CI. These fields are completely
customizable and configurable.
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CMDB Tiered Alerts
Tiered Alerts are tools used to manage CI behaviors when a defined event occurs (ex: When a CI status
changes to Down, an alert might send a notification e-mail to the Record Owner). Alerts are tiered
because they can be configured to initiate a sequential set of Commands/Actions/One-Steps at timed
intervals; the alerts continue to increment (based on defined intervals) until the defined event is no longer
valid.

Good to know:

• Tiered Alerts are available for the following CI Records: Network Device, Printer, System, Telephony
Equipment, and Other CI.

• Tiered Alerts require an Automations Process to define the event (ex: CI status changes to Down)
that initiates the alert. CSM provides multiple OOTB Automation Processes that use Tiered Alerts.
For more information, see CMDB Automation Processes.

• Add up to 99 Tiered Alerts.

• View defined Tiered Alerts in Grid form by clicking View>Grid View in the Tiered Alerts tab of the
Arrangement.

To define Tiered Alerts:

1. Open a CI record (New>New Configuration Item>New Config - [CI type]).
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2. Click the Tiered Alert tab in the Arrangement.

3. Click the New Tiered Alert button.

The Tiered Alert form opens.

4. Define the first tier:
a. Alert Order: Click the Up arrow to select the tier level (ex: 1).

b. Alert Action: Select a Command, Action, or One-Step to take place when the Tiered Alert is
initiated (ex: Send E-Mail):

i. Click the Action Selector button to access the Action Manager.

The Action Manager Opens.
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ii. Click the Command, Action, or One-Step to execute (ex: Send E-Mail Command).

iii. Click OK.

The Command, Action, or One-Step opens in the Alert Action field.
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Note: The Wait time from previous alert field is disabled since this is the first defined
alert.

5. Define the second tier:
a. Alert Order: Click the Up arrow to select the tier level (ex: 2).

b. Alert Action: Select a Command, Action, or One-Step to take place when the Tiered Alert is
initiated.

i. Click the Action Selector button to access the Action Manager.

The Action Manager Opens.

ii. Click the Command, Action, or One-Step to execute (ex: New Incident One-Step).

iii. Click OK.

The Command, Action, or One-Step opens in the Alert Action field.

c. Define the Wait Time from Previous Alert:
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i. In the first field, provide a number to indicate the number of minutes, hours, or days that
CSM should wait (after the first Tiered Alert) before initiating the second alert (ex: 2).

ii. In the second field, click the drop-down to reveal timeframe options, and then select a
timeframe (Minutes, Hours, Days).

The Tiered Alert record is automatically saved.
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CMDB Dashboard
CSM provides a OOTB CMDB Dashboard that intuitively organizes your critical CI metrics into a single,
real-time, at-a-glance CMDB control panel.

Note: CMDB metrics are also found on other OOTB Dashboards (ex: Global IT).

The following table describes the items on the Dashboard:

Item Description
Widget
Type

Widget Name Widget Uses:

CIs Being
Repaired

Displays the number
of CIs with an Asset
Status of In Repair.

Text
Gauge

CI in Repair Custom Search Group

CIs
Currently
Down

Displays the number
of CIs with an Asset
Status of Down.

Text
Gauge

Current Down CIs
CIs Currently Down
Search Group

CIs that are
New

Displays the number
of CIs with an Asset
Status of New.

Text
Gauge

New CIs Custom Search Group

Events by
CI

Displays the number
of Events by Vendor.

Bar with
Line
Chart

CI Events vs. New CIs
All Events Search Group,
All Assets Search Group
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Item Description
Widget
Type

Widget Name Widget Uses:

CI by
Vendor

Displays the
percentage of CIs
based on Vendor.

Pie Chart CI by Vendor
Hardware with
Manufacture Search
Group

Total
CMDB
Assets

Displays the number
of assets based on
type.

Text
Gauge

Uses the following Widgets:

• CMDB Computers in
last 30 days

• CMDB Network
Devices in last 30
days

• CMDB Printers in last
30 days

• CMDB Telephony in
last 30 days

• Copy of Mobile in
CMDB

• Copy of Servers in
CMDB

• Other CIs in CMDB

• Software in CMDB

• System in CMDB

Uses the following
Search Groups:

• All Computers

• All Network
Devices

• All Printers

• All Telephony
Equipment

• All Mobile
Equipment

• All Server
Equipment

• All Other CIs

• All Software

• All System CIs

Filter
Filters Dashboard
metrics by a defined
date range.

Filter
CD - Date Filter - 30 Day
Default
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CMDB One-Steps
CSM provides multiple One-Steps associated with CIs, including:

One-Step Description/Actions Associations Executed From

Status    

Alt Step from
Relationship

Conditionally change the CI status to next
logical status (defined by the CI Status
values in Table Management) and/or initiate
the next appropriate One-Step.

[CI]
CI Form: Next:
[Status]

Alt 2 Step from
Relationship

Next Step from
Relationship

Form    

Ownership    

Assign to ANY
Individual

Prompts the User to assign the record to any
CSM User (not limited by Team). Uses
Owned By ID and Owned By Team fields.

[CI]
CI Form: Assign To
link

Assign to
Individual

Launches the Choose Team window, where
a User can choose an Owned By Team for
the record; then, launches the Choose User
window, where a User can choose a Primary
User from the already-selected Team.

[CI]
CI Form: Select
Owner link

Assign to Team
Launches the Choose Team window, where
a User can choose an Owned By Team for
the record.

[CI]
CI Form: Select
Team link

Take Ownership
Makes the Current User the Primary User of
the record.

[CI]
CI Form: Take
Ownership link (I
Want To section)

Other    

DateTime Info
Popup

Displays details for all the date/timestamps
to give a historical view.

[CI]

CI Form: View
Detailed Date/Time
Information link (I
Want To section)
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Create a new...

Prompts the User to create a new Incident,
Problem, or Change.

Note: This One-Step is only applicable for
hardware CIs.

[CI]
CI Form: Create a
new... link (I Want To
section)

A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.

The schema document is also available on the Customer Support Portal. In the Customer Support Portal,
go to the Release Notes tab, and select Cherwell Service Management. Select the version of CSM you
are running to find the schema document you need.
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CMDB Search Groups
CSM provides the following OOTB CI Search Groups:

Search Group Returns Association Executed From

All Assets All CIs, regardless of type. Configuration Item
Search Manager,
Reports, Widgets

Assets with Linked
Incidents

CIs with at least one related
Incident.

Configuration Item
Search Manager,
Reports

CIs Currently Down CIs with an Asset Status of Down. Configuration Item
Search Manager,
Widgets

Computers and
Systems

Computer and System CIs. Configuration Item
Search Manager,
Reports

Critical CIs CIs marked as Critical. Configuration Item Search Manager

Hardware Hardware CIs. Configuration Item
Search Manager,
Reports

Items with BIOS
CIs that have a BIOS Version
number.

Configuration Item
Search Manager,
Reports

Software Software License CIs. Configuration Item
Search Manager,
Reports

Software Compliance
CIs where the number of Users is
less than the number of Software
Licenses in use .

Configuration Item Search Manager
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CMDB Automation Processes
CSM provides the following OOTB CMDB Automation Processes:

Name Description

Notify Owner of
Computer Change

When any Field of a Config - Computer Record changes, the process initiates
the Send Computer Change Notification E-mail One-Step, which sends a
notification e-mail to the owner of the Config - Computer Record.

Tiered Alert -
Computer Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Computer Business Object).

Notify Owner of
Network Device
Change

When any Field of a Config - Network Device Record changes, the process
initiates the Send Device Change E-mail One-Step, which sends a notification e-
mail to the owner of the Config - Network Device Record.

Tiered Alert -
Network Device
Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Computer Business Object).

Tiered Alert - Printer
Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Printer Business Object).

Tiered Alert - Server
Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Server Business Object).

Tiered Alert -
System Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - System Business Object).

Tiered Alert -
Telephony
Equipment Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Telephony Equipment Business Object).

Tiered Alert - Other
CI Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Other CI Business Object).
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CMDB Reports
CSM provides the following OOTB CMDB Reports:

Report Description Association Search Group

OS Report Lists Hardware assets and details. Configuration Item Hardware

BIOSVersions
Lists CIs that have a BIOS Version
number.

Configuration Item Items with BIOS

Computer Memory
Audit

Lists Physical Memory and Virtual
Memory of Computer and System
assets.

Configuration Item
Computers and
Systems

CI Change Request
Metrics

Bar Chart of Top 5 CIs with large
numbers of associated Change
Requests.

Configuration Item All Assets

CI Summary Report Lists all Hardware CIs by Vendor. Configuration Item Hardware

CPU Speed Report
Lists CPU Speed and number of CPUs
of Computer and System assets.

Configuration Item
Computers and
Systems

Software Summary

Lists software summary information,
including Asset Tag, Version, Number
Assigned to Users, and Number of
Licenses.

Configuration Item Software

Incidents by
Configuration Item

Lists CIs with linked Incidents and
includes information such as Asset Tag,
Manufacturer, and Model.

Configuration Item
Assets with
Linked Incidents
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Change Management
Change management ensures that Changes are recorded, classified, scheduled, implemented, and
reviewed to minimize Service disruption to the company.

Note: This feature is also available as a mergeable application (mApp).
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About Change Requests
A Change Request is a record that tracks the addition, removal, or modification of anything that could
affect IT Services. These can include changes to architectures, processes, tools, metrics, documentation,
and other Configuration Items.

CSM manages three types of Changes:

• A Standard Change is documented, low risk, low cost, occurs frequently, and is thoroughly
understood by the Change Advisory Board (CAB). The Change only needs to be approved by the
CAB once before it is added to a list of Standard Changes.

• A Normal Change is undocumented and it is unknown how the Change might affect the system.
Though the CAB must approve the Change before implementation, it is not considered a high
priority, and can be addressed during the regular CAB meeting time.

• An Emergency Change is a break in the system and must be addressed immediately so that the
system can resume operation. Since the Change is critical, it requires immediate attention from
either the CAB or Emergency Change Advisory Board (ECAB).

For example:

• A new employee requires a software installation (Normal Change). If this becomes a common
scenario, a Change Request can be submitted to make it a pre-authorized Change (Standard
Change).

• A technician reboots the e-mail server because several employees are unable to access e-mail
(Emergency Change).

Note: This feature is now available as a mergeable application (mApp).
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Change Features and Capabilities
CSM Change Management has many features and capabilities:

• Searching: Quickly locate all Changes by running a Quick Search, or search for a particular Change
or set of Changes by refining the search criteria to a word/phrase, timeframe, Customer, etc. Use
Search Groups to save and run commonly-run searches.

• Search Groups: Use Change Search Groups to quickly locate/filter Changes, or to automate
searching in Reports or on Dashboards.

• Security: Secure Changes by controlling who can view, create, and edit records.

• Business Object: Use the dedicated Business Object to track Changes, and configure the
Business Object to capture/track only what you want.

• Form: Use the powerful Change Request forms to create, edit, and track Changes. The forms
provide a Quick Info Tile to display important at-a-glance information (Change ID, requestor contact
information, current and next status, record ownership, and common operations). A workflow bar
allows you to visually track the Change workflow phases, and an Arrangement area dynamically
displays linked records (child records) that are in a relationship with the Change (parent record).

• Creation Flexibility: Create Changes manually or through an automated process.

• Ownership: Assign each Change to a record owner to ensure accountability.

• Linked Records: Link child records to a parent Change Record to keep supporting information at
your fingertips and to ensure data relationships. Linked child records are visible in the Change's
Form Arrangement area.

• Approval Process: Use three OOTB Change Approval processes to automate and regulate
approving/denying/abstaining Changes. The Change Approval processes contains automatic
notifications and status tracking.

• Approval Tracking: Use linked Approvals to track who/when approved/denied/abstained a Change.

• Tasks: Use linked Tasks to distribute and track individual pieces of work assigned to Teams or
Users (example: Escalations, Time Entries, and Work Items).

• Customer Communication Tracking: Use linked Journals to track e-mail correspondence.

• History and Revision Tracking: Use linked Journals to track (and audit) important Status and field
changes.

• Rich Text: Use Rich Text to complement your description fields by adding fonts and images/
screenshots.

• Actions/One-Steps: Use powerful Actions/One-Steps to move Changes through their workflow,
initiate common operations (example: Assign ownership), initiate scenario-specific Actions, run
Reports, etc. Actions/One-Steps are available on the Change forms (including from the CSM
Desktop Client Task Pane and CSM Desktop Client menu bar), and on the Change Dashboards.

• Change Dashboards: Use the Change Dashboard to view your critical Change metrics in a single,
real-time, configurable, at-a-glance control panel. The Dashboard displays Change data, such as
the number of open Changes, the number linked to Incidents and Problems, the number of Changes
in each status of the workflow (example: Classify, Assess, Implement, Review), and the number of
Changes by category.
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• Reports: Run Reports to show up-to-date statistics on Change breakdowns, trends, CI Change
Request metrics, and more.

• Automation Processes: Use Automation Processes to automatically escalate Changes, send e-
mails, etc.
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Change Good to Know
• Search for one or more Changes that meet a specific criteria by running a Quick Search or Search

Group.

• Create a new Change by clicking New > New Change Request on the CSM Desktop Client toolbar
or File > New > New Change Request from the CSM Desktop Client menu bar.

• The Main Pane for Normal and Emergency Changes toggles between two embedded forms: a
simple Step View form and a detailed Expanded View form that displays all Change information in a
single form.

• View additional form information and helpful tips by clicking the INFO button located on the title
banner of the form.

• CSM implements several OOTB Actions/One-Steps to make Change Management more efficient.
For more information about Actions and One-Steps, refer to the Actions/One-Steps documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a
full list of One-Steps associated with a particular type of Business Object (example: Major).

• CSM provides several OOTB Automation Processes to automate Change Management. For more
information, see the Automation Process documentation.

• If enabled (via an Automation Process), e-mail notifications are automatically created and sent to
stakeholders. For example:

• A Customer to notify her of a status change.

• Team owners to notify them of ownership.

• The User owner to notify him of the ownership.

• Approvers when a Change requires approval.

• When on a record, you can send an e-mail directly to the current Customer (requestor) by clicking
File > E-mail Current Customer or by clicking the Customer's e-mail address in the Requestor
section of the Quick Info Tile. If sent using the File menu, the e-mail is blank. If sent using the Quick
Info Tile, an e-mail template is used to auto-populate the e-mail with information from the current
Change (example: Change ID, Customer's name, logging date/time details, etc.).

• Journals track what occurs during the record's lifecycle (example: Notes to track progress or
comments, and History to track important field changes, e-mail correspondence, etc.). View or add
Journals by clicking the Journal tab in the record's Arrangement.

• Attachments supplement records by providing additional details in the Form of linked/imported files
(.pdf, .doc, etc.), images, web pages, and Document Repositories. View and manage Attachments

using the Attachment button  and Attachments bar.

• The Quick Info Tile displays important at-a-glance information:
• The Type bar displays whether the Change is Standard, Normal, or an Emergency.

• The Status bar displays the current status of the Change as it moves through its workflow.

• The Priority bar displays the Change priority as either Low, Normal, High, or Urgent.
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• The Owned By section displays the current record owner (oneself, a User, or a Team).
Changes must be assigned to an owner, and can be assigned by clicking one of the ownership
links in the Quick Info Tile.

• The workflow bar (top of Main Pane) indicates the current phase of the Change as it moves through
its workflow. Dark gray indicates the current phase.

• Clicking Show All Tabs on the Quick Info Tile displays all Forms in the Arrangement area, whether or
not they hold information related to the Change. Clicking Show Related Tabs displays Forms with
information related to the Change.

• Fields:
• Many fields with drop-downs are driven by a Lookup Table and can be edited in the CSM

Desktop Client using Table Management. To see what table is providing the data, click inside
the field, and then press F3.

• Required fields are often conditional, meaning some are required to save a record, some are
required to change the status of a record, some are required to "close" the record, etc. You will
be reminded when fields are required, either by a red box around the field or by a reminder
message.

• The Description field is a Rich Text field so formatting and images/screenshots can be used to
complement the text. To format the text or embed an image, click the Zoom button .

• Some validated fields can recognize what you are typing and will suggest a value for you
(example: If you type "P" into the field, CSM will suggest the first item it finds that starts with
the letter P). Use the down arrow button to scroll through other possible values.

• Press TAB to move to the next field on the Form.

Note: A full list of Fields is beyond the scope of this document. Export a schema document
from CSM Administrator (Create a Blueprint > >Tools> > Export Schema) to view a full list of
fields associated with a particular type of Business Object (example: Major).

• Saving:

• Date, time, and user name information is recorded the first time the form is saved, and each
time the form is modified.

• Clicking Save  triggers an audit of fields that are being tracked for modification (example:
Status). If a modification is detected in a tracked field, a Journal-History record is created to
track the modification. View the modifications in the Journals tab (Arrangement area).
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Change Advisory Boards (CABs)
Normal and Emergency Change Requests require at least one Approval by a Change Advisory Board.
CSM uses two OOTB boards, including:

• Change Advisory Board: The Change Advisory Board (CAB) is a group of people that support the
assessment, prioritization, authorization and scheduling of Changes.

• Emergency Change Advisory Board: The Emergency Change Advisory Board (ECAB) is a subgroup
of the Change Advisory Board that makes decisions about Emergency Changes.

By default, Standard Changes do not require the approval of the CAB, but you can define an Approval
Process in CSM Administrator (Create a Blueprint>"Business Object">Edit Approvals), if necessary.

Tip: Use the Change Advisory Board Worksheet to organize information relating to CAB and
ECAB members. You will need this information when defining the approval boards.
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Creating a Change Advisory Board
Complete the following procedures to configure the CAB. Procedures are configured in the CSM Desktop
Client and in CSM Administrator.

To configure the CAB:

1. Complete the Change Advisory Board worksheet: Organize information relating to CAB members.

2. Define Change Advisory Board Members: Select CAB members and assign basic Approval rights.

Note: CSM provides three OOTB Approvals for Change, including Emergency Change
Implementation Requests, Normal Change Assessment Approval, and Normal Change
Implementation Approval. Add, edit, or delete Approvals for Change in CSM Administrator by
clicking Create a New Blueprint>Change Request>Edit Approvals.
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Change Advisory Board Worksheet
Use the Change Advisory Board worksheet to organize information relating to CAB members. A subset of
the CAB are members of the Emergency Change Advisory Board (ECAB), who approve Emergency
Change Requests.

Change Advisory Board

Table Selections Comments

CAB Member
Name:

 
Member names come from a UserInfo table that is set
up when identifying CSM Users.

Change Type

• Emergency

• Normal

• Standard

Defined using the Change Type Lookup Table in Table
Management.

 

 

Role

• Business Analyst

• Change Manager

• Developer

• End-User

• Financial Analyst

• Project Manager

• Project Team Member

• Sponsor

• Stakeholder

• Technical Analyst

• Tester

Defined using the CAB Role Lookup Table in Table
Management.

Approval Phase
• Assessment Phase

• Implementation Phase

By default, Standard Changes do not require an
Approval, but you can define an Approval Process in
CSM Administrator (Create a Blueprint>"Business
Object">Edit Approvals), if necessary.
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Define Change Advisory Board Members
Use the following procedure to define CAB members.

To define a CAB member:

1. On the CSM Desktop Client menu bar, click Tools>Table Management.

Note: By default, you must be a Service Desk Level 2 or higher to view Table Management.

2. Click the Type drop-down, and then select Standing CAB Member.

The Standing CAB Member grid opens.

3. Click the New button .

The Standing CAB Member form opens.

Note: The following fields are driven by a Lookup Table. If you have security rights, use Table
Management (Tools>Table Management) to add, edit, or delete field values.

a. Click the Change Type drop-down, and then select a Change type (ex: Normal).

b. Click the Member Name drop-down, and then select a User (ex: Andrew).

c. Click the Role drop-down, and then select a role for the User (ex: Change Manager).

d. Select the phase in which the User can vote:
◦ Assessment Phase

◦ Implementation Phase

Note: CSM provides three OOTB Approvals for Change, including Emergency Change
Implementation Requests, Normal Change Assessment Approval, and Normal Change
Implementation Approval. Add, edit, or delete Approvals for Change in CSM
Administrator by clicking Create a New Blueprint>Change Request>Edit Approvals.

4. Click Save .
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Change Workflow
CSM provides three workflows based on the different types of Change, including:

• Standard Change Request workflow:
• Log a Standard Change: Typical step-by-step instructions for logging a Standard Change.

• Log a Standard Change - Detailed: Detailed step-by-step instructions for logging a Standard
Change, including tips, optional steps, and behind-the-scenes information.

• Normal Change Request workflow:
• Log a Normal Change: Typical step-by-step instructions for logging a Normal Change.

• Log a Normal Change - Detailed: Detailed step-by-step instructions for logging a Normal
Change, including tips, optional steps, and behind-the-scenes information.

• Emergency Change Request workflow:
• Log an Emergency Change: Typical step-by-step instructions for logging an Emergency

Change.

• Log an Emergency Change - Detailed: Detailed step-by-step instructions for logging an
Emergency Change, including tips, optional steps, and behind-the-scenes information.
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Use the following figure to determine which type of Change workflow to follow.

202

CSM Record Management

CSM Record Management



Standard Change Workflow
CSM provides a unique OOTB workflow for Standard Changes.

Note: CSM uses several features to manage the Change workflow (ex: The Change form helps
create, manage, and track Changes, One-Steps help move the Change through its workflow,
Automation Processes notify stakeholders via e-mails, an Approval process enforces Approvals, a
Change Dashboard notifies stakeholders and tracks metrics, etc.).

Contributors

A Standard Change typically has several contributors. Depending on your workflow and the size of your
company, many of these contributors may have combined roles:

• Creator: User who first logs the Change. This is typically a technician.

• Requestor: User who requests the Change. This is typically an IT manager.

• Owner: User who manages the Change. This is typically a Change manager.
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Phases

The Standard Change workflow is divided into the following phases:

1. Classify: Creator logs a new Change, and then identifies the requestor. Creator classifies the
Change by defining the type, title, priority, and description. Creator assigns ownership.

2. Implement: Creator implements the Change by defining the template, approved item, proposed
start date, proposed end date, primary CI, Service, and Service importance. Creator closes the
Change.

Statuses

A Standard Change progressing through the workflow encounters the following statuses:

1. Classify: Change is created, a requestor is identified, the Change is classified, and ownership is
assigned.

2. Implementing: Change is implemented, and then closed.

3. Closed: Change is closed.

204

CSM Record Management

CSM Record Management



Log a Standard Change
The following procedure walks you through the typical steps to log a Standard Change.

To manually log a Standard Change:

1. On the CSM toolbar, click New > New Change Request.

A new Normal Change record is created with a unique Change ID.

2. Creator selects a Requestor (if different from the creator):
a. Requestor: Specify the name of the person who initiated the Change, and then press ENTER

or TAB to search for the Customer Record.

If an exact match is found, the Requestor fields are auto-populated with the Customer’s name,
avatar, e-mail, and phone number. If multiple matches are found, the Contact Manager opens
so that you can select the appropriate Customer.

3. Creator classifies the Change:
a. Change Type: In the drop-down, select Standard.

The Standard Change form opens.

Note: The Change automatically enters the Classify phase with a status of Classify.

b. Complete the Classify/Assess section:
i. Change Title: Specify a title for the Change.

ii. Priority: Click the Priority drop-down to reveal the Priority Matrix, and then select a
priority based on its impact and urgency.

The Priority alert bar indicates the priority.

iii. Description: Specify a description for the Change.

Tip: Description is a Rich Text field. To format the text or embed an image, click the
Zoom button .

4. Creator assigns an Owner to the Change by clicking one of the Ownership links in the Quick Info
Tile (Owned By and I Want To sections). Ownership is required:

◦ Take Ownership: Click this link to make yourself the User Owner.

◦ Assign to: Click this link to select a User Owner. The Team Owner is populated by the User
Owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User Owner (User is
limited by Team).

◦ Select Team: Click this link to first select a Team Owner.

5. Owner implements the Change:
a. In the Status bar, click the Next: Implement link.
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The status changes to Implementing and the Change enters the Implement phase.

b. Complete the Implement section:
i. Standard Change Template: From the drop-down, select a predefined template.

ii. Standard Change Approved Items: From the drop-down, select a predefined item
related to the Standard Change Template.

iii. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for
the Change.

iv. Proposed End Date: Click the Calendar Date Selector button  to select an end date for
the Change.

v. Planning:

◦ View Change Calendar: Click the View Change Calendar button to open the Change
Calendar.

Note: The View Change Calendar button displays when the Proposed Start Date and
Proposed End Date fields are populated.

◦ View Collision Detection: Click the View Collision Detection button to open a
Configuration Map of the Primary CI.

Note: The View Collision Detection button displays when the Primary CI field is
populated.

i. Primary CI: Click the CI Selector button  to launch the CMDB window, where you can
select a CI. You can show CIs for any Customer or for a selected Customer.

ii. Impact Analysis: Click the Impact Analysis button to display the Configuration Map of the
Primary CI.

iii. Service Affected: From the drop-down, select the affected Service.

Note: If a Stop icon  appears next to the Proposed Start Date and/or the Proposed
End Date, you are outside of the maintenance window, and you must select an
acceptable date.

iv. Service Importance: This field is auto-populated based on the Service Affected selection.
However, you can also type a custom Service Importance value.

v. Propose New Date: Click the Propose New Date button to clear the Proposed Start Date
field and Proposed End Date field in order to define new dates.

Note: The Propose New Date button displays when the Proposed Start Date and
Proposed End Date fields are populated.

vi. Create Normal Change Request: Click the Create Normal Change Request button to log
a new Normal Change from the Standard Change. The title, description, priority,
proposed start date, proposed end date, and review date auto-populate with data from
the Standard Change.
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6. Owner closes the Change.
a. In the Status bar, click the Next: Close link.

The status changes to Closed, the Form fields are locked as read-only, and the Change
cannot be reopened.
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Log a Standard Change - Detailed
The following procedure walks you through the typical steps to log a Standard Change, including tips,
optional steps, and behind-the-scenes information. The different contributors are noted in the procedure.

To manually log a Standard Change:

1. On the CSM toolbar, click New > New Change Request.

Tip: You can also click File > New > New Change Request from the CSM Desktop Client menu bar.

A new Normal Change record is created with a unique Change ID (example: 10920).

Tip: The Main Pane displays dynamic embedded forms as you move through the workflow. You can
toggle between a simple Step View form and a more detailed Expanded View form.

Note: When the Change is first saved, it appears on the Change Dashboard to notify Users
of its existence.

2. Creator selects a Requestor (if different from the person logging the request) in the Quick Info Tile.
a. Requestor: Specify the name (example: Amy) of the person who initiated the Change, and

then press ENTER or TAB to search for the Customer Record.

If an exact match is found, the Requestor fields are auto-populated with the Customer’s name,
avatar, e-mail, and phone number. If multiple matches are found (example: multiple Customers
named Amy), the Contact Manager opens so that you can select the appropriate Customer.

Tips: Wildcards (example: % or *) can be used when searching. If the Customer is a VIP, a

VIP icon  appears beside the name. To browse for a Customer or add a new Customer

Record, click the Customer Selector button  to launch the Contact Manager. To add an
alternate phone number or e-mail address, click the Alternate Contact Info link. To view the

selected Requestor's detailed Customer Record, click the Quick View button .

3. Creator classifies the Change:

Note: View additional form information and helpful tips by clicking the INFO button located
on the title banner of the form.

a. Change Type: Select Standard as the type of Change.

The Standard Change form opens.

The Change automatically enters the Classify phase with a status of Classify.

b. Complete the Classify/Assess section:
i. Change Title: Specify a title for the Change (example: Install Screen Capture Software).
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ii. Priority: Click the Priority drop-down to reveal the Priority Matrix, and then select a
priority based on its impact and urgency (example: Low for a support Service that only
affects one individual).

The Priority alert bar indicates the priority.

Note: Red indicates an Urgent priority, orange indicates a High priority, and green
indicates a Normal or Low priority. These values are set in the Change Priority table
(Tools>Table Management>Change Priority).

iii. Description: Specify a description for the Change (example: Install SnagIt screen
capture software for Curtis Parker).

Tip: Description is a Rich Text field. To format the text or embed an image, click the
Zoom button .

4. Creator assigns an Owner to the Change by clicking one of the Ownership links in the Quick Info
Tile (Owned By and I Want To sections). Ownership is required:

◦ Take Ownership: Click this link to make yourself the User Owner.

◦ Assign to: Click this link to select a User Owner. The Team Owner is populated by the User
Owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User Owner (User is
limited by Team).

◦ Select Team: Click this link to first select a Team Owner.

5. Owner implements the Change:
a. In the Status bar, click the Next: Implement link.

The status changes to Implementing and the Change enters the Implement phase.

b. Complete the Implement section:
i. Standard Change Template: From the drop-down, select a predefined template:

◦ Preapproved Hardware Install

◦ Preapproved Patch Install

◦ Preapproved Software Install

Tip: Add, edit, or delete Standard Change Template options using a Lookup Table in
Table Management (Tools>Table Management>Change - Standard Template).

i. Standard Change Approved Items: From the drop-down arrow, select a predefined item
related to the Standard Change Template.

Tip: Add, edit, or delete Standard Change Approved Items using a Lookup Table in Table
Management (Tools>Table Management>Change - Standard Approval).

ii. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for
the Change.
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iii. Proposed End Date: Click the Calendar Date Selector button  to select an end date for
the Change.

iv. Planning:

◦ View Change Calendar: Click the View Change Calendar button to open the Change
Calendar.

Note: The View Change Calendar button displays when the Proposed Start Date and
Proposed End Date fields are populated.

◦ View Collision Detection: Click the View Collision Detection button to open a
Configuration Map of the Primary CI.

Note: The View Collision Detection button displays when the Primary CI field is
populated.

i. Primary CI: Click the CI Selector button  to launch the CMDB window, where you can
select a CI (example: curtis-desk). You can show CIs for any Customer or for a selected
Customer.

The selected CI record appears on the Configuration Items tab (Form Arrangement).

Tip: View the selected CI record by clicking the Quick View button  or by clicking the
record on the Configuration Items tab (in the Arrangement area; if not displayed, click
Show All Tabs).

ii. Impact Analysis: Click the Impact Analysis button to display the Configuration Map of the
Primary CI.

iii. Service Affected: In the drop-down, select the affected Service (example: Employee
Support).

Note: If a Stop icon  appears next to the Proposed Start Date and/or the Proposed
End Date, you are outside of the maintenance window, and you must select an
acceptable date.

iv. Service Importance: This field is auto-populated based on the Service Affected selection
(example: Support). However, you can also type a custom Service Importance value.

v. Propose New Date: Click the Propose New Date button to clear the Proposed Start Date
field and Proposed End Date field in order to define new dates.

Note: The Propose New Date button displays when the Proposed Start Date and
Proposed End Date fields are populated.

vi. Create Normal Change Request: Click the Create Normal Change Request button to
create a new Normal Change from the Standard Change. The title, description, priority,
proposed start date, proposed end date, and review date auto-populate with data from
the Standard Change.

6. Owner closes the Change.
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Tip: Before closing the Change record, click the E-Mail Change Review button in the I Want To
section to define and send an e-mail (contains a link to a Change review in the Portal) to the
Customer (requestor).

a. In the Status bar, click the Next: Close link.

The status changes to Closed, the Form fields are locked as read-only, and the Change
cannot be reopened.
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Normal Change Workflow
CSM provides a unique OOTB workflow for Normal Changes.
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Note: CSM uses several features to manage the Change workflow (ex: The Change form helps
create, manage, and track Changes, One-Steps help move the Change through its workflow,
Automation Processes notify stakeholders via e-mails, an Approval process enforces Approvals, a
Change Dashboard notifies stakeholders and tracks metrics, etc.).

Contributors

A Change typically has several contributors. Depending on your workflow and the size of your company,
many of these contributors may have combined roles:

• Creator: User who first logs the Change. This is typically a technician.

• Requestor: User who requests the Change. This is typically an IT manager.

• Owner: User who manages the Change. This is typically a Change manager.

• Approver: User who ensures that the Change should be implemented. This is typically one or more
members of the CAB Team.

Phases

The Normal Change workflow is divided into the following phases:

1. Classify: Creator logs a new Change, and then identifies the requestor. Creator classifies and
schedules the Change by defining the type, title, description, reason, Service, priority, Service
importance, primary CI, start date, end date, review date. Creator assigns ownership.

2. Assess: Creator assesses the Change by defining the risk, risk impact, necessity, back out plan,
and feasibility. Owner submits the Change for assessment approval and the approver approves or
denies the Change.

3. Implement: If the Change is approved, the owner plans the implementation by defining the
implementation plan and acceptance criteria. Owner submits the Change for implementation
approval and the approver approves or denies the Change. Owner implements the Change by
defining the implementer's notes, start date, and end date. If necessary, Owner creates Tasks.

4. Review: Owner reviews that Change by defining the final disposition, actual start date, actual end
date, and review notes. If necessary, owner send a Change review questionnaire to the requestor.
Owner closes the Change.

Statuses

A Normal Change progressing through the workflow encounters the following statuses:

1. New: Change is created, a requestor is identified, the Change is classified and scheduled, and then
ownership is assigned.

2. Assessing: Change is assessed and submitted for assessment approval.

3. Approval: Change assessment is approved (If denied, status changes to Denied).
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4. Pre-Implement: Change implementation is planned. Change is submitted for implementation
approval.

5. Approving: Change implementation is approved (If denied, status changes to Denied).

6. Implementing: Change is implemented.

7. Review: Change is reviewed.

8. Closed: Change is closed.
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Log a Normal Change
The following procedure walks you through the typical steps to log a Normal Change.

To manually log a Normal Change:

1. On the CSM toolbar, click New>New Change Request.

A new Normal Change Record is created with a unique Change ID and a status of New. The
Change automatically enters the Classify phase.

2. Creator selects a Requestor (if different from the creator):
a. Requestor: Specify the name of the person who initiated the Change, and then press ENTER

or TAB to search for the Customer Record.

If an exact match is found, the Requestor fields are auto-populated with the Customer’s name,
avatar, e-mail, and phone number. If multiple matches are found, the Contact Manager opens
so that you can select the appropriate Customer.

3. Creator classifies and schedules the Change:
a. Change Type: Normal is selected by default.

b. Change Title: Specify a title for the Change.

c. Description: Specify a description of the Change.

Tip: Description is a Rich Text field. To format the text or embed an image, click the Zoom
button .

d. Reason: Select a reason for creating the Change.

e. Service Affected: From the drop-down, select the affected Service.

f. Priority: Click the Priority drop-down to reveal the Priority Matrix, and then click a priority
(Urgent, High, Normal, or Low).

The Priority alert bar indicates the priority.

g. Service Importance: This field is auto-populated based on the Service Affected selection.
However, you can also type a custom Service Importance value.

h. Primary CI: Click the CI Selector button  to launch the CMDB window, and then select a CI.
This shows CIs for any Customer or for a selected Customer.

The selected CI Record appears on the Configuration Items tab (Form Arrangement).

i. Impact Analysis: Click the Impact Analysis button to display the Configuration Map of the
Primary CI.

j. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for the
Change.
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k. Proposed End Date: Click the Calendar Date Selector button  to select an end date for the
Change.

Note: If a Stop icon  appears next to the Proposed Start Date and/or the Proposed End
Date, you are outside of the maintenance window, and you must select an acceptable date.
Click the Propose New Dates button to clear the Proposed Start Date Field and the Proposed
End Date Field, and then select different dates. Click the Create Emergency Change button to
create an Emergency Change from the Normal Change.

l. Review Date: The Field automatically populates based on the CI. You can also click the

Calendar Date Selector button  to select a different review date for the Change.

m. Planning:
◦ View Change Calendar: Click the View Change Calendar button to open the Change
Calendar.

Note: The View Change Calendar button displays when the Proposed Start Date and
Proposed End Date fields are populated.

◦ View Collision Detection: Click the View Collision Detection button to open a
Configuration Map of the Primary CI.

Note: The View Collision Detection button displays when the Primary CI field is
populated.

4. Creator assigns an Owner to the Change by clicking one of the Ownership links in the Quick Info
Tile (Owned By and I Want To sections). Ownership is required:

◦ Take Ownership: Click this link to make yourself the User Owner.

◦ Assign to: Click this link to select a User Owner. The Team Owner is populated by the User
Owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User Owner (User is
limited by Team).

◦ Select Team: Click this link to first select a Team Owner.

5. Owner assesses the Change:
a. In the Status bar, click the Next: Assess link.

The status changes to Assessing, and the Change enters the Assess phase.

b. Click Next.

The Assess/Approve page opens.

c. Complete the assessment:
i. Risk Impact: Select the Risk Impact check box for issues that might occur during the

implementation of the Change. Options include:
◦ Not During Normal Maintenance Window?

◦ Requires Service Outage?
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◦ Mission or Business Critical?

◦ Fast Track?

ii. Risk: Specify a description of any additional risks that might occur during the
implementation of the Change.

iii. Impact Assessment: Specify the impact assessment (consequences of the Change).

iv. Necessity Assessment: Specify the necessity assessment (based on urgency and how
long the change can be delayed).

v. Back Out Plan: Specify a back out plan or attach information that details what actions to
perform if the Change implementation does not work.

vi. Feasibility Assessment: Specify the feasibility assessment (viability of the Change).

6. Owner submits she Change for assessment approval:

Note: If the CAB is able to meet and approve the Change in person, click the Approve by
Show of Hands link in the I Want To section of the Quick Info Tile to bypass the typical
Approval processes. A Show of Hands Approval Form opens, which allows you to provide
approval notes, approve the Change, and return to the Change Form.

a. In the Status bar, click the Next: Submit for Approval button.

The status changes to Approval.

7. Approver approves the Change:
a. In the Approval grid, double-click an Approval Record.

The Approval Form opens. The Approver Name and Details Fields are auto-populated per the
defined Approval process rules.

b. (Optional) In the Comments Field, provide your feedback.

c. Click Approve.

The Approval Status icons indicate the number of pending Approvals and their status
(Pending, Approved, Denied, or Abstained).

The Change status changes to Pre-Implement and the Change enters the Implement phase.

8. Owner plans the implementation:

a. Click Next.

The Pre-Implement and Implement page opens.

b. Complete the Pre-Implement section:
i. Implementation Plan: Specify the implementation plan (process required to implement

the Change).

ii. Acceptance Criteria: Specify the acceptance criteria (functionality and quality
requirements).
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9. Owner submits the Change for implementation approval:
a. In the Status alert bar, click the Next: Submit for Approval link.

The Change status changes to Approving, and Change Record Fields prior to the
Implementation section are locked as read-only.

10. Approver approves the implementation of the Change:
a. In the Approval grid, double-click an Approval Record.

The Approval Form opens. The Approver Name and Details Fields are auto-populated per the
defined Approval Process rules.

b. (Optional) In the Comments Field, provide your feedback.

c. Click Approve.

The Approval status icons indicate the number of pending Approvals and their status (Pending,
Approved, Denied, or Abstained).

When the Change is approved, the Change status changes to Implementing.

11. Owner implements the Change:
a. Complete the Implement section:

i. Implementer's Notes: Specify details related to the implementation of the Change.

ii. Actual Start Date: Click the Calendar Date Selector button  to select the date that the
Change actually started.

iii. Actual End Date: Click the Calendar Date Selector button  to select the date that the
Change actually ended.

iv. Create a New Task: Click the Create a New Task button to create a new Task Record in
the Form Arrangement.

Note: All Tasks must be closed before the Change Record can be closed.

12. Owner reviews the Change:
a. In the Status bar, click the Next: Review link.

b. Click Next.

The Review page opens.

c. Complete the Review section:
i. Final Disposition: Click the drop-down, and then select the disposition.

ii. Proposed Start Date: This Field auto-populates with the date the Change was scheduled
to start.

iii. Proposed End Date: This Field auto-populates with the date the Change was scheduled
to end.
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iv. Actual Start Date: This Field auto-populates with the date the Change actually started.

Click the Calendar Date Selector button  to select a different start date for the Change.

v. Actual End Date: This Field auto-populates with the date the Change actually ended.

Click the Calendar Date Selector button  to select a different end date for the Change.

vi. Review Date: This Field auto-populates with the selected review date.

vii. E-mail Questionnaire: Click the E-mail Questionnaire button to define and send an e-
mail (contains a link to a Change review in the Portal) to the Customer (requestor).

Tip: You can also send a Change review to the Customer (requestor) at any time by
clicking the E-mail Change Review button in the I Want To section of the Quick Info Tile.

viii. Review Notes: Specify additional information related to implementation of the Change.

13. Owner closes the Change:
a. In the Status bar, click the Next: Close link.

The status changes to Closed and a read-only Expanded View displays in the Main Pane. After the
Change is closed, it cannot be reopened.
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Log a Normal Change - Detailed
The following procedure walks you through the typical steps to log a Normal Change, including tips,
optional steps, and behind-the-scenes information. The different contributors are noted in the procedure.

To manually log a Normal Change:

1. On the CSM toolbar, click New>New Change Request.

Tip: You can also click File>New>New Change Request from the CSM Desktop Client menu bar.

A new Normal Change record is created with a unique Change ID (example: 10890) and a status of
New. The Change automatically enters the Classify phase.

Tip: The Main Pane displays dynamic embedded forms as you move through the workflow. You can
toggle between a simple Step View form and a more detailed Expanded View form.

Note: When the Change is first saved, it appears on the Change Dashboard (All Open
Change Requests list) to notify Users of its existence.

2. Creator selects a Requestor (if different from the person logging the request) in the Quick Info Tile.
a. Requestor: Specify the name (example: Amy) of the person who initiated the Change, and

then press ENTER or TAB to search for the Customer Record.

If an exact match is found, the Requestor fields are auto-populated with the Customer’s name,
avatar, e-mail, and phone number. If multiple matches are found (example: multiple Customers
named Amy), the Contact Manager opens so that you can select the appropriate Customer.

Tips: Wildcards (example: % or *) can be used when searching. If the Customer is a VIP, a

VIP icon  appears beside the name. To browse for a Customer or add a new Customer

Record, click the Customer Selector button  to launch the Contact Manager. To add an
alternate phone number or e-mail address, click the Alternate Contact Info link. To view the

selected Requestor's detailed Customer Record, click the Quick View button .

3. Creator classifies and schedules the Change:

Tip: View additional form information and helpful tips by clicking the INFO button located on the title
banner of the form.

a. Change Type: Normal is selected by default.

b. Change Title: Specify a title for the Change (example: Install screen capture software).

c. Description: Specify a description of the Change (example: Install SnagIt screen capture
software for Curtis Parker).
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Tip: Description is a Rich Text field. To format the text or embed an image, click the Zoom
button .

d. Reason: Select a reason for creating the Change (example: Introduction or Removal of CI).

Tip: Add, edit, or delete Change Reason options using a Lookup Table in Table Management
(Tools>Table Management>Change Reason).

e. Service Affected: In the drop-down, select the affected Service (example: Employee Support).

f. Priority: Click the Priority drop-down to reveal the Priority Matrix, and then click a priority
(example: Low for an optional Service that only affects one individual).

The Priority alert bar indicates the priority.

Note: Red indicates an Urgent priority, orange indicates a High priority, and green indicates a
Normal or Low priority. These values are set in the Change Priority table (Tools>Table
Management>Change Priority).

g. Service Importance: This field is auto-populated based on the Service Affected selection
(example: Support). However, you can also type a custom Service Importance value.

h. Primary CI: Click the CI Selector button  to launch the CMDB window, and then select a CI
(example: curtis-desk). This shows CIs for any Customer or for a selected Customer.

The selected CI record appears on the Configuration Items tab (Arrangement area).

Tip: View the selected CI record by clicking the Quick View button  or by going to the
record in the Configuration Items tab (Form Arrangement), clicking View, and then selecting
Form View.

i. Impact Analysis: Click the Impact Analysis button to display the Configuration Map of the
Primary CI.

j. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for the
Change.

k. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for the
Change.

Note: If a Stop icon  appears next to the Proposed Start Date and/or the Proposed End
Date, you are outside of the maintenance window, and you must select an acceptable date.
Click the Propose New Dates button to clear the Proposed Start Date field and the Proposed
End Date field, and then select different dates. Click the Create Emergency Change button to
create an Emergency Change from the Normal Change.

l. Review Date: The field automatically populates based on the CI. You can also click the

Calendar Date Selector button  to select a different review date for the Change.

m. Planning:
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◦ View Change Calendar: Click the View Change Calendar button to open the Change
Calendar.

Note: The View Change Calendar button displays when the Proposed Start Date and
Proposed End Date fields are populated.

◦ View Collision Detection: Click the View Collision Detection button to open a
Configuration Map of the Primary CI.

Note: The View Collision Detection button displays when the Primary CI field is
populated.

Tip: Nominate the Normal Change to become a Standard Change by clicking the
Nominate for Standard Change link in the I Want To section of the Quick Info Tile. After
clicking the link, select a Standard Change Template for the Change. A new Normal
Change record is created and is auto-populated with the Requestor, Change Title,
Description, Service Affected, Priority, Service importance, and Primary CI.

4. Creator assigns an Owner to the Change by clicking one of the Ownership links in the Quick Info
Tile (Owned By and I Want To sections). Ownership is required:

◦ Take Ownership: Click this link to make yourself the User Owner.

◦ Assign to: Click this link to select a User Owner. The Team Owner is populated by the User
Owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User Owner (User is
limited by Team).

◦ Select Team: Click this link to first select a Team Owner.

5. Owner assesses the Change:
a. In the Status bar, click the Next: Assess link.

The Change status changes to Assessing and the Change enters the Assess phase.

b. Click Next.

The Assess/Approve page opens.

c. Complete the assessment:
i. Risk Impact: Select the Risk Impact check box for issues that might occur during the

implementation of the Change. Options include:
◦ Not During Normal Maintenance Window?

◦ Requires Service Outage?

◦ Mission or Business Critical?

◦ Fast Track?

ii. Risk: Specify a description of any additional risks that might occur during the
implementation of the Change.

iii. Impact Assessment: Specify the impact assessment (consequences of the Change).
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iv. Necessity Assessment: Specify the necessity assessment (based on urgency and how
long the change can be delayed).

v. Back Out Plan: Specify a back out plan or attach information that details what actions to
perform if the Change implementation does not work.

vi. Feasibility Assessment: Specify the feasibility assessment (viability of the Change).

6. Owner submits the Change for assessment approval:

Note: If the CAB is able to meet and approve the Change in person, click the Approve by
Show of Hands link in the I Want To section of the Quick Info Tile to bypass the typical
Approval processes. A Show of Hands Approval form opens, which allows you to provide
approval notes, approve the Change, and return to the Change form.

a. In the Status bar, click the Next: Submit for Approval button.

The Change status changes to Approval.

7. Approver approves the Change.
a. In the Approval grid, click an Approval Record.

The Approval form opens. The Approver Name and Details fields are auto-populated per the
defined Approval process rules.

b. (Optional) In the Comments field, provide your feedback.

c. Click Approve.

The Approval Status icons indicate the number of pending Approvals and their status
(Pending, Approved, Denied, or Abstained).

The Change status changes to Pre-Implement and the Change enters the Implement phase.

8. Owner plans the implementation:

a. Click Next.

The Pre-Implement and Implement page opens.

b. Complete the Pre-Implement section:
i. Implementation Plan: Specify the implementation plan (process required to implement

the Change).

ii. Acceptance Criteria: Specify the acceptance criteria (functionality and quality
requirements).

9. Owner submits the Change for implementation approval:
a. In the Status bar, click the Next: Submit for Approval link.

The Change status changes to Approving and Change record fields prior to the
Implementation section are locked as read-only.
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10. Approver approves the implementation of the Change:
a. In the Approval grid, click an Approval Record.

The Approval form opens. The Approver Name and Details fields are auto-populated per the
defined Approval process rules.

b. (Optional) In the Comments field, provide your feedback.

c. Click Approve.

The Approval Status icons indicate the number of pending Approvals and their status
(Pending, Approved, Denied, or Abstained).

When the Change is approved, the Change status changes to Implementing.

11. Owner implements the Change:
a. Complete the Implement section:

i. Implementer's Notes: Specify details related to implementation of the Change.

ii. Actual Start Date: Click the Calendar Date Selector button  to select the date that the
Change actually started.

iii. Actual End Date: Click the Calendar Date Selector button  to select the date that the
Change actually ended.

iv. Create a New Task: Click the Create a New Task button to create a new Task record in
the Form Arrangement.

Note: All Tasks must be closed before the Change record can be closed.

12. Owner reviews the Change:
a. In the Status bar, click the Next: Review link.

b. Click Next.

The Review page opens.

c. Complete the Review section:
i. Final Disposition: Click the drop-down, and then select the disposition (example:

Successful).

ii. Proposed Start Date: This field auto-populates with the date the Change was scheduled
to start.

iii. Proposed End Date: This field auto-populates with the date the Change was scheduled
to end.

iv. Actual Start Date: This field auto-populates with the date the Change actually started.

Click the Calendar Date Selector button  to select a different start date for the Change.

v. Actual End Date: This field auto-populates with the date the Change actually ended.

Click the Calendar Date Selector button  to select a different end date for the Change.

vi. Review Date: This field auto-populates with the selected review date.
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vii. E-Mail Questionnaire: Click the E-Mail Questionnaire button to define and send an e-
mail (contains a link to a Change review in the Portal) to the Customer (requestor).

Tip: You can also send a Change review to the Customer (requestor) at any time by
clicking the E-Mail Change Review button in the I Want To section of the Quick Info Tile.

viii. Review Notes: Specify additional information related to implementation of the Change.

13. Owner closes the Change:
a. In the Status bar, click the Next: Close link.

The status changes to Closed and a read-only Expanded View displays in the Main Pane.
After the Change is closed, it cannot be reopened.
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Emergency Change Workflow
CSM provides a unique OOTB workflow for Emergency Changes.
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Note: CSM uses several features to manage the Change workflow (ex: The Change form helps
create, manage, and track Changes, One-Steps help move the Change through its workflow,
Automation Processes notify stakeholders via e-mails, an Approval process enforces Approvals, a
Change Dashboard notifies stakeholders and tracks metrics, etc.).

Contributors

A Change typically has several contributors. Depending on your workflow and the size of your company,
many of these contributors may have combined roles:

• Creator: User who first logs the Change. This is typically a technician.

• Requestor: User who requests the Change. This is typically an IT manager.

• Owner: User who manages the Change. This is typically a Change manager.

• Approver: User who ensures that the Change should be implemented. This is typically one or more
members of the CAB Team.

Phases

The Emergency Change workflow is divided into the following phases:

1. Classify: Creator logs a new Change, and then identifies the requestor. Creator classifies and
schedules the Change by defining the type, title, description, reason, Service, priority, Service
importance, primary CI, start date, end date, review date. Creator assigns ownership.

2. Assess: Creator assesses the Change by defining the risk, risk impact, necessity, back out plan,
and feasibility.

3. Implement: Owner plans the implementation by defining the implementation plan and acceptance
criteria. Owner submits the Change for implementation approval and the approver approves or
denies the Change. Owner implements the Change by defining the implementer's notes, start date,
and end date. If necessary, Owner creates Tasks.

4. Review: Owner reviews that Change by defining the final disposition, actual start date, actual end
date, and review notes. If necessary, owner send a Change review questionnaire to the requestor.
Owner closes the Change.

Statuses

An Emergency Change progressing through the workflow encounters the following statuses:

1. Classify: Change is created, a requestor is identified, the Change is classified and scheduled, and
then ownership is assigned.

2. Assessing: Change is assessed.

3. Pre-Implement: Change implementation is planned. Change is submitted for implementation
approval.

4. Approving: Change implementation is approved (If denied, status changes to Denied).
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5. Implementing: Change is implemented.

6. Review: Change is reviewed.

7. Closed: Change is closed.
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Log an Emergency Change
The following procedure walks you through the typical steps to log an Emergency Change.

To manually log an Emergency Change:

1. On the CSM toolbar, clickNew > New Change Request .

A new Normal Change record is created with a unique Change ID.

2. Creator selects a Requestor (if different from the creator):
a. Requestor: Specify the name of the person who initiated the Change, and then press ENTER

or TAB to search for the Customer Record.

If an exact match is found, the Requestor fields are auto-populated with the Customer’s name,
avatar, e-mail, and phone number. If multiple matches are found, the Contact Manager opens
so that you can select the appropriate Customer.

3. Creator classifies and schedules the Change:
a. Change Type: Change Type: In the drop-down, select Emergency.

The Emergency Change form opens.

The Change automatically enters the Classify phase with a status of New.

b. Complete the Classify/Schedule section:
i. Change Title: Specify a title for the Change.

ii. Description: Specify a description of the Change.

Tip: Description is a Rich Text field. To format the text or embed an image, click the
Zoom button .

iii. Reason: Select a reason for creating the Change.

iv. Service Affected: From the drop-down, select the affected Service.

v. Priority: Click the Priority drop-down to reveal the Priority Matrix, and then click a
priority (Urgent, High, Normal, or Low).

The Priority alert bar indicates the priority.

vi. Service Importance: This field is auto-populated based on the Service Affected selection.
However, you can also type a custom Service Importance value.

vii. Primary CI: Click the CI Selector button  to launch the CMDB window, and then select
a CI. This shows CIs for any Customer or for a selected Customer.

viii. Impact Analysis: Click the Impact Analysis button to display the Configuration Map of the
Primary CI.
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ix. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for
the Change.

x. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for
the Change.

Note: If a Stop icon  appears next to the Proposed Start Date and/or the Proposed
End Date, you are outside of the maintenance window, and you must select an
acceptable date.

xi. Review Date: The field automatically populates based on the CI. You can also click the

Calendar Date Selector button  to select a different review date for the Change.

xii. Planning:
◦ View Change Calendar: Click the View Change Calendar button to open the
Change Calendar.

Note: The View Change Calendar button displays when the Proposed Start Date
and Proposed End Date fields are populated.

◦ View Collision Detection: Click the View Collision Detection button to open a
Configuration Map of the Primary CI.

Note: The View Collision Detection button displays when the Primary CI field is
populated.

4. Creator assigns an Owner to the Change by clicking one of the Ownership links in the Quick Info
Tile (Owned By and I Want To sections). Ownership is required:

◦ Take Ownership: Click this link to make yourself the User Owner.

◦ Assign to: Click this link to select a User Owner. The Team Owner is populated by the User
Owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User Owner (User is
limited by Team).

◦ Select Team: Click this link to first select a Team Owner.

5. Owner assesses the Change:
a. In the Status bar, click the Next: Assess link.

The Change status changes to Assessing and the Change enters the Assess phase.

b. Click Next.

The Assess/Approve page opens.

c. Complete the assessment:
i. Risk Impact: Check the Risk Impact check box for issues that might occur during the

implementation of the Change. Options include:
◦ Not During Normal Maintenance Window?

◦ Requires Service Outage?
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◦ Mission or Business Critical?

◦ Fast Track?

ii. Risk: Specify a description of any additional risks that might occur during the
implementation of the Change.

iii. Impact Assessment: Specify the impact assessment (consequences of the Change).

iv. Necessity Assessment: Specify the necessity assessment (based on urgency and how
long the change can be delayed).

v. Back Out Plan: Specify a back out plan or attach information that details what actions to
perform if the Change implementation does not work.

vi. Feasibility Assessment: Specify the feasibility assessment (viability of the Change).

6. Owner plans the implementation:
a. In the Status bar, click the Next: Pre-Implementation link.

The Change status changes to Pre-Implement and the Change enters the Implement phase.

b. Click Next.

The Pre-Implement and Implement page opens.

c. Complete the Pre-Implement section:
i. Implementation Plan: Specify the implementation plan (process required to implement

the Change).

ii. Acceptance Criteria: Specify the acceptance criteria (functionality and quality
requirements).

7. Owner submits the Change for implementation approval:

Note: If the CAB is able to meet and approve the Change in person, click the Approve by
Show of Hands link in the I Want To section of the Quick Info Tile to bypass the typical
Approval process. A Show of Hands Approval form opens, which allows you to provide
approval notes, approve the Change, and return to the Change form.

a. In the Status bar, click the Next: Submit for Approval link.

The Change status changes to Approval and Change fields prior to the Implementation section
are locked as read-only.

8. Approver approves the Change:
a. In the Approval grid, click an Approval Record.

The Approval form opens. The Approver Name and Details fields are auto-populated per the
defined Approval Process rules.

b. (Optional) In the Comments field, provide your feedback.

c. Click Approve.
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The Approval Status icons indicate the number of pending Approvals and their status
(Pending, Approved, Denied, or Abstained).

When the Change is approved, the Change status changes to Implementing.

9. Owner implements the Change:
a. Complete the Implement section:

i. Implementer's Notes: Specify details related to implementation of the Change.

ii. Actual Start Date: Click the Calendar Date Selector button  to select the date that the
Change actually started.

iii. Actual End Date: Click the Calendar Date Selector button  to select the date that the
Change actually ended.

iv. Create a New Task: Click the Create a New Task button to create a new Task record in
the Form Arrangement.

Note: All Tasks must be closed before the Change record can be closed.

10. Owner reviews the Change:
a. In the Status bar, click the Next: Review link.

The Change status changes to Review and the Change enters the Review phase.

b. Click Next.

The Review page opens.

i. Final Disposition: Click the drop-down, and then select the disposition.

ii. Proposed Start Date: This field auto-populates with the date the Change was scheduled
to start.

iii. Proposed End Date: This field auto-populates with the date the Change was scheduled
to end.

iv. Actual Start Date: This field auto-populates with the date the Change actually started.

Click the Calendar Date Selector button  to select a different start date for the Change.

v. Actual End Date: This field auto-populates with the date the Change actually ended.

Click the Calendar Date Selector button  to select a different end date for the Change.

vi. Review Date: This field auto-populates with the selected review date.

vii. E-Mail Questionnaire: Click the E-Mail Questionnaire button to define and send an e-mail
(contains a link to a Change review in the Portal) to the Customer (requestor).

Tip: You can also send a Change review to the Customer (requestor) at any time by
clicking the E-Mail Change Review button in the I Want To section of the Quick Info Tile.

viii. Review Notes: Specify additional information related to implementation of the Change.

11. Owner closes the Change:
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a. In the Status bar, click the Next: Close link.

The status changes to Closed and a read-only Expanded View displays in the Main Pane.
After the Change is closed, it cannot be reopened.
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Log an Emergency Change - Detailed
The following procedure walks you through the typical steps to log a Normal Change, including tips,
optional steps, and behind-the-scenes information. The different contributors are noted in the procedure.

To manually log an Emergency Change:

1. On the CSM toolbar, click New>New Change Request.

Tip: You can also click File>New>New Change Request from the CSM Desktop Client menu bar.

A new Normal Change record is created with a unique Change ID (example: 10890).

Tip: The Main Pane displays dynamic embedded forms as you move through the workflow. You can
toggle between a simple Step View form and a more detailed Expanded View form.

Note: When the Change is first saved, it appears on the Change Dashboard (All Open
Change Requests list) to notify Users of its existence.

2. Creator selects a Requestor (if different from the person logging the request) in the Quick Info Tile.
a. Requestor: Specify the name (example: Amy) of the person who initiated the Change, and

then press ENTER or TAB to search for the Customer Record.

If an exact match is found, the Requestor fields are auto-populated with the Customer’s name,
avatar, e-mail, and phone number. If multiple matches are found (example: multiple Customers
named Amy), the Contact Manager opens so that you can select the appropriate Customer.

Tips: Wildcards (example: % or *) can be used when searching. If the Customer is a VIP, a

VIP icon  appears beside the name. To browse for a Customer or add a new Customer

Record, click the Customer Selector button  to launch the Contact Manager. To add an
alternate phone number or e-mail address, click the Alternate Contact Info link. To view the

selected Requestor's detailed Customer Record, click the Quick View button .

3. Creator classifies and schedules the Change:

Tip: View additional form information and helpful tips by clicking the INFO button located on the title
banner of the form.

a. Change Type: Change Type: In the drop-down, select Emergency.

The Emergency Change form opens.

The Change automatically enters the Classify phase with a status of New.

b. Complete the Classify/Schedule section:
i. Change Title: Specify a title for the Change (example: Reboot E-Mail Server).
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ii. Description: Specify a description of the Change (example: Several employees cannot
access their e-mail. Standard fixes have not worked, so a reboot of the e-mail server is
required).

Tip: Description is a Rich Text field. To format the text or embed an image, click the
Zoom button .

iii. Reason: Select a reason for creating the Change (example: Incident/Problem
Resolution).

Tip: Add, edit, or delete Change Reason options using a Lookup Table in Table
Management (Tools>Table Management>Change Reason).

iv. Service Affected: In the drop-down, select the affected Service (example: E-Mail/
Calendaring).

v. Priority: Click the Priority drop-down to reveal the Priority Matrix, and then click a
priority (example: Urgent for a Mission-Critical Service that affects an entire department
or VIP).

The Priority alert bar indicates the priority.

vi. Service Importance: This field is auto-populated based on the Service Affected selection
(example: Mission-Critical). However, you can also provide a custom Service importance
value.

vii. Primary CI: Click the CI Selector button  to launch the CMDB window, and then select
a CI (example: Mail Server). This shows CIs for any Customer or for a selected
Customer.

viii. Impact Analysis: Click the Impact Analysis button to display the Configuration Map of the
Primary CI.

ix. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for
the Change.

x. Proposed Start Date: Click the Calendar Date Selector button  to select a start date for
the Change.

Note: If a Stop icon  appears next to the Proposed Start Date and/or the Proposed
End Date, you are outside of the maintenance window, and you must select an
acceptable date.

xi. Review Date: The field automatically populates based on the CI. You can also click the

Calendar Date Selector button  to select a different review date for the Change.

xii. Planning:
◦ View Change Calendar: Click the View Change Calendar button to open the
Change Calendar.

Note: The View Change Calendar button displays when the Proposed Start Date
and Proposed End Date fields are populated.
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◦ View Collision Detection: Click the View Collision Detection button to open a
Configuration Map of the Primary CI.

Note: The View Collision Detection button displays when the Primary CI field is
populated.

4. Creator assigns an Owner to the Change by clicking one of the Ownership links in the Quick Info
Tile (Owned By and I Want To sections). Ownership is required:

◦ Take Ownership: Click this link to make yourself the User Owner.

◦ Assign to: Click this link to select a User Owner. The Team Owner is populated by the User
Owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User Owner (User is
limited by Team).

◦ Select Team: Click this link to first select a Team Owner.

5. Owner assesses the Change:
a. In the Status bar, click the Next: Assess link.

The Change status changes to Assessing and the Change enters the Assess phase.

b. Click Next.

The Assess page opens.

c. Complete the assessment:
i. Risk Impact: Check the Risk Impact check box for issues that might occur during the

implementation of the Change. Options include:
◦ Not During Normal Maintenance Window?

◦ Requires Service Outage?

◦ Mission or Business Critical?

◦ Fast Track?

ii. Risk: Specify a description of any additional risks that might occur during the
implementation of the Change.

iii. Impact Assessment: Specify the impact assessment (consequences of the Change).

iv. Necessity Assessment: Specify the necessity assessment (based on urgency and how
long the change can be delayed).

v. Back Out Plan: Specify a back out plan or attach information that details what actions to
perform if the Change implementation does not work.

vi. Feasibility Assessment: Specify the feasibility assessment (viability of the Change).

6. Owner plans the implementation:
a. In the Status bar, click the Next: Pre-Implementation link.

The Change status changes to Pre-Implement and the Change enters the Implement phase.

b. Click Next.
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The Pre-Implement and Implement page opens.

c. Complete the Pre-Implement section:
i. Implementation Plan: Specify the implementation plan (process required to implement

the Change).

ii. Acceptance Criteria: Specify the acceptance criteria (functionality and quality
requirements).

7. Owner submits the Change for implementation approval:

Note: If the CAB is able to meet and approve the Change in person, click the Approve by
Show of Hands link in the I Want To section of the Quick Info Tile to bypass the typical
Approval process. A Show of Hands Approval form opens, which allows you to provide
approval notes, approve the Change, and return to the Change form.

a. In the Status bar, click the Next: Submit for Approval link.

The Change status changes to Approval and Change fields prior to the Implementation section
are locked as read-only.

8. Approver approves the Change:
a. In the Approval grid, click an Approval Record.

The Approval form opens. The Approver Name and Details fields are auto-populated per the
defined Approval process rules.

b. (Optional) In the Comments field, provide your feedback.

c. Click Approve.

The Approval Status icons indicate the number of pending Approvals and their status
(Pending, Approved, Denied, or Abstained).

When the Change is approved, the Change status changes to Implementing.

9. Owner implements the Change:
a. Complete the Implement section:

i. Implementer's Notes: Specify details related to implementation of the Change.

ii. Actual Start Date: Click the Calendar Date Selector button  to select the date that the
Change actually started.

iii. Actual End Date: Click the Calendar Date Selector button  to select the date that the
Change actually ended.

iv. Create a New Task: Click the Create a New Task button to create a new Task record in
the Form Arrangement.

Note: All Tasks must be closed before the Change record can be closed.

10. Owner reviews the Change:
a. In the Status bar, click the Next: Review link.
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The Change status changes to Review and the Change enters the Review phase.

b. Click Next.

The Review page opens.

i. Final Disposition: Click the drop-down, and then select the disposition (example:
Successful).

ii. Proposed Start Date: This field auto-populates with the date the Change was scheduled
to start.

iii. Proposed End Date: This field auto-populates with the date the Change was scheduled
to end.

iv. Actual Start Date: This field auto-populates with the date the Change actually started.

v. Actual End Date: This field auto-populates with the date the Change actually ended.

vi. Review Date: This field auto-populates with the selected review date.

vii. E-Mail Questionnaire: Click the E-Mail Questionnaire button to define and send an e-mail
(contains a link to a Change review in the Portal) to the Customer (requestor).

Tip: You can also send a Change review to the Customer (requestor) at any time by
clicking the E-Mail Change Review button in the I Want To section of the Quick Info Tile.

viii. Review Notes: Specify additional information related to implementation of the Change.

11. Owner closes the Change:
a. In the Status bar, click the Next: Close link.

The status changes to Closed and a read-only Expanded View displays in the Main Pane.
After the Change is closed, it cannot be reopened.
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Change Design Ideas
CSM provides an OOTB Change workflow with all the tools you need to successfully create and manage
a Change. You can use this workflow as-is, or tailor it to meet the needs of your organization. Design
ideas include:

• Fields: Change which Fields are required and when, which Fields support Rich Text, etc.

• Statuses: Modify Change statuses and/or the One-Steps that are initiated when a Change enters
each status.

• Form: Change the Form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Steps: Create Actions/One-Steps to automate your workflow (ex: Add another
Approval process), or implement any of the unused sample One-Steps that are shipped with CSM
(ex: Create and send out a Change Review questionnaire).

• E-mail: Change the templates that are used to create the e-mails sent by Automation Processes.
Or, disable/change when and to whom notifications are sent (ex: Notify Change owners by e-mail of
any status updates).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down Fields (ex: CAB Members).

• Approvals: Modify the Approval process rules (ex: The number or percentage of approvers needed
to approve a Change).

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.
Refer to the online help for this detailed information.
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Change Features
CSM provides the following tools to help manage Change:
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Change Form
Use the Change Form to create, edit, and track Changes. The Form has four areas:

1. A workflow bar tracks the Change as it progresses through the Change workflow phases:
◦ Standard Change: Classify, Implement.

◦ Normal Change: Classify, Assess, Implement, Review.

◦ Emergency: Classify, Assess Implement, Review.

2. The Quick Info Tile displays important at-a-glance information, such as Change ID, Change Type
(Standard, Normal, or Emergency), Status bar (current status), Priority alert bar, Requestor,
Ownership (Change Manager), and common operations (I Want To section).

3. The Main Pane displays dynamic embedded forms as you move through the workflow. Using Normal
and Emergency Changes, you can toggle between a simple Step View form and a detailed
Expanded View form.

4. The Arrangement dynamically displays linked records (child records) that are related to the Change
(parent record), such as Journals (to track notes and history), Problems, and Incidents. Additional
tabs related to the Change are displayed as information is recorded onto the Form.

The following table describes notable fields on the Form.

243

CSM Record Management

CSM Record Management



Field Description Comments

Quick Info
Tile

Important at-a-glance inFormation, such
as Change ID, Type alert bar, Status
alert bar, Priority alert bar, requestor
information, ownership, and common
operations (I Want To section).

 

Change Record type.
CSM automatically assigns the Record Type
based on type of record created
(New>Change Request).

ID
Unique record identifier (example:
10890).

CSM automatically assigns the ID when the
Change is created.

Type alert bar

Type of Change (Normal, Standard,
Emergency). The color green indicates
a Standard or Normal Change, and the
color red indicates an Emergency
Change.

CSM automatically displays the appropriate
Change form based on the type of Change.

Status alert
bar

Current status of the Change as it
progresses through the Change
workflow.

Change statuses do not always align with
Change phases.

Priority alert
bar

The color (red/orange/green) indicates
the level of priority.

Priority is defined using the Priority drop-
down (Priority Matrix) in the Classify section
of the Main Pane.

Requestor Person who initiates the Change.
CSM automatically assigns the Change
creator as the requestor, but a different
requestor can be selected.

Requestor
Name

Name of the Customer who initiated the
Change.

Provide a name in the Requestor field
(example: Clair), and then press
<Enter> or <Tab> to locate the
Customer Record.

Note: Wildcards like % or * can be used
with partial information. If an exact
match is found, the information auto-
populates the Requestor, Phone, and E-
mail fields. If multiple matches are found
(example: Multiple Customers named
Clair), the Contact Manager opens so
that the technician can select the
appropriate one.

After you select a Customer, the Photo,
Phone, and E-mail fields are auto-populated
with information from the Customer record.
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Field Description Comments

Avatar
Avatar (photo or image) of the Customer
who initiated the Change.

The Avatar, Phone, and E-mail fields are
auto-populated with information from the
requestor's Customer Record.

One-Step (Dial Customer Phone): Dials the
Customer's phone number.

One-Step (Follow-up E-mail): Creates a
follow-up e-mail to send the Customer
regarding a question or update about the
Change. Allows the User to edit the e-mail
before clicking Send. Attaches the e-mail to
the Change History record.

 

E-mail

E-mail address of the Customer who
initiated the Change.

Click the link to create an e-mail
addressed to the Customer (if e-mail is
configured).

Phone

Phone number of the Customer who
initiated the Change.

Click the link to dial the Customer (if
telephony is configured).

Owned By/
Change
Manager

Record owner.  

User Owner

-select owner-

Name of the User owner. Click the link
to first select a Team and then a User
owner (User is limited by Team).

Typically, the owner is the Reviewer and
a member of the Support Team.

One-Step (Assign to Individual):

Launches the Choose Team window, where
a User can choose an Owned By Team for
the record; then, launches the Choose User
window, where a User can choose a
Primary User from the already-selected
Team.

Team Owner

-select team-

Name of the owner Team. Click the link
to select a Team owner.

One-Step (Assign to Team):

Launches the Choose Team window, where
a User can choose an Owned By Team for
the record.

Assign to

Click the link to select a User owner for
the Change. The Team owner is auto-
populated by the selected User owner's
default Team.

One-Step (Assign to ANY Individual):

Launches the Choose Team window, where
a User can choose an Owned By Team for
the record; then, launches the Choose User
window, where a User can choose a
Primary User from the already-selected
Team.

Avatar
Photo/graphic associated with the User
owner (from User profile)

 

I Want To Common operations.  
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Field Description Comments

Take
Ownership

Click the link to make yourself (Current
User) the User owner for the Change.

One-Step (Take Ownership):

Makes the Current User the Primary User of
the record.

E-mail Change
Review

Click the link to define and send an e-
mail containing a link to the Review
Questionnaire.

One-Step (Create Change Review): Creates
a new Review Questionnaire (Supporting
Object) and creates an e-mail containing a
link to the review and record details
(Description, Scheduled End Date, Actual
End Date, etc.).

Main Pane
Displays detailed information about the
Change, such as title, description, etc.

Fields in the Main Pane vary based on the
type of Change.

Change Type
Type of Change. Click the drop-down
and select a Change type (Normal,
Standard, Emergency).

Different Change forms display based on
the type of Change.

Change Title Display name for the Change.  

Description Description of the Change.  

Primary CI CI affected by the Change.  

Proposed
Start Date

Expected start date. Click the Calendar

Date Selector button  to select a start
date for the Change.

 

Proposed End
Date

Expected end date. Click the Calendar

Date Selector button  to select an
end date for the Change.

 

Impact
Analysis

Displays a Configuration Map of the
primary CI. Click the button to open the
Configuration Map window.
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Change Tasks
A Task is a piece of work that is created and assigned to another CSM User or Team to help resolve/fulfill
an Incident/Service Request, Problem, or Change Request (example: An Incident might require a server
reboot). Tasks can also be used to successfully complete a Project or Release (example: A Project might
require a new switch). Use Tasks to distribute and track individual pieces of work assigned to Teams or
Users within the context of a Change.

The following OOTB Task types are available for Changes:

• Escalation: A Task assigned to a higher tier of support.

• Time Entry: A Task for tracking time against a parent object.

• Work Item: A Task for either immediate action or future completion.

The Task form defines and manages your Tasks. The Task form is a child record that is linked to and
available from its parent Change Form (access the Form by clicking the Tasks tab in the Form
Arrangement). The Task form that is accessed from a Change is an abbreviated form view.

To view the detailed Task form, click the Go to Record button, or search for the Task using a Quick Search
or Search Group.

Note: For detailed information about the Task form, refer to the Task form documentation.
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Change Journals
CSM provides the following OOTB Change Journal types:

• Journal - Note: Tracks User notes/comments. For example, a User might chronicle troubleshooting
progress.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt, follow-
up, resolution, and questions.

• Journal - Queue History: Tracks when records are added to/removed from a Queue.

Note: History Journals are automatically created by CSM. Note and Customer Request
Journals are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).

Note: For detailed information about Journal forms, refer to Journal forms.
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Change Dashboard
CSM provides a OOTB Change Dashboard that intuitively organizes your critical metrics into a single,
real-time, at-a-glance Change control panel.

Note: Change metrics are also found on other OOTB Dashboards (example: Global IT).

The following table describes the items on the Dashboard.

Item Description
Widget
Type

Widget Name Widget Uses:

All Open
Change
Requests

All open Changes.
Search
Results List

CDAll Open
Changes

All Open Changes
Search Group

My Change
Reviews

Number of approved
Changes owned by the
current User.

Search
Results List

CDAll Approved
Changes

My Approved
Changes Search
Group

Approved
Changes

All approved Changes. Text Gauge
CDTotal
Approved
Changes

Approved Changes
Search Group
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Item Description
Widget
Type

Widget Name Widget Uses:

Linked
Incidents or
Problems

Open Changes that have
either at least one linked
Incident or one linked
Problem.

Text Gauge
Changes with
Linked Incidents
or Problems

Active Changes with
Linked Incidents and
Problems Search
Group

Open Past
Scheduled
Close Date

Open Changes (Status does
not = Closed) that are open
past the time they are
scheduled to be closed
(Created Date Time is
greater than Scheduled End
Date.

Text Gauge
CDOpen
Changes Past
Request Date

All Open Past
Scheduled Close
Date Search Group

Changes
Outside
Window

Open Changes (Status does
not = Closed) that occur
outside of the maintenance
window (Not During
Maintenance Window =
True).

Text Gauge

CDOpen Change
Outside of
Maintenance
Window

Open Changes Not
During Maintenance
Window Search
Group

High Risk
Changes

Uncompleted Changes
(Status does not =
Complete) with a risk value
that is greater than/equal to
3.

Text Gauge
CDHigh Risk
Changes

High Risk Changes
Search Group

Change
Request Life
Cycle

Number of open Changes
based on status.

Pipeline
Chart

CDChange
Request Lifecycle

All Open Changes
Search Group

Open Change
Requests by
Type

Percentage of open
Changes based on type.

Doughnut
Chart

CDChanges by
Type

Change Requests
Search Group
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Change One-Steps
CSM provides multiple One-Steps associated with Changes, including:

One-Steps Description/Actions Associations Executed From

Status    

Alt Step from
Relationship Conditionally change the Change status

to next logical status (defined by the
Change Status values in Table
Management) and/or initiate the next
appropriate One-Step.

Change Request
Change Form:
<Status> link

Alt 2 Step from
Relationship

Next Step from
Relationship

Button Next Step

Conditionally changes the embedded
form to the next logical form (based on
Embedded Form) and/or initiates the next
appropriate One-Step.

Change Request
Change Form: Form
buttons

Form    

Ownership    

Assign to Anyone

Prompts the User to assign the record to
any CSM User (not limited by Team).
Uses Owned By ID and Owned By Team
fields.

Change Request
Change Form:
Assign To link

Assign Change
to Owner

Launches the Choose Team window,
where a User can choose an Owned By
Team for the record; then, launches the
Choose User window, where a User can
choose a Primary User from the already-
selected Team.

Change Request
Change Form:
Select Owner link

Assign Change
to Team

Launches the Choose Team window,
where a User can choose an Owned By
Team for the record.

Change Request
Change Form:
Select Team link

Take Ownership
of Change

Makes the Current User the Primary User
of the record.

Change Request
Change Form: Take
Ownership link (I
Want To section)

Other    

251

CSM Record Management

CSM Record Management



Create Change
Review

Creates a new Review Questionnaire
(Supporting Object) and creates an e-
mail containing a link to the review and
record details (Description, Scheduled
End Date, Actual End Date, etc.).

Change Request

Change Form: E-
Mail Change Review
link (I Want To
section)

Change Request
Actions toolbar item;
Create Change
Review option

Create New Task
Creates a new Task in the Change's Form
Arrangement.

Change Request
Change Form:
Create New Task link
(I Want To section)

Nominate for
Standard Change

Creates a new Normal Change Record. Change Request

Change Form:
Nominate for
Standard Change
link (I Want To
section)

Rework Change
Request

Changes the Change status to New so
that Users can edit fields and then
resubmit the Change for CAB Approval.

Change Request
Change Form:
Rework Change link
(I Want To section)

A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.
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Change Search Groups
CSM provides numerous OOTB Change Search Groups. Notable Change Search Groups include:

Search Group Returns Association Executed From

Active Changes with
Linked Incidents or
Problems

Open Changes that have either at
least one linked Incident or one
linked Problem.

Change Request
Search Manager,
Widgets

All Changes Waiting
Approval

Changes that have a status of
Waiting Approval.

Change Request Metrics

Change Requests
All Change Requests, regardless of
status.

Change Request
Search Manager,
Widgets

Emergency Change
Changes that are defined as
Emergency Changes.

Change Request
Search Manager,
Widgets, Change
Calendar

My Approved Changes
Changes approved by me (Current
User).

Change Request
Search Manager,
Widgets

My Open Change
Requests

Open Changes owned by me
(Current User).

Change Request
Search Manager,
Widgets

My Teams Open
Change Requests

Open Changes owned by one of my
(Current User) Teams.

Change Request
Search Manager,
Widgets

My Total Changes
Changes owned by me (Current
User).

Change Request
Search Manager,
Widgets

Normal Change
Changes that are defined as Normal
Changes.

Change Request
Search Manager,
Change Calendar

Standard Change
Changes that are defined as
Standard Changes.

Change Request
Search Manager,
Change Calendar
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Change Automation Processes
CSM provides the following OOTB Change Automation Processes:

Name Description

Notify Requestor of
Status Change

When the Status Field of a Change Request changes, the process initiates the
Send Status Change E-mail One-Step, which sends an e-mail notification of the
status change to the requestor of a Change Request.

Notify Change Team
of Assignment

When the Owned By Team Field of a Change Request changes, the process
initiates the Notify Owned By Team via E-mail One-Step, which sends a
notification e-mail to members of the Team that owns the Change Request.

Notify Change Owner
of Assignment

When the Owned By Field of a Change Request is changed, the process
initiates the Notify Owned By via E-mail One-Step, which sends a notification e-
mail to the new owner.

Change Approval
Notifications

When an Approval is added to a Change Request, the process initiates the
Send E-Mail One-Step, which sends a notification e-mail to members of the
CAB.

Change - Escalate 4
Hours after End Date

Waits four hours after the Scheduled End Date. If the time limit passes, the
process initiates the Escalate Change 4 Hours After End Date One-Step, which
sends an e-mail to the Change Request owner requesting that they update the
record.

Change - Notify
Problem Owner

Waits until a Change Request that is linked to a Problem is closed, then
initiates the Notify Problem Owner Change is Closed One-Step, which sends a
notification e-mail to the Problem owner.
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Change Reports
CSM provides the following OOTB Change Reports:

Report Description Association Search Group

Planned Changes
Lists Normal and Standard Changes within
a User-specified date range.

Change
Request

All Open
Changes

Post Implementation
Review

Lists Changes and their associated
Incidents and/or Problems.

Change
Request

Changes with
Linked Incidents
and Problems

Change Trends
Line chart shows the number of Changes
by the associated Service. Also lists
Change details.

Change
Request

Changes with
Linked CIs

Past Year Change
Trends

Line chart shows the number of Changes
within the past year by the associated
Service. Also lists Change details.

Change
Request

Date Range for
Report

Change Breakdown

Line chart shows the number of Changes
by the reason for the Change (ex: Incident
Resolution) within a User-specified date
range. Also lists Change details.

Change
Request

Date Range for
Report

Past Year Change
Breakdown

Bar chart shows the number of Changes by
the reason for the Change (ex: Incident
Resolution) within a User-specified date
range. Also lists Change details.

Change
Request

Date Range for
Report

CI Change Request
Metrics

Bar chart shows the top five CIs based on
the highest number of associated Change
Requests. Also lists Change details.

Change
Request

Changes with
Linked CIs

Proactive Service -
Changes

Lists Changes based on Service
Categorization within a User-specified date
range.

Change
Request

Date Range for
Report
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Knowledge Management
Knowledge management is the process that ensures that all Knowledge in your CSM Knowledge Base is
efficiently gathered, approved, stored, and shared with Users and Customers. In CSM, Knowledge is
stored mainly in Knowledge Articles (KAs) but can come from other Knowledge Sources as well, including
Business Object records, Attachments, and Web sources (example: Google or YouTube).

For more information, see:

• About Knowledge

• Knowledge Features and Capabilities

• Knowledge Article Good to Know

• About Knowledge Articles
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Release Management
Release management is the process that ensures that builds are created, tested, and deployed without
affecting the stability of existing Services.

Note: This feature is also available as a mergeable application (mApp).
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About Releases
A Release is the deployment of one or more Configuration Items (CIs) that are built, tested, and deployed
together. Releases involve extensive planning, building, and testing to ensure that existing Services are
not impacted by the deployment.

Example: A Change Request is logged to upgrade the SQL Server. A technician determines that a
Release is required to implement the defined Change. The Release Team (ex: Knowledge Manager,
Deployment Manager, Testing Manager) plans and tests the Release before deploying it to the
organization.

In CSM, a Release is a Major Business Object provided as a Mergeable Application, or mApp.

Note: For more information about mApps, including how to apply a mApp, refer to the mApp
documentation.

The default Release Form helps to create, manage, and track Releases:
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• The Main Pane displays dynamic embedded forms as you move through the workflow. You can
toggle between a simple Step View form and a more detailed read-only Expanded View form.

• The Quick Info Tile displays important at-a-glance information, such as Release ID, Status alert bar
(current status), Priority alert bar, Open Tasks alert bar, Requestor, Record Ownership, and
common operations (I Want To section). A workflow bar tracks the Release as it progresses through
the Release workflow phases:

• Plan

• Build

• Test

• Document

• Approve

• Deploy
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• Review

• The Arrangement dynamically displays linked records (child records) that are in a relationship with
the Release (parent record), such as Journals (to track notes, history, etc.), Change Requests,
Release CIs, Service Schedule, Release Team, Tasks/Milestones, Build Package, Release Test,
Approvals, and Deploy Package.
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Release Features and Capabilities
CSM Release Management has numerous features and capabilities:

• Searching: Quickly locate all Releases by running a Quick Search, or search for a particular
Release by refining the search criteria to a word/phrase, timeframe, Customer, etc. Use Search
Groups to save/run commonly-run Searches.

• Search Groups: Use Release Search Groups to quickly locate/filter Releases, or to automate
searching in Reports or on Dashboards.

• Security: Secure Releases by controlling who can view, create, and edit records.

• Business Object: Use the dedicated Release Business Object to track Releases; configure the
Business Object to capture/track only what you want.

• Form: Use the powerful Release Form to create, edit, and track Releases. The form provides a
Quick Info Tile to display important at-a-glance information (Release ID, current and next status,
Record Ownership, common operations (I Want To section), a workflow bar to visually track the
Release workflow phases, and an Arrangement area to dynamically display linked records (child
records) that are in a relationship with the Release (parent record).

• Workflow: Use the streamlined Release workflow to move Releases from Plan to Review.

• Creation Flexibility: Create Releases manually or through an automated process.

• Tasks: Use linked Tasks to distribute and track individual pieces of work assigned to Teams or
Users.

• Linked Records: Link child records to a parent Release Record to keep supporting information at
your fingertips and to ensure data relationships. Linked child records are visible in the Release's
Arrangement area.

• History and Revision Tracking: Use linked Journals to track important Status and field changes.

• Ownership: Assign each Release to a record owner to ensure accountability.

• Approval Process: Use the defined Release Approval processes to automate and regulate
approving/denying/abstaining Releases. The Release Approval process contains automatic
notifications and status tracking.

• Tasks: Use linked Tasks/Milestones to distribute and track individual pieces of work assigned to
Teams or Users (for example, Escalations, Time Entries, and Work Items).

• Customer Communication Tracking: Use linked Journals to track e-mail correspondence (ex:
Receipt, Follow-up, Resolved, and Closed).

• History and Revision Tracking: Use linked Journals to track important status and field changes.

• Queue Tracking: Use linked Journals to track when records are added to/removed from a Queue.

• Actions/One-Steps: Use powerful Actions and One-Steps to move Releases through their
workflow, initiate common operations (ex: Assign Ownership), initiate scenario-specific Actions, run
Reports, etc. Actions/One-Steps are available on the Release Form (ex: CSM Desktop Client Task
Pane).

• Automation Processes: Use Automation Processes to automatically send notification e-mails.
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Release Good to Know
• Search for one or more Releases that meet a specific criteria by running a Quick Search or Search

Group.

• Since a Release can be the implementation of one or more Change Requests, a Release can also
be created from a Change Request by clicking File>New>New Release from the CSM menu bar,
pressing CTRL+SHIFT+R, or clicking the Create New Release link in the Change Request Actions
section of the Task Pane. When submitted from a Change Request, the Release inherits specific
record information, including Requestor, Title, Description, and associated CIs.

• The Release form's Main pane toggles between two embedded forms: a simple Step View form and
a read-only Expanded View form that displays all Release information on a single form.

• View additional form information and helpful tips by clicking the INFO button located on the title
banner of the form.

• CSM implements several default Actions/One-Steps to make Release Management more efficient.
For detailed information about Actions and One-Steps, refer to the Actions/One-Steps
documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• CSM provides several default Automation Processes to automate Release Management. For more
information, refer to the Automation Process documentation.

• If enabled (via an Automation Process), e-mail notifications are automatically created and sent to:
• Release owner to notify him of assignment.

• Release Team to notify them of ownership.

• Release Team to notify them of a new build.

• Release Team to notify them of build test results.

• Journals track what occurs during the record's lifecycle (ex: Notes to track progress or comments;
and History to track important field changes, e-mail correspondence, etc.). View or add Journals by
clicking the Journal tab in the record's Arrangement.

• Attachments supplement records by providing additional details in the form of linked/imported files
(.pdf, .doc, etc.), images, web pages, and Document Repositories. View and manage Attachments

using the Attachment button  and Attachments bar.

• The Quick Info Tile displays important at-a-glance information, such as Release ID, Status alert bar
(current status), Priority alert bar, Open Tasks alert bar, Requestor information, Record Ownership,
and common operations (I Want To section).

• The workflow bar tracks the Release as it progresses through the Release workflow phases. Dark
gray indicates the current phase.

• The Main Pane displays embedded forms used to create the Release. The Main Pane toggles
between two embedded forms: a simple Step View form and a more detailed Expanded View form
(read-only).
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• The Arrangement dynamically displays linked child records, such as Journals (to track comments
and important field and status changes), Approvals (to track who approved the Release and when),
and forms that display as the Release progresses through its workflow.

• Fields:
• Required fields are often conditional, meaning some are required to save a record, some are

required to change the status of a record, some are required to "close" the record, etc. You will
be reminded when fields are required, either by a red box around the field or by a reminder
message.

• Use Rich Text fields to use formatting and image/screenshots to complement the text. To
format the text or embed an image, click the Zoom button .

• Some validated fields can recognize what you are typing and will suggest a value for you (ex:
Type "P" into the field; CSM will suggest the first item it finds that starts with the letter P). Use
your Down Arrow button to scroll through other possible values.

• Press F3 to open a Selector window, where you can select a legal value or create a new value.

• Press TAB to move to the "next" field on the form.

Note: A full list of Fields is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view
a full list of fields associated with a particular type of Business Object (ex: Major).
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Release Workflow
The following figure shows a high-level Release process workflow in the default system.
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Note: CSM uses several features to manage the Release workflow (ex: The Release Form helps
create and manage Releases, One-Steps help move the Release through its workflow, Automation
Processes notify stakeholders via e-mails).

Contributors

A Release typically has several contributors. Depending on your workflow and the size of your company,
many of these contributors might be combined into one person:

• Requestor: Person who initiates the Release. This is typically a technician or owner of the
associated Change Request.

• Creator: User who first creates the Release. This is typically a technician.

• Owner/Release Manager: User who manages the Release. This is typically a technician; the level
varies depending on tiered support.

• Task Owner: User to whom Tasks are assigned in order to help deploy the Release.

• Testing Manager: User who manages the Test phase of the Release.

• Documentation Manager: User who creates the Release Notes or other documentation for the
Release and communicates the information to the Knowledge Manager and Training Manager.

• Knowledge Manager: User who communicates release note data to the Knowledge Team.

• Training Manager: User who communicates release note data and incorporates the new
information into training materials.

• Approver: User who ensures that the Release is ready for deployment. This is typically a member
of the Knowledge Team.

• Deployment Manager: User who manages the deployment of the Release.

• Stakeholder: User/Customer with an interest in the outcome of the Release.

Phases

The Release workflow is broken down into the following phases:

1. Plan: Creator records the Requestor and initial details, and then assigns an owner. Owner defines
the Release Package, Service Schedule, and Release Plans. Owner adds members to the Release
Team, and then assigns Tasks to Release Team members.

2. Build: Owner creates one or more builds of the Release Package.

3. Test: Test Manager tests the Release build(s) in a test environment that duplicates the live
environment.

4. Document: Documentation Manager creates Release Notes, and then the owner requests
approval.

5. Approve: Approver makes a decision (approves, denies, abstains) regarding the deployment of the
Release build(s) to the live environment.

6. Deploy: Deployment Manager deploys the Release to the live environment.
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7. Review: Owner records the final details, and then closes the Release.

Statuses

A Release progressing through the workflow encounters the following statuses:

Note: Release statuses do not align with Release phases.

1. New: Release is being created, recorded (initial details), and assigned to an owner.

2. Planning: Release Package, Service Schedule, and Release Plan are being planned. Release
team is assigned. Tasks are assigned.

3. Building: Release build is being defined.

4. Testing: Release build is being tested.

5. Documenting: Release Notes are being defined.

6. Approving: Release is being approved.

7. Deploying: Release is being deployed.

8. Reviewing: Release is being reviewed.

9. Cancelled: Release is cancelled.

10. Closed: Release is closed.
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Creating Releases
The following instructions are available to walk you through the steps to create a new Release using our
default workflow:

• Create a Release: Typical step-by-step instructions for creating a Release.
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Create a Release
The following procedure walks you through the typical steps to create a Release.

To create a Release:

1. On the CSM Desktop Client toolbar, click New>New Release.

The Release Record is created with a unique ID and a status of New. The Release enters the Plan
phase.

2. The creator records the initial details.
a. Requestor (in the Quick Info Tile): Provide the name of the person who initiated the Release,

and then press ENTER or TAB to search for the User Record.

b. Title: Provide a title.

c. Priority: Select a priority for the Release.
i. Select the Priority drop-down to reveal the Priority Matrix, and then click a priority

number.

The priority is displayed in the Priority alert bar of the Quick Info Tile. The color (red/orange/
green) indicates the level of priority.
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d. Risk: Select a risk level from the drop-down.

e. Category: Select a category from the drop-down.

f. Type: Select a type of deployment.

g. Version: Provide the version of the Release.

h. Primary CI: Select an affected CI:

i. Click the CI Selector button  to launch the CMDB window and select a CI.

The CI record appears in the Configuration Items tab (Arrangement area).

i. Impact Analysis: Click this button to view a Configuration Map of CIs that are affected by
the Release.

i. Planned Start: Click the Date Selector button  to access the Calendar, and then select the
day in which you plan to begin the Release process.

j. Planned End: Click the Date Selector button to access the Calendar, and then select the day
in which you plan to deploy the Release.

k. Release Calendar: Click this button to open the Change/Release Calendar.

l. Due Date: Click the Date Selector button to access the Calendar, and then select the day in
which the Release is due.

m. Description: Provide a description of the Release.

n. Scope: Select a scope for the Release.

o. Justification for Release and any associated risks: In the drop-down a justification and any
risks that may occur during the Release process.

3. Creator assigns an Owner.
a. Click one of the Ownership Links in the Quick Info Tile (Owned By/Release Manager section).

Ownership is required:
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4. Owner builds the Release Package.
a. Click the Define Package button on the Release Details form.

The Release Units form opens and the Release status changes to Planning.

b. Define the Release Package.
i. Select Release Package units (components of the package) by selecting the

corresponding check box.

c. Owner adds additional affected CIs.
i. Click the Release CIs tab in the Arrangement to open the CI grid.
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ii. Click the Add a Configuration Item button  to launch the CMDB window, where you
can select a CI.

The selected CI record appears in the Configuration Items tab.

iii. View Impacted CIs: Click the Visualization button  to view affected CIs.

iv. Hyperlinks to Build Documentation: Insert a hyperlink (Rich Text) to the documentation
associated with the build, if applicable.

d. Owner adds the Release to the Service Schedule.
i. Click the Schedule Service button on the Release Units form.

The Service Schedule form opens in the Main Pane.

ii. Service: In the drop-down, select the affected Service.

iii. Start Date: Click the Date Selector button  to access the Calendar, and then select the
first day in which the Service will be affected.

iv. End Date: Click the Date Selector button  to access the Calendar, and then select the
last day in which the Service will be affected.

v. Type: Select the type of disruption the Release will have on the Service.

vi. Notes: Provide any additional information about the Service Schedule.

e. Owner defines a Release Plan.
i. Click the Create Release Plans button on the Service Schedule form.

The Release Plans form opens in the Main Pane.
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ii. Deployment Plan: Provide the deployment plan.

iii. Backout Plan: Provide a backout plan.

f. Owner defines a Release Team.
i. Click the Assign Release Team button on the Release Plans form.

The Release Team form opens in the Main Pane and the Release Team tab appears in
the Arrangement.

ii. Click the New Release Team button in the Release Team tab of the Arrangement.

The Release Team Member form opens.

iii. Send Notification E-mails: Select the check box to indicate that the User should receive
Release updates via e-mail.

iv. Name: Provide the name of a User.

v. Role: In the drop-down, select the role of the User.

vi. E-mail: Provide the e-mail address of the User.

vii. Phone Number: Provide the phone number of the User.

viii. Notes: Provide any additional information about the User.

g. Owner assigns Tasks to Release Team members.
i. Click the Assign Tasks button on the Release Team form.

The Assign Tasks/Set Milestones form opens in the Main Pane and the Tasks/Milestones
tab opens in the Arrangement.
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ii. Click the New Task button in the Tasks/Milestones tab of the Arrangement.

The Task form opens in the Arrangement.

iii. Complete a Task form for each Task.

The priority is displayed in the Priority alert bar of the Quick Info Tile. The color (red/
orange) indicates whether or not there are open Tasks. If there are no open Tasks, the
alert bar is green. If there are one to five open Tasks, the alert bar is orange. If there are
more than five open Tasks, the alert bar is red.

5. Owner defines the Release Package build.
a. Click the Build Package(s) button on the Assign Tasks/Set Milestones form.

The Build Package(s) form opens in the Main Pane, the Build Package tab appears in the
Arrangement, and the Release enters the Build phase.
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b. Click the New Release Package Build button in the Build Package tab of the Arrangement.

The Build Release Package form opens in the Arrangement.

c. Short Description: Provide a brief description of the build.

d. Build Version: Provide the version of the build.

e. Build Location: Provide the location of the build.

f. Destination: Provide the location where the build will be stored.

6. Testing Manager tests deployment of the build.
a. Click the Create/Run Test Plans button on the Build Package(s) form.

The Test Script(s) form opens in the Main Pane, the Release Test tab appears in the
Arrangement, the Release status changes to Testing, and the Release enters the Test phase.
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b. Click the New Release Test button in the Release Test tab of the Arrangement.

The Release Test form opens in the Arrangement.

c. Test Title: Provide a title for the test.

d. Build Version: Select a build version from the drop-down.

e. Release Location: Provide the location of the test Release.

f. Test Script: Provide the test script.

g. Expected Results: Provide the expected result of the test.

h. Tester: Provide the name of the tester.

i. Test Status: Select the status of the test.

j. Test Start Date Time: Click the Date Selector button to access the Calendar, and then select
the day in which you begin the test.

k. Test End Date Time: Click the Date Selector button to access the Calendar, and then select
the day in which you end the test.
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l. Test Disposition: Select the disposition (outcome) of the test.

CSM automatically sends an e-mail to Release Team members to notify them of the test
outcome.

m. Actual Results: Provide the result of the test.

The Testing Status icons indicate the number of Test Events and their status (Passed, Failed,
Not Run).

Note: If the build fails testing, click the Create New Build link in the Quick Info Tile to return to
the Build phase, or click the Cancel Release link to move to the Review phase.

7. Documentation Manager creates Release Notes.
a. Click the Create Release Notes button on the Test Script(s) form.

The Release Notes form opens in the Main Pane, the Release status changes to
Documenting, and the Release enters the Document phase.

277

CSM Record Management

CSM Record Management



b. Author: Provide the name of the author.

c. Release Notes: Provide the Release Notes.

8. Owner requests approval for the Release.
a. Click the Obtain Approval button on the Release Notes form.

The Release Approval form opens in the Main Pane, the Approvals tab appears in the
Arrangement, and the Release enters the Approve phase.

278

CSM Record Management

CSM Record Management



9. Approver approves the Release.
a. In the Approval grid, click an Approval Record to open the form.

b. (Optional) In the Comments field, provide your feedback.

c. Click Approve.

The Approval Status icons indicate the number of pending Approvals and their status
(Approved, Denied, or Abstained).
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10. Deployment Manager deploys the Release.
a. Click the Deploy Package(s) button on the Release Approval form.

The Deployment(s) form opens in the Main Pane, the Deploy Release Package tab opens in
the Arrangement, and the Release enters the Deploy phase.

b. In the Deploy Package grid, click a Release Package record. The Build Version and Short
Description fields are autopopulated.

c. Deployment Started: Click the Date Selector button to access the Calendar, and then select
the day in which you start the deployment before updating the time.

d. Deployment Finished: Click the Date Selector button to access the Calendar, and then select
the day in which you end the deployment before updating the time.

e. Disposition: Select the disposition (outcome) of the deployment.

The Deployment Status icons indicate the number of pending deployments and their status
(succeeded, failed, cancelled).

f. Details: Provide any additional information about the deployment.

11. Owner completes the final details reviews the Release.
a. Click the Review Release button on the Deployment(s) form.

The Release Details form opens in the Main Pane and the Release enters the Review phase.
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b. Actual Start Date: Click the Date Selector button to access the Calendar, and then select the
date and time in which you actually started the Release process.

c. Click the Date Selector button to access the Calendar, and then select the date and time in
which you actually ended the Release process.

d. Final Disposition: Select the disposition (outcome) of the Release.

e. Review Notes/Lessons Learned: Provide any additional information about the Release.

12. Owner closes the Release.
a. Click the Close Release button on the Release Details form.

The Release status changes to Closed.
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Release Design Ideas
CSM provides a default Release workflow with all the items you need to successfully create Releases.
You can use this workflow, or tailor it to meet the needs of your organization. Design ideas include:

• Fields: Change which fields are required and when, which fields support Rich Text, etc.

• Statuses: Change Release statuses and/or the One-Steps that are initiated when a Release enters
each status.

• Form: Change the form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority and risk.

• Actions and One-Steps: Create Actions/One-Steps to automate your workflow (ex: Add a button
that Tweets the final disposition of the Release).

• E-mail: Change the templates that are used to create the e-mails sent by Automation Processes
(ex: Notify Release Team of New Build). The e-mail templates are defined as part of the One-Step.
Or, disable/change when and to whom notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that send notification e-mails
(ex: Notify Release Team of New Build).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down fields (ex: Role).
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Release Features
CSM provides the following tools to help manage Releases:
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Release Form
Use the Release Form to create, edit, and track Releases. The form is made up of four main areas:

• Quick Info Tile: Displays important at-a-glance information, such as Release ID, Status alert bar
(current status), Priority alert bar, Open Tasks alert bar, Requestor information, Record Ownership,
and common operations (I Want To section).

• Workflow Bar: Tracks the Release as it progresses through the Release workflow phases. Dark gray
indicates the current phase.

• Main Pane: Displays embedded forms used to create the Release. The Main Pane toggles between
two embedded forms: a simple Step View form and a more detailed Expanded View form (read-
only).

• Arrangement: Dynamically displays linked child records, such as Journals (to track comments and
important field and status changes), Approvals (to track who approved the Release and when), and
forms that display as the Release progresses through its workflow.
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The following table describes important fields on the form:

Field Description Comments

Quick Info
Tile

Important at-a-glance information, such as Release ID,
Status alert bar, Priority alert bar, Open Tasks alert bar,
Requestor information, Record Ownership, and common
operations (I Want To section).

 

Release Record type.

CSM automatically assigns
the Record Type based on
type of record created
(New>Release).

ID Unique record identifier (ex: 10405).
CSM automatically assigns
the ID when the Release is
created.

Status alert
bar

Current status of the Release as it progresses through
the Release workflow.

Release statuses align with
Release phases, but this is
not the case in every
process (ex: Incident phases
are different than Incident
statuses).

Status

Statuses include:

• New: Release is being created, recorded (initial
details), and assigned to an owner.

• Planning: Release Package, Service Schedule,
and Release Plan are being planned. Release
team is assigned. Tasks are assigned.

• Building: Release build is being defined.

• Testing: Release build is being tested.

• Documenting: Release Notes are being defined.

• Approving: Release is being approved.

• Deploying: Release is being deployed.

• Reviewing: Release is being reviewed.

• Cancelled: Release is cancelled.

• Closed: Release is closed.

 

Priority alert
bar

The color (red/orange/green) indicates the level of
priority.

Priority is defined using the
Priority drop-down (Priority
Matrix) in the Release
Details section of the Main
Pane.
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Field Description Comments

Open Tasks
alert bar

The color (red/orange/green) indicates whether or not
there are open Tasks.

Tasks are assigned using
the Task form in the
Arrangement.

Requestor Person who initiates the Release.  

Requestor
Name

Name of the Customer who initiated the Release.

Provide a name in the Requestor field (ex: Gina), and
then press <Enter> or <Tab> to locate the Customer
Record.

Note: Wildcards like % or * can be used with partial
information. If an exact match is found, the information
autopopulates the Requestor, Phone, and E-mail fields. If
multiple matches are found (ex: Multiple Customers
named Gina), the Contact Manager opens so that the
technician can select the appropriate one.

After you select a Customer,
the Photo, Phone, and E-
mail fields are autopopulated
with information from the
Customer Record.

Avatar
Avatar (photo or image) of the Customer who initiated the
Release.

The Avatar, Phone, and E-
mail fields are autopopulated
with information from the
Requestor's Customer
Record.

One-Step (Dial Customer
Phone): Dials the
Customer's phone number.

One-Step (Follow-up E-
mail): Creates a follow-up e-
mail to send the Customer
regarding a question or
update about the Release.
Allows the User to edit the e-
mail before clicking Send.
Attaches the e-mail to the
Release History record.

E-mail

E-mail address of the Customer who initiated the
Release.

Click the link to create an e-mail addressed to the
Customer (if e-mail is configured).
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Field Description Comments

Phone

Phone number of the Customer who initiated the
Release.

Click the link to dial the Customer if telephony is
configured.

Owned By/
Release
Manager

Record owner.

Assign to
Click the link to select a User owner for the Release. The
Team owner is populated by the selected User owner's
default Team.

One-Step (Assign to ANY
Individual): Prompts the
User to assign the record to
any CSM User (not limited
by Team). Uses Owned By
ID and Owned By Team
fields.

User Owner

-select
owner-

Name of the User owner. Click the link to first select a
Team and then a User owner (User is limited by Team).

Typically, the owner is the Reviewer and a member of the
Support Team.

One-Step (Assign to
Individual):

Launches the Choose Team
window, where a User can
choose an Owned By Team
for the record; then,
launches the Choose User
window, where a User can
choose a Primary User from
the already-selected Team.

Team Owner

-select team-

Name of the owner Team. Click the link to select a Team
owner.

One-Step (Assign to Team):

Launches the Choose Team
window, where a User can
choose an Owned By Team
for the record.

Avatar
Photo/graphic associated with the User owner (from User
profile).

 

I Want To Common operations.  

Take
Ownership

Click the link to make yourself (Current User) the User
owner for the Release.

One-Step (Take Ownership):

Makes the Current User the
Primary User of the record.
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Field Description Comments

Notify Task
Owners to
Update
Tasks

Click the link to define and send an e-mail all Release
Team members.

Note: Team members must have a selected Send
Notification E-mail check box.

One-Step (E-mail Release
Team): Prompts the User to
define and send an e-mail to
all Project members that are
selected to receive
notification e-mails (Send
Notification E-mail
checkbox).

View
Detailed
Date/Time
Information

Click the link to open the Information window, where you
can view created date and time, creator name, and last
edited date and time. Time Date/time format is MM/DD/
YYYY HH:MM.

One-Step (Date Time Info
Popup): Displays details for
all the date/timestamps to
give a historical view.
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Release Tasks
A Task is a piece of work that is created and assigned to another CSM User or Team to help resolve/fulfill
an Incident/Service Request, Problem, or Change Request (example: An Incident might require a server
reboot). Tasks can also be used to successfully complete a Project or Release (example: A Project might
require a new switch). Use Tasks to distribute and track individual pieces of work assigned to Teams or
Users within the context of a Release.

The following OOTB Tasks are available for Releases:

• Escalation: A Task assigned to a higher tier of support.

• Time Entry: A Task for tracking time against a parent object.

• Work Item: A Task for either immediate action or future completion.

The Task form captures and manages your Tasks. The Task form is a child record that is linked to
and available from the Release Form (access the form by clicking the Tasks tab in the Release
Arrangement). The Task form that is accessed from a Release is an abbreviated form view.

To view the detailed Task form, click the Go to Record button, or search for the Task using a Quick Search
or Search Group.

Note: For detailed information about the Task form, refer to the Task form documentation.
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Release Journals
CSM provides the following OOTB Release Journal types:

• Journal - Note: Tracks User notes/comments.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt, follow-
up, resolution, and questions.

• Journal - Queue History: Tracks when records are added to/removed from a Queue.

• Journal - Remote Support History: Tracks chat/remote support sessions.

Note: History Journals are automatically created by CSM. Note and Customer Request
Journals are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).
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Release One-Steps
CSM provides multiple One-Steps associated with Releases, including:

One-Steps Description/Actions Associations Executed From

Status    

Alt Step from
Relationship

Conditionally change the Release
status to next logical status (defined
by the Release Status values in
Table Management) and/or initiate
the next appropriate One-Step.

Release

Release Form: <Status> link (I
Want To section)

Note: The bottom two Status
links (I Want To) are dynamic
and based on the Alt 1 Status
and Alt 2 Status defined in the
Release Status Lookup Table
in Table Management.

Alt 2 Step from
Relationship

Next Step from
Relationship

Button Next
Step

Conditionally changes the
embedded form to the next logical
form (based on Embedded Form)
and/or initiates the next appropriate
One-Step.

Release Release Form: Form buttons

Set to Complete
Changes the Release status to
Closed and sets the form view to
the Expanded View (read-only).

Release
Release Form: Close Release
button

Cancel Release
Changes the Release status to
Cancelled.

Release
Release Form: Cancel
Release (I Want To section)

Form    

Ownership    

Assign to ANY
Individual

Prompts the User to assign the
record to any CSM User (not limited
by Team). Uses Owned By ID and
Owned By Team fields.

Release Release Form: Assign To link

Select Individual

Launches the Choose Team
window, where a User can choose
an Owned By Team for the record;
then, launches the Choose User
window, where a User can choose a
Primary User from the already-
selected Team.

Release
Release Form: Select Owner
link
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Select Team
Launches the Choose Team
window, where a User can choose
an Owned By Team for the record.

Release
Release Form: Select Team
link

Take Ownership
Makes the Current User the Primary
User of the record.

Release
Release Form: Take
Ownership link (I Want To
section)

Other    

E-Mail Release
Team

Prompts the User to define and
send an e-mail to all Project
members that are selected to
receive notification e-mails (Send
Notification E-mail checkbox).

Release
Release Form: E-mail Release
Team link (I Want To section)

Notify Task
Owners to
Update Status

Sends an e-mail to Task owners
asking them to update their open
Tasks.

Release
Release Form: Notify Task
Owners to Update Tasks link (I
Want To section)

DateTime Info
Popup

Displays details for all the date/
timestamps to give a historical view.

Release
Release Form: View Detailed
Date/Time Information link (I
Want To section)

A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.
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Release Search Groups
CSM provides numerous OOTB Release Search Groups. Notable Release Search Groups include:

Search Group Returns Association Executed From

Closed Releases All closed Releases. Release
Search Manager,
Widgets

Closed Early Successful
Releases

Closed Releases that are completed
before the due date and are marked as
successful.

Release Search Manager

Closed Late Releases
Closed Releases that are completed
after the due date.

Release Search Manager,

Closed Releases with
Failed Builds

Closed Releases where none of the
builds are successful.

Release Search Manager

Closed Releases with
Unsuccessful/ Incomplete
Tests

Closed Releases where at least one
Release test disposition is failed.

Release Search Manager

Closed Unsuccessful
Releases

Closed Releases with a final disposition
of either Failed or Cancelled.

Release Search Manager

Open Releases All open Releases. Release Search Manager

Open Releases Awaiting
Approval

Open Releases with a status of
Waiting.

Release
Search Manager,
Metrics

Open Releases with Failed
Build Deployment

Open Releases with a build disposition
of failed.

Release Search Manager

Specific Closed Release
Closed Releases that meet a User-
provided Release ID (prompt).

Release Search Manager
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Release Automation Processes
CSM provides the following OOTB Release Automation Processes:

Name Description

Notify Release Owner of
Assignment

When Ownership is assigned, the process initiates the Notify Owned By via
E-mail One-Step, which sends a notification e-mail to the new owner.

Notify Release Team of
Build Test Results

When a Test Disposition Field is selected, the process initiates the Notify
Team of Test Results One-Step, which sends a notification e-mail to
Release Team members.

Notify Release Team of
New Build

When a new Release package build is created, the process initiates the
Notify Team of New Build One-Step, which sends a notification e-mail to
Release Team members.

Notify Release Team of
Ownership

When Ownership is assigned, the process initiates the Notify Owned By
Team via E-mail One-Step, which sends a notification e-mail to members of
the owner's Team.
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Supplier Management
Supplier management is the process that allows Users to onboard and offboard multiple Suppliers
(internal and/or external) and manage their individual lifecycles, which includes defining information,
creating Agreements, and assessing performance.
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About Suppliers
A Supplier is a person or group (internal or external) that is responsible for providing a product or service
to an organization based on an Operational Level Agreement (OLA) or Underpinning Contract (UC).

In CSM, Supplier is a Major Business Object. The Supplier form allows Users to view, create, track, and
manage Suppliers.

Note: Supplier can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Supplier Good to Know
• A Supplier is a person or group (internal or external) that is responsible for providing a product or

service to an organization based on an Operational Level Agreement (OLA) or Underpinning
Contract (UC).

• Search for one or more Suppliers that meet a specific criteria by running a Quick Search or Search
Group.

• Create a new Supplier by clicking New>New Supplier on the CSM Desktop Client toolbar or by
clicking File>New>New Supplier from the CSM Desktop Client menu bar.

• The OOTB system implements several Actions/One-Steps to make creating Suppliers more efficient.
For more information about Actions and One-Steps, refer to the Actions/One-Steps documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• Press TAB to move to the next field on the form.

• Secure Supplier records by controlling who can view, create, and edit records.
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Create a New Supplier
To create a new Supplier:

1. On the CSM Desktop Client toolbar, click New>New Supplier. A new Supplier Form displays.

The Supplier automatically enters the Evaluating phase of the workflow.

The Form Arrangement Pane contains tabs for quick reference of records related to the Supplier.
The Manager can customize how many tabs are visible at one time by selecting boxes under the
Tab Visibility section of the Quick Info Tile. There is no requirement regarding which tabs need to be
populated or completed in order for the Supplier to move through the workflow.

◦ The Agreements tab displays existing contracts the company has with the Supplier and the
Work Units tab divides them into smaller units. The Tasks tab then shows what the Supplier
needs to perform or provide in order to fulfill the Agreements and Work Units.

◦ The Supplier Catalog Items tab displays the existing items the supplier is contracted for,
including type of item and how it is used within the company.

◦ Scorecard assessment dates and grades display in the Scorecard tab. The most recent
grade displays in the Quick Info Tile. For details on the completing the Supplier Scorecard, see
Step 5.

◦ As Supplier Risk Assessments are performed, they populate the Supplier Risk
Assessment tab. The date that the assessment was performed, the Supplier's total score,
their total risk level, and the Manager that performed the assessment will display under this
tab. For details on completing the Risk Assessment, see Step 6.

◦ Service Impact Events include anything that may impact the Suppliers ability to provide their
specified service, these events can be manually inputted into the tab.

◦ If a Service Complaint needs to be created against the Supplier, it can be done so through
the Service Complaints tab.

◦ The Configuration Items tab displays the Configuration Items that a Supplier's service
supports.

2. Record basic Supplier details, contact information, and add a company logo in the Details section of
the Supplier form.

3. Provide Supplier Management information to determine how often the Supplier's performance
should be reviewed and how often Risk Assessments should be conducted. The Supplier Category
should be populated from the drop-down menu to denote what type of contract the Supplier has with
the company. The Supplier Type can also be populated from the drop-down to denote if the Supplier
is an Internal Supplier or an External Supplier.

Note: The Supplier Category and Supplier Type drop-down menus can be configured based
on User need. To add or remove field options, click Tools>Table Management>Supplier
Category, or the desired menu name, and right-click a field to edit it. Click the New button in
the CSM toolbar to add a new field option to the drop-down.
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Note: The On Probation/Under Review checkbox is linked to an Automation Process; if the
field is selected, then the system automatically notifies the Supplier Manager via e-mail that
the Supplier needs to be reviewed.

4. Assign a Manager to the Supplier in the Quick Info Tile.

a. Click the Select Owner link to add a Manager to the Supplier and to denote the department.

The Manager section of the Quick Info Tile populates with the Manager's name and department.

b. Click the Take Ownership link in the I Want To section to assign yourself as the owner of the
Supplier record. The Supplier is then assigned to the User logged into CSM and viewing the
Supplier Form.

5. Create a Supplier Scorecard.

a. Click the Create Scorecard link in the Quick Info Tile.

Note: The Scorecard assesses the Supplier's reliability and whether or not there are
complaints within their control attached to their Form. Complaints associated with the
Supplier display in the Service Complaints tab of the Form Arrangement.

The Scorecard Form displays, showing how the Supplier has ranked in four categories, each with
the same subcategories.

A grade based on the Scorecard Form's calculations displays in the grade section of the Quick Info
Tile. "A" and "B" grades are green; "C" grades are orange.

Note: The Supplier Scorecard uses an Automation Process that automatically sends an e-
mail to the Supplier Manager if the resultant grade is lower than the previously attained
grade. The Supplier Manager also receives an e-mail if the Supplier is given a failing grade
by the Scorecard.

6. Complete the Supplier Risk Assessment.

a. Click the Create Risk Assessment link in the Quick Info Tile.

The Risk Assessment Questionnaire determines the Supplier's risk based on Service Delivery Risks
and Service Disruption Risks. The Questionnaire should be filled out during the initial Evaluation
stage, and again based on the Risk Assessment Cycle that should have been determined in the
Supplier Management section of the main form.

Note: The Risk Assessment form is the OOTB configuration but can be modified by the User
to measure fields of their choice. The Questionnaire corresponds with the Risk subject. The
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Questionnaire asks questions regarding the subject that is currently selected, but the
Questionnaire is the same for each subject. A Risk Mitigation Plan is required if the Risk is
Moderate and Possible, or higher. The plan should be typed into the available text box. All
Risk Assessments that are performed and the date of completion displays in the Risk
Assessment tab in the Arrangement Pane.

The Risk Assessment results display in the Quick Info Tile. "Low" Risk are green, "Medium" are
orange, and "High" are red.

7. Once information has been completed by the Supplier Manager, the status of the Supplier can be
moved to the next stage in the workflow, from Evaluating to Onboarding.

• Onboarding occurs when the Supplier is filling out Agreements with the company and establishing
a service design.

• Once a Supplier has been approved and is acting as a service provider, the Supplier should be
moved to the Active phase of the workflow.

• Offboarding may occur as a result of poor performance and serves as the phase a Supplier will be
in if the company is currently attempting to sever ties. During this phase, a replacement Supplier
should be chosen.

• The Inactive phase occurs when a Supplier is no longer being used and has fulfilled all existing
Tasks or Agreements.
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Scorecard Management
Scorecard management is the process that allows Users to evaluate the performance of a Supplier in real
time.
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About Scorecards
A Scorecard is a record that allows Users to view detailed Supplier performance data in real time. The
Scorecard displays data that is automatically calculated based on quality, delivery, responsiveness, and
complaints, and then presented as a letter grade in the Grade alert bar in the Quick Info Tile of the
Supplier form.

In CSM, Scorecard is a Supporting Object. The Scorecard form allows Users to view and manage
Scorecards.

Note: Scorecard Weight and Scorecard Curve are Lookup Objects that allow Users to define
Scorecard properties (categories, point allocation, grading system, etc.) using Table Management.

Note: Scorecard can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Scorecard Good to Know
• A Scorecard is a record that allows Users to view detailed Supplier performance data in real time.

• The Scorecard displays data that is automatically calculated based on quality, delivery,
responsiveness, and complaints, and then presented as a letter grade in the Grade alert bar in the
Quick Info Tile of the Supplier form.

• Scorecard Weight and Scorecard Curve are Lookup Objects that allow Users to define Scorecard
properties (categories, point allocation, grading system, etc.) using Table Management.

• Search for one or more Scorecards that meet a specific criteria by running a Quick Search or
Search Group.

• Secure Scorecard records by controlling who can view records.
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Agreement Management
Agreement management is the process that allows Users to mange individual Operational Level
Agreements (OLAs) and Underpinning Contracts (UCs).
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About Agreements
An Agreement is a record that defines the terms of service between the service desk and a Supplier. An
Operational Level Agreement (OLA) is a service agreement between the service desk and another entity
(ex: Team, department, etc.) within the same organization. An Underpinning Contract (UC) is a service
agreement between an organization and a third-party service provider. Agreements are directly related to
Suppliers and include Terms, including rules for changes to the Agreement, rules for termination of the
Agreement, and service availability.

In CSM, Agreement is a Group Object that includes two Major Objects: OLA and Underpinning Contract.
The OLA form and Underpinning Contract form share fields and functionality and are used to view and
manage each type of Agreement separately:

Note: Agreement can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Agreements Good to Know
Good to know:

• Search for one or more Agreements that meet a specific criteria by running a Quick Search or
Search Group.

• Create a new Operational Level Agreement by clicking New>New Agreement>New OLA on the
CSM Desktop Client toolbar, or by clicking File>New>New Agreement>New OLA from the CSM
Desktop Client or Browser Client menu bar.

• Create a new Underpinning Contract by clicking New>New Agreement>New Underpinning
Contract on the CSM Desktop Client toolbar , or by clicking File>New>New Agreement>New
Underpinning Contract from the CSM Desktop Client or Browser Client menu bar.

Note: Operational Level Agreements are Agreements with an internal Supplier. Underpinning
Contracts are Agreements with an external Supplier. The steps in this document can be used to
create either an OLA or a UC.

• When on a record, you can send an e-mail directly to the current Supplier by clicking the Supplier's
e-mail address in the Supplier section of the Quick Info Tile. If sent using the Quick Info Tile, an e-
mail template is used to auto-populate the e-mail with the Supplier's e-mail address, and a record of
the e-mail will remain in the associated Agreement's history.

• The Supplier tab contains the Supplier's full record as it is seen in the Supplier Selector.

• Journals track what occurs during the record's lifecycle (ex: Notes to track progress or comments).
View or add Journals by clicking the Journals tab in the record's Arrangement. The Journals
associated with Agreements track Owner notes/comments.

• Attachments supplement records by providing additional details in the form of linked/imported files
(.pdf, .doc, etc.), images, web pages, and Document Repositories. View and manage Attachments

using the Attachment button  and Attachments bar.

• The Quick Info Tile (left) displays important at-a-glance information:

• The Status bar displays the current status of the Agreement as it moves through its workflow.
The next status is displayed as a link directly beneath the current status. Click the status link to
move the Agreement to the next status.

• The Supplier section displays the vendor who is providing the product or Service.

• The Owned By section displays the current record owner. The creator of the Agreement is
automatically assigned as the Owner. A new Owner can be assigned to the Agreement by
clicking one of the ownership links in the Quick Info Tile.
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• The workflow bar (top of Main Pane) indicates the current phase of the Agreement as it moves
through its workflow. Dark gray indicates the current phase.

• Press TAB to move to the next field on the form.

• Fields:

• The Description field is a Rich Text field. To format the text or embed an image, click the Zoom
button .

• The OOTB system implements several Actions/One-Steps to make creating Operational Level
Agreements and Underpinning Contracts more efficient. For more information about Actions and
One-Steps, refer to the Actions/One-Steps documentation.

Note: A full list of One-Steps and Fields is beyond the scope of this document. Export a
schema document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to
view a full list of One-Steps or Fields associated with a particular type of Business Object
(ex: Major).
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Create an Agreement
The following procedure provides steps for creating an Agreement.

To create a new OLA:

1. On the CSM Desktop Client toolbar, click New>New Agreement>New OLA.

A new OLA is created with a status of New. The creator of the OLA is automatically assigned as the
Owner.

2. Assign a new Owner to the OLA by clicking one of the ownership links in the Quick Info Tile (Owned
By or I Want To sections):

a. Take Ownership: Click the link to make yourself the Owner.

b. Owner Name: Click the link to select an Owner (User is limited by Team).

c. Owner Team: Click the link to select an Owner Team.

3. Select a Supplier in the Quick Info Tile (this field is required):
a. Supplier: Provide the name (ex: Hardware Support) of the Team that will be responsible for

fulfilling the Agreement, and then press Enter or Tab to search for the Supplier Record. If an
exact match is found, the Supplier fields are auto-populated with the Supplier's name, image,
e-mail, and phone number.

Note: To browse for a Supplier or add a new Supplier Record, click the Supplier
Selector button . The Supplier tab in the Form Arrangement contains an overview of
the Supplier record. To view the selected Supplier's detailed Supplier Record, click the

Quick View button .

4. When ready, the Owner begins planning the OLA:
a. In the Status alert bar, click Begin Planning.

The Agreement status changes to Planning.

5. Provide details about the OLA:
a. Name: Provide a name for the OLA (this field is required).

b. Supplier Catalog Item Type: Select a Supplier Catalog Item Type from the drop-down (ex:
Product or Service).

c. Supplier Catalog Item: Select the Supplier Catalog Item from the Selector tool (ex: Laptop,
SQL Server).

Note: New Supplier Catalog Items can be created from the Supplier Catalog Item
Selector or by using the Supplier Catalog Item Form (Supplier Catalog Items are
limited by the Supplier Catalog Type). For more information about Supplier Catalog
Item, refer to About Supplier Catalog Items documentation.

d. Description: Provide a description of the OLA.
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e. Start Date: Click the Calendar Date Selector button  to select a start date for the OLA.

f. End Date: Click the Calendar Date Selector button  to select an end date for the OLA.

g. Review Date: Click the Calendar Date Selector button  to select a review date for the OLA.

h. Scope: Provide the scope of the OLA.

6. Provide Cost and Performance information:
a. Resolution Time: Provide the resolution time.

b. Resolution Units: Provide the units to be applied to the resolution time (ex: Minutes, hours,
days, or weeks).

c. Resolution Business Hours: Click the Business Hours Manager button  to select the
business hours that will count against the resolution.

d. Associated Cost: Provide the cost of the product or service.

e. SKU Number: Provide the Stock Keeping Unit number of the Supplier Catalog Item.

7. Provide terms for changing or terminating the Agreement:
a. Rules for Changes: Provide the negotiated and agreed upon rules for changing the

Agreement.

b. Rules for Termination: Provide the negotiated and agreed upon rules for terminating the
Agreement.

8. Provide Availability details:
a. Service Availability: Provide the time(s) that the service is to be available.

b. Service Availability Exception(s): Provide the exception(s) for when the service will not be
available.

c. Service Uptime: Provide the uptime for the service.

9. When the available information has been entered, the Owner activates the OLA:
a. In the Status alert bar, click Activate to activate the OLA.

The Agreement status changes to Active.

Note: The Owner can keep track of progress, troubleshooting, or other notes using the
Journals tab. The Journal tracks Owner notes/comments, as well as activity and
changes made to the Agreement.

10. When the Agreement has been fulfilled, the Owner can Retire the OLA:
a. In the Status alert bar, click Retire to retire the OLA.

The Agreement status changes to Retired.

11. The OLA can be reverted to Active status or reverted to Inactive status after being retired.

a. Revert to Active: Click the link to revert the Agreement to Active.

b. Revert to Inactive: Click the link to revert the Agreement to Inactive.
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Agreement Features
CSM provides the following tools to help manage Agreements:
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Agreement Forms
Use the Agreement Forms to create, edit, and track Agreements. The forms are made up of three main
areas:

1. The Quick Info Tile displays important at-a-glance information based on the type of Agreement, such
as the Agreement type (ex: Operational Level Agreement, Underpinning Contract), Status alert bar
(current and next status), Supplier, Owned By, and common operations (I Want To section).

2. The Main pane displays detailed Agreement information based on the type of Agreement.

3. The Arrangement dynamically displays linked child records based on the type of Agreement, such
as Terms, associated Supplier, and Journals.

The following table describes common fields on the Agreement Form:
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Field Description Comments

Quick Info Tile

Important at-a-glance information, such
as the Agreement type, Supplier, record
ownership, and common operations (I
Want To section).

 

*Supplier Supplier assigned to the Agreement.

*Required

A Supplier is a person or group (internal
or external) that is responsible for
providing a product or service to an
organization based on an Operational
Level Agreement (OLA) or
Underpinning Contract (UC).

Image Image associated with the Supplier.
The Image, Phone, and E-mail fields
are auto-populated with information
from the Supplier's Record.

One-Step (Dial Supplier Phone): Dials
the Supplier's phone number.

One-Step (Follow-up E-mail): Creates a
follow-up e-mail to send the Supplier
regarding a question or update about
the Agreement. Allows the User to edit
the e-mail before clicking Send.
Attaches the e-mail to the Agreement
History record.

E-mail
E-mail address of the Supplier
associated with the Agreement.

Phone

Phone number of the Supplier
associated with the Agreement.

Click the link to dial the Supplier if
telephony is configured.

Owned By Record owner.
Ownership is automatically assigned to
the creator.

User Owner
Name of the User Owner. Click the link to
first select a Team and then an Owner
(User is limited by Team).

The creator of the Agreement is
automatically assigned as the Owner.

Team Owner
Name of the Owned By Team. Click the
link to select a Team owner.

Avatar
Photo/graphic associated with the owner
(from User profile).

 

I Want To Common operations.  

Take Ownership
Click the link to make yourself the User
Owner of the Agreement.
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Field Description Comments

View Detailed
Date/Time
Information

Click the link to open the Information
window, where you can view created
date and time, creator name, and last
edited date and time. Time Date/time
format is MM/DD/YYYY HH:MM.

One-Step (Date Time Info Popup):
Displays details for all the date/
timestamps to give a historical view.

Main Pane

Contains information about the
Agreement, such as the Supplier Catalog
Item Type, the Supplier Catalog Item, a
description of the Agreement, and the
Scope of the Agreement.

Fields in the Main pane are the same,
regardless of the type of Agreement.
These fields are completely
customizable and configurable.

*Name Name of the Agreement. *Required

*Supplier Catalog
Item Type

Designates if the Supplier is providing a
product or a Service.

*Required

*Supplier Catalog
Item

Designates what kind of product or
Service the Supplier is providing.

*Required

Supplier Catalog Items are limited by
the Supplier Catalog Type.

Description Description of the Agreement.

Scope
A summary of the steps involved in
completing the Agreement.

Cost and
Performance

Resolution Time
The negotiated and agreed upon
resolution time.

Resolution Units
The units to be applied to the resolution
time.

Resolution
Business Hours

The business hours that will count
against the resolution time.

Associated Cost
The negotiated and agreed upon cost of
the product or service.

Arrangement
Dynamically displays child records that
are in a relationship with the Agreement.

Terms
Displays rules for changing or
terminating the Agreement.

Supplier
Displays detailed information about the
Supplier.

Journals

Displays related Journal records that are
created to track User notes/comments,
field changes, and e-mail
correspondence.
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Agreement Journals
CSM provides the following OOTB Agreement Journal types:

• Journal - Note: Tracks User notes/comments.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt, follow-
up, resolution, and questions.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Remote Support History: Tracks chat/remote support sessions.

Note: History Journals are automatically created by CSM. Notes are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).
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Agreement One-Steps
CSMprovides the following Agreement One-Steps:

One-Steps Description/Actions Associations Executed From

Status

Alt 1 Step from
Relationship

Conditionally change the
Agreement Status to next
logical Status (defined by
the Agreement Status
values in Table
Management) and/or initiate
the next appropriate One-
Step.

Agreement
Agreement Form: Next:
<Status>

Alt 2 Step from
Relationship

Next Step from
Relationship

Ownership

Assign to Individual

Launches the Choose Team
window, where a User can
choose an Owned By Team
for the record; then,
launches the Choose User
window, where a User can
choose a Primary User from
the already-selected Team.

OLA or UC
Agreement Form: <Owner's
Name> link

Assign to Team

Launches the Choose Team
window, where a User can
choose an Owned By Team
for the record.

OLA or UC
Agreement Form: <Owner's
Team> link

Take Ownership
Makes the Current User the
Primary User of the record.

OLA or UC
Agreement Form: Take
Ownership link (I Want To
section)

Supplier

E-Mail Supplier
E-Mails Supplier associated
with the Agreement.

OLA or UC
Agreement Form: Supplier
e-mail address

Dial Supplier Phone
Calls Supplier associated
with the Agreement.

OLA or UC
Agreement Form: Supplier
phone number

I Want To

Date Time Info Popup

Displays details for all the
date / time stamps to give a
historical view of the
Agreement.

OLA or UC

Agreement Form: View
Detailed Date / Time
Information link (I Want To
section)

Other
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Update Costs when OLA
Costs Change

Updates record to reflect
changes made to the
Associated Cost field.

Updates costs on associated
Work Units and Service
Catalog Templates.

OLA
Agreement Form: One-Step
runs automatically when
OLA is saved.

Update Costs when UC
Costs Change

Updates record to reflect
changes made to the
Associated Cost field.

Updates costs on associated
Work Units and Service
Catalog Templates.

UC
Agreement Form: One-Step
runs automatically when UC
is saved.

Update Costs when
Agreement Costs Change

Updates record to reflect
changes made to the
Associated Cost field.

Updates costs on associated
Work Units and Service
Catalog Templates.

Agreement
Agreement Form: One-Step
runs automatically when
Agreement is saved.

A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.
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Agreement Search Groups
CSM provides the following OOTB Agreement Search Groups:

Operational Level Agreements

Search Group Returns Association Executed From

Active OLAs All active OLAs. OLA Search Manager, Widgets

All OLAs All OLAs, regardless of status. OLA Search Manager

OLA Costs
Active OLAs with associated
costs.

OLA Search Manager

Underpinning Contracts

Search Group Returns Association Executed From

Active Status All active Underpinning Contracts. Underpinning Contract Search Manager, Widgets

This Week
Underpinning Contracts with a
review date this week.

Underpinning Contract Search Manager

Agreement

Search Group Returns Association Executed From

Resolution Times
Agreements containing a
Resolution Time.

Agreements Search Manager

Supplier Agreements Agreements with a Supplier. Agreements Search Manager

317

CSM Record Management

CSM Record Management



Risk Management
Risk management is the process that allows organizations to minimize Risks associated with Suppliers by
defining and tracking factors that could affect the delivery of a Service.
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About Risk
A Risk Assessment is a questionnaire that is used to evaluate the risk level of a Supplier. Users evaluate
a Supplier using the Risk Questionnaire by answering questions related to Service Delivery risks and
Service Disruption risks. As the User progresses through the questionnaire, Risk Weight definitions
calculate the risk level, and then auto-populate Risk Chart using Low, Medium, High, and Extreme risk
levels.

In CSM, Risk Assessment is a Supporting Business Object. The Risk Assessment form allows Users to
view and manage Risk Assessments.

Note: Risk Weight is a Lookup Object that allows Users to define Risk Assessment properties
(including categories, subcategories, point allocation, etc.) using Table Management.

Note: Risk Assessment can be used to support Multi-Sourcing Service Integration (MSI) and
Service Integration and Management (SIAM). For more information, see The Relationship
between CSM and Multi-Sourcing Service Integration and Service Integration and Management.
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Risk Good to Know
• A Risk Assessment is a questionnaire that is used to evaluate the risk level of a Supplier.

• Risk Weight is a Lookup Object that allows Users to define Risk Assessment properties (including
categories, subcategories, point allocation, etc.) using Table Management.

• Search for one or more Risk Assessments that meet a specific criteria by running a Quick Search or
Search Group.

• Create a new Risk Assessment by clicking the Create a Risk Assessment link in the I Want To
section of the Quick Info Tile of a Supplier form.

• The OOTB system implements several Actions/One-Steps to make creating Risk Assessments more
efficient. For more information about Actions and One-Steps, refer to the Actions/One-Steps
documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• Press TAB to move to the next field on the form.

• Secure Risk Assessment records by controlling who can view, create, and edit records.
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Service Catalog Template Management
Service Catalog Template management is the process that allows Users manage deliverables that are
comprised of Work Units and available to Customers from the Service Catalog in the Customer Portal.

Note: A simple version of Service Catalog Template and Work Unit functionality is available as a
mergeable application (mApp).
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About Service Catalog Templates
A Service Catalog Template is a deliverable that is comprised of related Work Units and available to
Customers from the Service Catalog in the Customer Portal. When a Service Catalog Template is
selected, a Service Request is created and the associated Work Units transform into Tasks, which are
required to close the Service Request. This allows you easily manage the Tasks required to fulfill common
Service Requests.

In CSM, Service Catalog Template is a Major Business Object. The Service Catalog Template form allows
users to view, create, track, and manage Service Catalog Templates. The Critical Path time will
automatically create a cumulative process completion time based on attached SLAs, Work Units, and
Dependencies.

Note: Service Catalog Template can be used to support Multi-Sourcing Service Integration (MSI)
and Service Integration and Management (SIAM). For more information, see The Relationship
between CSM and Multi-Sourcing Service Integration and Service Integration and Management.
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Service Catalog Template Good to Know
• A Service Catalog Template is a deliverable that is comprised of related Work Units and available to

Customers from the Service Catalog in the Customer Portal.

• The Critical Path Time is based on attached Work Units, Dependencies, and Incident SLAs.

• Search for one or more Service Catalog Templates that meet a specific criteria by running a Quick
Search or Search Group.

• Create a new Service Catalog Template by clicking New>New Service Catalog Template on the
CSM Desktop Client toolbar or by clicking File>New>New Service Catalog Template from the CSM
Desktop Client menu bar.

• By default, Service Catalog Template uses the Incident Service and Category structure. Access
Category options by clicking Tools>Table Management>Type>Incident Category.

• The OOTB system implements several Actions/One-Steps to make creating Service Catalog
Templates more efficient. For more information about Actions and One-Steps, refer to the Actions/
One-Steps documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• Fields:
• Press TAB to move to the next field on the form.

• The Description and Portal Description fields are Rich Text fields. To format the text or embed
an image, click the Zoom button .

• The Title, Portal Title, Description, Portal Description, Service, Category, and Subcategory
fields are required to save the record.

• Secure Service Catalog Template records by controlling who can view, create, and edit records.
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Creating Service Catalog Templates
The following instructions are available to walk you through the steps to create a Service Catalog
Template (SCT) using our OOTB workflow:

• Create a Service Catalog Template: Typical step-by-step instructions for creating an SCT.

Note: CSM provides an OOTB SCT workflow with all of the features you need to
successfully manage SCTs. You can use this workflow as-is, or tailor it to meet the needs of
your organization.
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Create a Service Catalog Template
The following procedure walks you through the typical steps to create a Service Catalog Template.

To create a Service Catalog Template:

1. On the CSM Desktop Client toolbar, click New>New Service Catalog Template.

A new Service Catalog Template record is created with a unique ID and a status of New.

Note: The Critical Path will create a cumulative process completion time based on all
attached SLAs, Work Units, and Dependencies. SCTs can be linked to Work Units and
Incidents from within the SCT form, a Work Unit form, or an Incident form. The cumulative
time will automatically populate in the Critical Path Quick Info Tile.

2. Complete the Title and Description section (all fields are required):
a. Title: Provide a title for the Service Catalog Template (ex: New Employee Setup).

b. Portal Title: Autopopulates based on the Title field. Provide a different title for the Portal
(Service Catalog page), if necessary.

c. Description: Provide a description for the Service Catalog Template (ex: Create all necessary
items for a new employee setup).

d. Portal Description: Autopopulates based on the Description field. Provide a different
description for the Portal (Service Catalog page), if necessary.

3. Complete the classification section (the Service, Category, and Subcategory fields are required):
a. Service: Select the affected Service (ex: Employee Support). An abbreviated read-only

Service form displays in the Form Arrangement.

Tip: To view the detailed Service form, click the Go to Record button  in the Form
Arrangement toolbar.

b. Category: Select the affected Service Category (ex: Add/Change).

c. Subcategory: Select the affected Service Subcategory (ex: New Employee Setup).

d. Service Catalog Template Category: Select a Service Catalog Template Category (ex: HR
Process). This categorization allows Users to filter Service Catalog Templates for Search
Groups and Reports.

4. Assign ownership in the Quick Info Tile:
a. (Optional) Assign a Business Owner by clicking the ownership link (Business Owner section):

◦ Select Owner (User): Click this link to select a User owner.

b. Assign an IT Process owner (if different from the creator) by clicking one of the ownership links
(IT Process Owner section):

◦ Creator's name (ex: Henri Bryce): Click this link to select a User owner.

◦ Creator's Team (ex: 3rd Level Support): Click this link to first select a Team owner.

325

CSM Record Management

CSM Record Management



5. Add Work Units to the Service Catalog Template:
a. Click the Add a Work Unit button in the Work Unit Functions section of the Main Pane or in the

I Want To section of the Quick Info Tile.

The Work Unit Selector opens displaying available WUs.

b. Select a Work Unit from the Grid. Linked Work Units will appear in the Work Unit tab as they

are added to the SCT. To view the detailed Work Unit form, click the Go to Record button 
in the Form Arrangement toolbar. The Work Units will then populate the Work Unit Order tab
where they are organized by the system.

Note: As Work Units are added, Dependencies can also be added to dictate the order
in which the Work Units are completed. Work Units with Dependencies are easily
viewed in the Work Unit Order tab. Above, before the PC can get an Asset Tag, the
laptop must first be acquired.

c. (Optional) Manage Work Units in the Work Unit Functions section, these will not appear in the
SCT unless the SCT has Work Units or Dependencies linked to it:

◦ Add a Work Unit: Add additional Work Unit to the Service Catalog Template.

◦ Delete a Work Unit: Remove a Work Unit to the Service Catalog Template.

◦ Reorder the Work Units: Organize the order of the Work Units.

◦ Update Completion Times: Automatically syncs Supplier Agreements with Work Units
and updates the Critical Path Time.

◦ Add a Dependency: Add a dependency to a Work Unit. The Work Unit that is depended
upon must be completed before the dependent Work Unit can be completed.

◦ Remove a Dependency: Remove an existing dependency.

◦ Add a Note to Work Unit Task: Provide additional information related to the Work Unit.
When the Work Unit becomes a Task, the defined note displays in the Description field
on the Task.

◦ Remove a Note from Work Unit: Remove an existing note from the Work Unit Task.

6. Activate the Service Template by clicking the Next: Active link in the Status bar.

The status changes to Active and the Service Catalog Template is available to Customers from the
Service Catalog in the Customer Portal. When a Service Catalog Template is selected, a Service
Request is created and the associated Work Units transform into Tasks, which are required to close
the Service Request.

Note: To retire the Service Catalog Template, click the Next: Retire link in the Status bar.
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Supplier Catalog Item Management
Supplier Catalog Item management is the process that allows Users to manage generic products or
Services that are provided by an internal or external Supplier.
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About Supplier Catalog Items
A Supplier Catalog Item is a generic product or Service that is provided by an internal or external Supplier
to an organization's Customers.

In CSM, Supplier Catalog Item is a Major Business Object. The Supplier Catalog Item form allows Users
to view, create, track, and manage Supplier Catalog Items.

Note: Supplier Catalog Item can be used to support Multi-Sourcing Service Integration (MSI) and
Service Integration and Management (SIAM). For more information, see The Relationship
between CSM and Multi-Sourcing Service Integration and Service Integration and Management.
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Supplier Catalog Item Good to Know
• A Supplier Catalog Item is a generic product or Service that is provided by an internal or external

Supplier to an organization's Customers.

• Search for one or more Supplier Catalog Items that meet a specific criteria by running a Quick
Search or Search Group.

• Create a new Supplier Catalog Item by clicking New>New Supplier Catalog Item on the CSM
Desktop Client toolbar or by clicking File>New>New Supplier Catalog Item from the CSM Desktop
Client menu bar.

• The OOTB system implements several Actions/One-Steps to make creating Supplier Catalog Items
more efficient. For more information about Actions and One-Steps, refer to the Actions/One-Steps
documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• Press TAB to move to the next field on the form.

• Secure Supplier Catalog Item records by controlling who can view, create, and edit records.
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Work Unit Management
Work Unit management is the process that allows Users to manage generic tasks that are required to
fulfill a Service Request.

Note: A simple version of Service Catalog Template and Work Unit functionality is available as a
mergeable application (mApp).
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About Work Units
A Work Unit is a generic task that is required to fulfill a Service Request. Work Units are grouped together
in one or more Service Catalog Templates and then converted into individual Tasks when a Customer
submits an order for a Service using the Customer Portal.

In CSM, Work Unit is a Major Business Object. The Work Unit form allows Users to view, create, track,
and manage Work Units:

Note: Work Unit can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Work Unit Good to Know
• A Work Unit is a generic task that is required to fulfill a Service Request. Work Units are grouped

together in one or more Service Catalog Templates and then converted into individual Tasks when a
Customer submits an order for a Service using the Customer Portal.

• Search for one or more Work Units that meet a specific criteria by running a Quick Search or Search
Group.

• Create a new Work Unit by clicking New>New Work Unit on the CSM Desktop Client toolbar or by
clicking File>New>New Work Unit from the CSM Desktop Client menu bar.

• The OOTB system implements several Actions/One-Steps to make creating Work Units more
efficient. For more information about Actions and One-Steps, refer to the Actions/One-Steps
documentation.

Note: A full list of One-Steps is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Steps associated with a particular type of Business Object (ex: Major).

• Fields:
• Press TAB to move to the next field on the form.

• The Work Unit Description and Task Description (Displays on Task) fields are Rich Text fields.
To format the text or embed an image, click the Zoom button .

• The Name, Work Unit Description, and Task Description (Displays on Task) fields are required
to save the record.

• Secure Work Unit records by controlling who can view, create, and edit records.
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Creating Work Units
The following instructions are available to walk you through the steps to create a Work Unit using our
OOTB workflow:

• Create a Work Unit: Typical step-by-step instructions for creating a Work Unit.

Note: CSM provides an OOTB Work Unit workflow with all of the features you need to
successfully manage Work Units. You can use this workflow as-is, or tailor it to meet the
needs of your organization.

333

CSM Record Management

CSM Record Management



Create a Work Unit
The following procedure walks you through the typical steps to create a Work Unit.

To create a Work Unit:

1. On the CSM Desktop Client toolbar, click New>New Work Unit.

A new Work Unit record is created with a unique ID and a status of New.

2. Complete the Basic Information section (the Name, Work Unit Description, and Task Description are
required):

a. Name: Provide a name for the Work Unit (ex: Acquire a Laptop).

b. Work Unit Category: (Optional) Select a Work Unit Category (ex: Order product).

c. Work Unit Description: Provide a description for the Work Unit (ex: Order a generic laptop).

d. Task Description (Displays on Task): Autopopulates based on the Work Unit Description field.
Provide a different description for the Task, if necessary (ex: Order a laptop from the lead
vendor).

3. Assign ownership in the Quick Info Tile by clicking one of the ownership links:

Note: When the Work Unit transforms into a Task, the Work Unit owner becomes the Task
owner.

◦ Assign to: Click the link to select a User owner . The Team owner is populated by the User
owner's default Team.

◦ Select Team: Click the link to first select a Team owner .

4. (Optional) Complete the Catalog Information section if you are using a Supplier Catalog Item:
a. Catalog Item: Select a Catalog Item (ex: Generic Laptop)..

Catalog Item information (pulled from the Supplier Catalog Item record) displays in the Main
Pane as read-only text, and the Supplier Catalog Item and Agreement records display as
abbreviated read-only forms in the Form Arrangement.

b. (Optional) Manage the Catalog Item:
◦ Change Supplier: Click the link in the I Want To section to open the Agreement Selector,
where you can select an alternate Supplier (ex: Viahouse Supplies).

The new Supplier information displays in the Main Pane. A warning icon and (Alternate
Supplier) text displays in the Supplier Information heading to indicate the change.

◦ Clear the Catalog Item: Click the link in the I Want To section to remove the data in the
Catalog Information section, so that you can select a new Catalog Item.

5. Activate the Work Unit by clicking the Next: Set as Active link in the Status bar.
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The status changes to Active and the Work Unit is available to use for Service Catalog Templates.
When a Service Catalog Template is selected, a Service Request is created and the associated
Work Units transform into Tasks, which are required to close the Service Request.

Note: To retire the Work Unit, click the Next: Retire Work Unit link in the Status bar.
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Work Unit Features
CSM provides the following tools to help manage Work Units:

• Form

• Search Groups

336

CSM Record Management

CSM Record Management



Work Unit Form
CSM provides a read-only OOTB Work Unit form available in the CSM Desktop Client. The Form is
comprised of three main areas:

1. Quick Info Tile: Displays important at-a-glance information (Status, assignment information, etc.).

2. Main Pane: Displays the main Form details and Fields.

3. Form Arrangement: Displays linked child records (ex: Supplier Catalog Item, Agreement (OLA or
UC), and Service Catalog Templates).
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Work Unit Search Groups
CSM provides the following OOTB Work Unit Search Groups:

Search Group Returns Association Executed From

All Work Units All Work Units, regardless of status. Work Unit Search Manager, Widgets

New Work Units Work Units with a status of New. Work Unit Search Manager

Retired Work Units Work Units with a status of Retired. Work Unit Search Manager
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Service Cart Management
Service Cart management is the process that gives Customers more control over their Service Requests
and Service Orders.

Note: This feature is also available as a mergeable application (mApp).
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About Service Carts
A Service Cart is an e-commerce tool that allows Customers to add multiple Service Requests to a single
order, and then temporarily hold the items until they are ready to submit the full order. When the order is
submitted, each Service Request automatically creates associated Tasks based on related Service
Catalog Template Work Units. Technicians fulfill the Service Requests in CSM, and Customers view and
track the Service Requests (and Service Request history) on the My Service Orders page of the
Customer Portal.

CSM Provides an OOTB Service Cart as a Major Business Object for Customers to use in the OOTB IT
Portal.

Note: Service Cart can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Service Cart Good to Know
• A Service Cart is an e-commerce tool that allows Customers to add multiple Service Requests to a

single order, and then temporarily hold the items until they are ready to submit the order. When the
order is submitted, each Service Request automatically creates associated Tasks based on related
Service Catalog Template Work Units. Technicians fulfill the Service Requests in CSM, and
Customers view and track the Service Requests (and Service Request history) on the My Service
Orders page of the Customer Portal.

• CSM Provides an OOTB Service Cart as a Major Business Object for Customers to use in the
OOTB IT Portal.

• Service Carts are automatically created when a Customer creates and saves a new Request in the
Portal. Once the Customer submits the items in the Service Cart, the Service Requests are created
in the CSM Desktop Client, and a Service Order is created that lists the details of the Customer's
Service Request(s).

• Incidents logged in the Portal do not go into a Service Cart or Service Order. Only Service Requests
are submitted via the Service Cart.

• CSM provides a read-only, editable OOTB Service Cart form available in CSM Administrator. The
Service Cart form is separate from the Service Request forms available in the CSM Desktop Client
and the Portal. For more information, refer to the Incident documentation.

• The OOTB CSM system implements several Actions and One-Steps to make working with the
Service Cart more efficient. For more information about Actions and One-Steps, refer to the Actions/
One-Steps documentation.

• CSM provides several OOTB Service Cart Search Groups that make finding Service Requests,
creating Widgets, and running Reports easier and faster.

• The OOTB CSM system implements several Automation Processes to automate Service Cart
Management (ex: Sending Customers reminders about their abandoned Service Carts). For more
information, refer to the Automation Process documentation.
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Service Cart Workflow

Note: The Service Cart has its own workflow separate from the Incident/Service Request
workflow. For more information about the workflow, phases, and statuses of Incidents and Service
Requests, refer to the Incident documentation.

The following figure shows a high-level Service Cart process workflow in the OOTB CSM system.
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Note: CSM uses several features to manage the Service Cart workflow. The Service Request
forms in the Portal help create and manage items in the Service Cart. Automation Processes
notify Customers via e-mails about the status of their Service Orders. The Service Cart
Dashboards allow Customers to track their open and past Service Orders.

Contributors

A Service Cart typically involves the following contributors:

• Customer: The Portal Customer who logs Service Requests.

• Technician: The User who manages and completes the Service Requests.

Statuses

A Service Cart progressing through the workflow encounters the following statuses:

1. New: Customer has created and recorded the initial details of a Service Request(s) in the Portal.

2. Committed: Customer has submitted their Service Order in the Portal.

3. Pending: The Service Order is temporarily paused or on hold.

4. In Progress: A technician in the CSM Desktop Client is investigating/fulfilling the Service Order.

5. Complete: A technician has resolved and closed the Service Order.

6. Canceled: The Customer who created and recorded the initial details of the Service Order has
canceled the order in the Service Cart before submitting it.

7. Abandoned: The Customer who created and recorded the initial details of the Service Order has
abandoned their order in the Service Cart without canceling or submitting it.
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Using Service Carts
When working with Service Carts, Users can:
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Add Items to the Service Cart
Service Carts are automatically created when a Customer creates and saves a new Request in the Portal.
Once the Customer submits the items in the Service Cart, the Service Requests are created in the CSM
Desktop Client, and a Service Order is created that lists the details of the Customer's Service Request(s).

Note: Incidents logged in the Portal do not go into a Service Cart or Service Order.

To add an item to a Service Cart:

1. Log in to the Portal

2. Click the Service Catalog button on the menu bar.

The Service Catalog opens.

3. Select a Request (ex: Request New Computer).

The Request form opens.
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4. Complete the Request form.

5. Click the Add to Cart button.

The My Service Cart Dashboard opens.

To add more Requests to the Service Cart, click Continue Shopping to return to the Service
Catalog. Click Cancel Order to cancel the entire order (you are prompted to verify before your order
is canceled).

6. Submit the Service Cart by clicking the Submit Order button. The My Service Orders Dashboard
opens and shows the status of all current and past Service Orders. Customers can click on an item
in the Grid to open the Service Request.
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View Items in a Service Order
Once a Service Request has been submitted, Customers can view the status of their current Service
Orders and review past Service Orders using the My Service Orders Dashboard.

To view items in a Service Order:

1. Log in to the Portal

2. Click the Service Orders drop-down in the menu bar, and then select My Orders.

The My Service Orders Dashboard opens.

3. Select an item from the Grids to open the specific Service Request.

349

CSM Record Management

CSM Record Management



Service Cart Features
CSM provides the following tools to help manage the Service Cart:

• Form

• Dashboards

• One-Steps

• Search Groups

• Automation Processes
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Service Cart Form
CSM provides a read-only OOTB Service Cart form available in CSM Administrator. The Form is
comprised of two main areas:

1. Quick Info Tile: Displays important at-a-glance information (Service Order ID, Status bar, record
ownership, etc.).

2. Main Pane: Displays the main Form details and Fields.

Note: The Service Cart form is separate from the Service Request forms available in the
CSM Desktop Client and the Portal. For more information, refer to the Incident
documentation.

Service Cart Form Fields

Field Description Comments

Quick Info Tile

Service
Order

Record type and unique record identifier
(ID).

CSM automatically assigns the ID when the
Service Cart is created.
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Field Description Comments

Status

Statuses include:

• New: Customer has created and
recorded the initial details of a
Service Request(s) in the Portal.

• Committed: Customer has
submitted their Service Order in the
Portal.

• Pending: The Service Order is
temporarily paused or on hold.

• In Progress: A technician in the
CSM Desktop Client is investigating/
fulfilling the Service Order.

• Complete: A technician has
resolved and closed the Service
Order.

• Canceled: The Customer who
created and recorded the initial
details of the Service Order has
canceled the order in the Service
Cart before submitting it.

• Abandoned: The Customer who
created and recorded the initial
details of the Service Order has
abandoned their order in the Service
Cart without canceling or submitting
it.

 

Requester

Name, avatar, e-mail address, and phone
number associated with the requester (i.e.,
the Portal Customer who submitted the
Service Order).

 

Main Pane - Details

Created On
Date on which the Service Order was
created.

The date is generated using the
ServiceCart.CreatedDateTime Text
Expression.

Estimated
Cost

Estimated Cost of the Service Order.
The estimated cost is calculated using the
Estimated Total Cost Text Expression.

Items
Total number of Service Requests in the
Service Order

The number of items is calculated using the
numeric Count Items Expression.

% Complete
Percentage of the Service Order that is
currently complete.

The percentage is calculated using the
Percentage Complete Text Expression.
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Field Description Comments

Items
Pending

Items in the Service Order with a status of
Pending.

The number of items with a Pending status
is calculated using a numerical Count Items
Pending Expression.

In Progress
Items in the Service Order with a status of
In Progress.

The number of items with an In Progress
status is calculated using a numerical
Count Items In Progress Expression.

Complete Items in the Service Order with a status of
The number of items with a Complete
status is calculated using a numerical
Count Items Complete Expression.

Canceled Items in the Service Order with a status of
The number of items with a Canceled
status is calculated using a numerical
Count Items Canceled Expression.
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Service Cart Dashboards
CSM provides the Service Cart and My Service Orders Dashboards for Customers to manage and view
their Service Orders in the OOTB IT Portal.

The My Service Cart Dashboard displays Service Orders that have been created but not yet submitted for
a technician to address in a Grid. Customers can cancel the order (by clicking the Cancel Order button) or
submit the order (by clicking the Submit Order button).

Once a Customer submits a Service Order, they can monitor the status of their Service Requests on the
My Service Orders Dashboard, as well as past Service Orders.
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Note: Service Request metrics are also available on other Dashboards, including Requests,
Global IT, and Executive.

My Service Cart Dashboard Widgets

Item Description
Widget
Type

Widget Name Widget Uses:

Services
Ordered

List of all Service Requests
saved but not yet submitted
in the Service Cart

Search
Results List

Service Cart
Item Grid

Custom Query:
Incident.Service Cart ID
equals Service Cart ID
Stored Value and
Incident.Withdraw is not
equal to True.

Continue
Shopping

Runs the Service Catalog
Action to return the User to
the Service Catalog.

Button
(Action)
Widget

Continue
Shopping

Service Catalog Action

Cancel
Order

Runs the Cancel Service
Cart Order Action to cancel
the order.

Button
(Action)
Widget

Cancel
Service Cart
Order

Cancel Service Cart Order
Action

Submit
Order

Runs the Submit Service
Cart Order Action to submit
the order.

Button
(Action)
Widget

Submit
Service Cart
Order

Submit Service Cart Order
Action

My Service Orders Dashboard Widgets
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Item Description
Widget
Type

Widget Name Widget Uses:

Filter
Filters data in the Search
Results Grid.

Filter
Service Order
Status

Filter by Lookup
Table

Services to be
Delivered

List of all Service Requests that
have been submitted and are
currently open.

Search
Results List

My Open
Service Orders

My Open Service
Order Items Search
Group

My Order
History

List of all Service Requests that
have been submitted and
closed.

Search
Results List

My Service
Order History

My Closed Service
Order Items Search
Group
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Service Cart One-Steps
CSM provides several OOTB Service Cart One-Steps, including:

One-Step Description/Actions Associations Executed From

Blueprint

Create
Incidents

Create Incidents from Service Cart
Items.

Once a Customer submits the Service
Order, CSM creates Incidents/Service
Requests based on the information
provided in the Service Order, and then
runs the In Progress One-Step to
change the Service Cart status to In
Progress.

Service Cart
One-Step Manager, Submit
button on the Portal My
Service Cart Dashboard.

Go to Cart
From the Summary form, the One-Step
takes the Customer to the Service
Cart.

Service Cart
One-Step Manager,
submission of the Service
Order to the Service Cart

Set Estimated
Total Cost

Sets the Total Cost field in the Service
Cart based on the sum of all costs in
the Service Order.

Service Cart
One-Step Manager,
submission of the Service
Order to the Service Cart

Blueprint - Email Messages

E-mail
Reminder

Sends the Customer a reminder about
Service Carts that have not been
submitted or committed for a technician
(ex: The Cart has been abandoned).

Service Cart

One-Step Manager, when
the Service Cart exceeds
the Service Cart Expiration
date (three days after the
Service Cart has been
created)

Order Canceled

Sends the Customer a notification that
the Service Order has been canceled
or the Service Cart has been
abandoned.

Service Cart
One-Step Manager, when
the Service Order has been
canceled.

Order
Confirmation

Sends the Customer a notification with
the Service Order details, including
Cart Item IDs, Total Cost, and Cart
Item Costs.

Service Cart
One-Step Manager, when
the Service Order has been
submitted.

Blueprint - Status Actions

Abandoned

Sets the status of the Service Cart to
Abandoned if the Cart remains in a
New status for more than twice the
number of days specified in the
Abandoned Cart Reminder Stored
Value.

Service Cart

One-Step Manager, when
the Service Cart exceeds
twice the number of days
specified in the Abandoned
Cart Reminder Stored
Value.
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Canceled
Sets the status of the Service Cart to
Canceled if all Service Cart Items are
canceled.

Service Cart
One-Step Manager, when
all items in a Service Cart
are canceled.

Complete
Sets the status of the Service Cart to
Complete when all items in the Service
Cart have been completed.

Service Cart
One-Step Manager, when
all items in a Service Cart
are complete.

In Progress

Sets the status of the Service Cart to In
Progress when the items in the Cart
have been submitted and Service
Requests have been created in CSM
for each Cart item.

Service Cart
One-Step Manager, when
all items in the Service Cart
have Service Requests.

New
Sets the status of the Service Cart to
New when the Service Cart has been
created.

Service Cart
One-Step Manager, when
the Service Cart is first
created.

Submitted

Sets the status of the Service Cart to
Submitted when items in the Service
Cart have been submitted as a Service
Order

Service Cart

One-Step Manager, when
the items in the Service
Cart have been submitted
as a Service Order.

Global

Send E-mail to
Customer

Sends an e-mail to the Customer who
submitted the Service Cart Order.

Service Cart One-Step Manager

A full list of One-Steps is beyond the scope of this document. Export a schema document from CSM
Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Steps associated
with a particular type of Business Object.
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Service Cart Search Groups
CSM provides several OOTB Service Cart Search Groups, including:

Search Group Returns Association Executed From

All Service Carts All Service Carts, regardless of status. Service Cart
Search Manager,
Metrics, Widgets

Canceled or
Abandoned Service
Carts

Service Carts that have been canceled
or abandoned.

Service Cart
Search Manager,
Metrics, Widgets

Complete Cart Items
Service Cart Items with a status of
Complete.

Service Cart
Search Manager,
Metrics, Widgets

Cost
Service Cart items where the Total Cost
field contains a value.

Service Cart
Search Manager,
Metrics, Widgets

In Progress Cart
Items

Open Service Cart items with a status
of In Progress.

Service Cart
Search Manager,
Metrics, Widgets

New Cart Items
Open Service Cart items with a status
of New.

Service Cart
Search Manager,
Metrics, Widgets

New Service Carts
Open Service Cart Orders with a status
of New.

Service Cart
Search Manager,
Metrics, Widgets

New Service Items
Open Service Cart Orders with a status
of New.

Service Cart
Search Manager,
Metrics, Widgets

Pending Cart Items
Open Service Cart Orders with a status
of Pending.

Service Cart
Search Manager,
Metrics, Widgets

Submitted Cart Items
Open Service Cart Orders with a status
of Submitted.

Service Cart
Search Manager,
Metrics, Widgets
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Service Cart Automation Processes
CSM provides the following OOTB Service Cart Automation Processes:

Name Description

Send Abandoned
Cart Reminder

When a Service Cart has been created and abandoned for three (3) days, the
process initiates the Email Reminder One-Step, which sends a notification e-mail
to the Service Cart creator about the Service Cart's status. The creator can then
continue with the Service Cart or abandon the order.

Send Order
Confirmation

When a Service Cart Order status is changed by a technician to Submitted, the
process initiates the Order Confirmation One-Step, which sends a notification e-
mail to the Customer with the order details.

Service Cart
Complete

When the items in a Service Cart are all set to Resolved status, the process
initiates a One-Step to set the Service Cart Order status to Complete and send a
notification e-mail to the Customer about the change.
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Task Management
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About Tasks
A Task is a piece of work that is created and assigned to another CSM User or Team to help resolve/fulfill
an Incident/Service Request, Problem, or Change Request (ex: An Incident might require a server
reboot). Tasks can also be used to successfully complete a Project or Release (ex: A Project might
require a new switch).

CSM provides the following OOTB Task types:

• Escalation: A Task assigned to a higher tier of support.

• Time Entry: A Task for tracking time against a parent object.

• Work Item: A Task for either immediate action or future completion.

In CSM, a Task is a Supporting Business Object (child). Tasks are accessible from the Tasks tab in the
Arrangement of their parent record.
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Task Features
CSM provides the following tools to help manage Tasks:

• Form

• Reports
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Task Form
Use the Task form to define and manage your Tasks. The Task form is a child form, and is linked to and
available from its parent Incident form (Arrangement area). The Task form is made up of two main areas:

1. Quick Info Tile: Displays important at-a-glance information, such as current and next status, record
ownership, and common operations (I Want To).

2. Main Pane: Displays the main form fields.

Note: The Task form that is accessed from an Incident is an abbreviated form View. To see
the detailed Task form, double-click the tab, or search for the Task using Quick Search or a
Search Group.

The following table describes notable fields on the form.

Field Description Comments

Quick Info Tile Important at-a-glance information.  

Status Task Workflow Status.  

Status

Current Status of the Task as it moves through the Task
Workflow. Statuses include:

• New: Task was created and is awaiting
acknowledgment from its Taskee/owner.

• Acknowledged: Task has been acknowledged
by its Taskee/owner.

• In Progress: Task is currently being worked by
its Taskee/owner.

• On Hold: Task is temporarily on hold.

• Closed: Task is closed because it was either
declined, reassigned, or completed.
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Field Description Comments

Owned By Record owner.  

Owned By Team
Name of the Team who owns the Task.

Click the link to select a Team owner for the Task.

One-Step (Assign to
Team): Launches the
Choose Team window,
where a User can choose
a Team owner for the
record.

Owned By
(Individual)

Name of the User who owns the Task

Click the link to first select a Team and then a User
owner for the Task (User is limited by Team).

One-Step (Assign to
Individual): Launches the
Choose Team window,
where a User can choose
a Team owner for the
record; then, launches the
Choose User window,
where a User can choose
a User owner from the
already-selected Team.

Take Ownership
Click the link to make yourself (Current User) the User
owner for the Task.

One-Step (Take
Ownership): Makes the
Current User the User
owner of the record.

I Want To Common operations.  

Add to My
Outlook
Calendar

Click the link to add the Task to your Outlook calendar.

One-Step (Add Task to
Outlook Calendar):
Creates an Outlook
calendar item.

Link to Upstream
Task

Click the link to link this Task to an Upstream Task,
making this Task the dependent Task. You are
prompted to select an existing Upstream Task or create
a new Upstream Task.

One-Step (Link to
Upstream Task): Links to
an upstream Task, making
this Task a dependent
Task.

Add Downstream
Task

Click the link to create a new Downstream Task that is
linked to this Task. You are prompted for a Task title.

One-Step (Add
Downstream Task):
Creates a dependent
Task.

Main Pane   

*Title Title for the Task. *Required.
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Field Description Comments

Type

Task Type:

• Escalation: A Task assigned to a higher tier of
support.

• Time Entry: A Task for tracking time against a
parent object.

• Work Item: A Task for either immediate action or
future completion.

 

*Description Description of the Task. *Required.

Task is for Future
Date/Time

When checked, indicates that the Task is expected to
be completed in the future (at the specified time).

 

Track Time Spent
When checked, indicates that the Taskee/owner is
manually tracking time (Time is manually entered in
Hours).

 

Close Code

Reason for Close:

• Completed

• Declined

• Reassigned

• Withdrawn

Autofilled when Task is
closed because it was
declined or reassigned.

Completion
Details

Details about how the Task was competed.  
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Task Reports
CSM provides the following OOTB Task Reports:

Report Description Association Search Group

My Task List Lists the Task type, description, and due date. Task My Open Tasks

Task Metrics
Lists the number of Tasks based on type and team
ownership.

Task All Tasks
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Task Automation Processes
CSM provides the following OOTB Task Automation Processes:

Name Description

Activate
Subtasks

When a Task is closed, the process initiates the Set Subtasks Active One-Step,
which sets subtasks in the Form Arrangement to Active when a Parent Task is
completed.

Notify User of
New Task

When a new Task is created, the process initiates the New Task Notification One-
Step, which sends an e-mail notification to the Task owner. It only takes place when
there is a value in Owned By and it is not the User who created the Task.

Notify Owner of
Review Date

Waits for the Status Field of a Task to change to On Hold, then initiates the Send E-
mail One-Step, which sends an e-mail to a Task owner notifying them that the Task
needs to be reviewed.
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Cherwell Service Management License Usage
Management

Note: This feature is also available as a mergeable application (mApp).
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About CSM License Usage
Cherwell Service Management (CSM) License Usage is a tool that allows you to track Cherwell Service
Management® license data related to the number of total licenses, used licenses, and remaining licenses.
It also allows you to track usage counts for features that do not require a license, such as the Dashboard
Viewer.

In CSM, CSM License Usage is a Major Business Object. The CSM License Usage form allows Users to
view, manage, and track usage data.
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CSM License Usage Good to Know
• Search for one or more CSM License Usage records that meet a specific criteria by running a Quick

Search or Search Group.

• Create a new CSM License Usage record by clicking New>New CSM License Usage on the CSM
Desktop Client toolbar or by clicking File>New>New CSM License Usage from the CSM Desktop
Client menu bar.

• CSM provides several OOTB Automation Processes to automate the CSM License Usage process.
For more information, refer to the Automation Process documentation.

• Press TAB to move to the next field on the form.

• The Started By section is populated with the name of the creator.

• A time stamp is recorded when the record is created.

• View high-level license counts in the License Usage Summary tab of the CSM License Usage Form
Arrangement.

• View detailed license counts in the CSM License Usage Count tab of the CSM License Usage Form
Arrangement.

• Quickly access the License Usage Metrics Dashboard by clicking the Go to CSM License Usage
Dashboard link in the I Want To section.

• Obtain a real-time license count by clicking the Go to License Count link in the I Want To section.
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Using CSM License Usage
When working with the CSM License Usage mApp, Users can:

• Create a CSM License Usage record.
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Create a CSM License Usage Record
Use the CSM Desktop Client to access the CSM License Usage record to track Cherwell Service
Management® license data related to the number of total licenses, used licenses, and remaining licenses.

To create a CSM License Usage record:

1. On the CSM Desktop Client toolbar, click New>New CSM License Usage.

A new CSM License Usage record is created with a status of Not Tracking. The creator is
automatically assigned as the Started By User.

2. Record Usage Tracking Configuration information (Start Date, End Date, Frequency, and Duration
are required):

a. Start Date: Click the Calendar Date Selector button  to select a start date and time for the
license tracking.

b. End Date: Click the Calendar Date Selector button  to select an end date and time for the
license tracking.

c. Frequency: Click the Up and Down buttons to select the frequency of the license tracking.

d. Duration: Click the drop-down, and then select a duration for the license tracking (hours or
minutes).

e. License Count: Select the type of data that you want to track (Available Licenses, Used
Licenses, and Total Licenses are selected by default).

f. Licensed Client: Select one or more clients for which you want to track license usage
(Desktop, Browser, Portal, and Reserved are selected by default).

g. Non-Licensed Client: Select one or more features for which you want to track usage counts
(Portal Login is selected by default).

3. Click the Activate Automated Tracking button.

The CSM License Tracking status to Tracking. When the first instance of license tracking is
recorded, and the number of Available Licenses, Used Licenses, and Remaining Licenses display in
the Quick Info Tile alert bars. When 50% of the licenses are in use, the Used Licenses alert bar
turns orange. When 80% of the licenses are in use, the Used Licenses alert bar turns red.

A summary of the tracked information is displayed in the License Usage Summary tab in the Form
Arrangement.

Tip: For a real-time license count, click the Get License Count link in the I Want To section of the
Quick Info Tile. A record of the current license data displays in the Quick Info Tile alert bars and in
the CSM License Usage tab of the Form Arrangement.

4. Click the Deactivate Automated Tracking button to end tracking.
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Configuring CSM License Usage
Complete the following procedures to configure CSM License Usage. Configuration procedures are
completed in CSM Administrator.

To configure CSM License Usage:

1. Configure CSM License Usage security rights: Configure who can access CSM License Usage
Business Objects, including:

◦ CSM License Usage

◦ CSM License Usage Count

◦ CSM License Usage Duration

◦ CSM License Usage Status

◦ CSM License Usage Type
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CSM License Usage Features
CSM provides the following tools to help manage CSM License Usage records:

• Form

• Dashboard

• Search Groups

• Automation Processes
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CSM License Usage Form
Use the CSM License Usage Form to log, edit, and track CSM License Usage records. The form is made
up of four main areas:

1. Quick Info Tile: Displays important at-a-glance information, including Status bar (current and next
status), Available Licenses bar, Used Licenses bar, Remaining Licenses bar, record ownership, and
common operations (I Want To section).

2. Main Pane: Displays the main form fields, which allow you to define the data you want to track.

3. Arrangement: Dynamically displays linked records (Child Records) that are in a relationship with the
parent CSM License Usage record.

The following table describes the fields on the form.

Field Description Comments

Quick Info Tile

Important at-a-glance information, including
Status bar (current and next status), Available
Licenses bar, Used Licenses bar, Remaining
Licenses bar, record ownership, and common
operations (I Want To section).
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Field Description Comments

CSM License Usage Record type.  

Status Alert Bar
Current and next status of the CSM License
Usage record.

 

Available Licenses
Alert Bar

Displays the total number of CSM licenses
available to your organization.

 

Used Licenses Alert
Bar

Displays the number of CSM licenses currently
being used.

 

Remaining Licenses
Alert Bar

Displays the number of CSM licenses that are
currently available.

 

Owned By   

User Owner

-select owner-
Record owner.  

Time stamp
The date and time in which the record was
created.

 

I Want To   

Get License Count
Click the link to access real-time license data
based on the defined criteria.

License Usage Count
One-Step: Steps through
a count of each CSM
License type (ex:
Available licenses) and
then saves the record.

Go to CSM License
Usage Dashboard

Click the link to open the License Usage Metrics
Dashboard where you can view and track license
data.

Go to Dashboard One-
Step: Opens the License
Usage Metrics
Dashboard in the Main
Pane.
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CSM License Usage Dashboards
CSM provides the following OOTB CSM License Usage Dashboards:

• CSM License Usage Dashboard

• License Usage Metrics Dashboard
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CSM License Usage Dashboard
CSM provides a OOTB License Usage Metrics Dashboard that intuitively organizes your critical license
metrics into a single control panel.

OOTB License Usage Metrics Dashboard Widgets

Item Description
Widget
Type

Widget Name Widget Uses:

License
Utilization per
Day

Number of used CSM
licenses and available
licenses per day.

Chart
Second Layout
Chart

Used Licenses
Search Group,
Available Licenses
Search Group

Total Available
Licenses

Total number of CSM
licenses available to the
organization.

Text Gauge
Total Available
Licenses

Total Licenses
Search Group

Remaining
Licenses

Number of CSM licenses
currently available to the
organization.

Text Gauge
Available
Licenses

Available Licenses
Search Group

Licenses
Percentage of each CSM
license type being used.

Chart License Used
License Used Search
Group
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Item Description
Widget
Type

Widget Name Widget Uses:

Daily
Application
Usage

Number of each type of CSM
license being used per day.

Chart
Daily
Application
Usage

Multiple Search
Groups (Total
License, Browser
Client, Rich Client,
Mobile Client,
Outlook Plugin, Portal
License, Reserved
License)

Non-License
Number of each type of non-
licensed CSM features being
used

Doughnut
Non License
Logins

Non License Logins
Search Group

Licensed Users
per Hour

Number of used and
available CSM licenses per
hour.

Chart
Users Logged
per Hour

Used Licenses
Search Group,
Available License
Search Group

Non-Licensed
Users per Hour

Number of users logged into
non-licensed CSM features
per hour.

Chart
Non License
Users by Hour

Total Non-License
Login Search Group,
Non-Licensed Users
Search Group
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Detail License Usage Metrics Dashboard
CSM provides a OOTB Detail License Usage Metrics Dashboard that dynamically displays data for a
specific licensed client or non-licensed feature (ex: Desktop Client). Access the Dashboard by double-
clicking a Widget segment for a particular

OOTB Detail License Usage Metrics Dashboard Widgets

Item Description
Widget
Type

Widget
Name

Widget Uses:

License
Utilization per
Day

Number of used CSM licenses
and available licenses per day.

Chart
Second
Layout Chart

Used Licenses
Search Group,
Available Licenses
Search Group

Maximum # of
Users

Highest number of licenses
used within an hour at any
point during the last quarter.

Text
Gauge

Total Users
Created Date Time
field, License Count
field

Minimum # of
Users

Lowest number of licenses
used within an hour at any
point during the last quarter.

Text
Gauge

Minimum
Users

Created Date Time
field, License Count
field
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Item Description
Widget
Type

Widget
Name

Widget Uses:

Users on
Average per
Hour

Average number of licenses
used each hour.

Chart
Users by the
Hour

Created Date Time
field, License Count
field

License Usage
on Average

Average number of licenses
used each day.

Chart Usage Detail
Created Date Time
field, License Count
field

Search License
Usage

All license usage counts
organized by the Created Date
Time field.

Search
Results
List

Search
License
Usage

CSM License Usage
Count Business
Object
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CSM License Usage Search Groups
CSM provides numerous OOTB CSM License Usage Search Groups. Notable Search Groups include:

Search Group Returns Association Executed From

All CSM License
Usage Records

All CSM License Usage records. CSM License Usage Search Manager

Completed CSM
License Usage

CSM License Usage records with a
status of Complete.

CSM License Usage Search Manager

Hour Tracking
Duration

CSM License Usage record with a
duration in hours and a status of
Tracking.

CSM License Usage
Search Manager,
Metrics, One-
Steps

Minute Tracking
CSM License Usage records with a
duration in minutes.

CSM License Usage Search Manager

Not Tracking
License Usage

CSM License Usage records with a
status of Not Tracking.

CSM License Usage Search Manager

Non License
Logins

CSM License Usage counts for
features that do not require a
license.

CSM License Usage
Count

Search Manager,
Widgets

Rich Client
CSM License Usage count for the
CSM Desktop Client.

CSM License Usage
Count

Search Manager,
Widgets

Portal Login
CSM License Usage count for the
Portal.

CSM License Usage
Count

Search Manager

Browser Client
CSM License Usage count for the
Browser Client.

CSM License Usage
Count

Search Manager,
Widgets
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CSM License Usage Automation Processes
CSM provides the following OOTB CSM License Usage Automation Processes:

Name Description

License Usage
Tracking in Hours

When the status of a CSM License Usage record is Tracking, the process waits
until the defined frequency in hours is reached, and then initiates the License
Usage Count One-Step.

License Usage
Tracking in Minutes

When the status of a CSM License Usage record is Tracking, the process waits
until the defined frequency in minutes is reached, and then initiates the License
Usage Count One-Step.
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